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Software License Agreement 

Enterasys (“Dragon”) Intrusion Prevention System 
 

This document is an agreement (“Agreement”) between You, the end user, and Enterasys Networks, Inc., (“Enterasys”) a wholly owned 
subsidiary of Extreme Networks, Inc., on behalf of itself and its Affiliates (as hereinafter defined) that sets forth your rights and obligations with 
respect to the Licensed Software.  BY INSTALLING THE LICENSE KEY (IF APPLICABLE) FOR THE SOFTWARE (“License Key”), COPYING, OR 
OTHERWISE USING THE LICENSED SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES THE 
LICENSE AND THE LIMITATION OF WARRANTY AND DISCLAIMER OF LIABILITY.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, 
RETURN THE LICENSE KEY TO ENTERASYS OR YOUR DEALER, IF ANY, OR DO NOT USE THE LICENSED SOFTWARE AND CONTACT ENTERASYS OR 
YOUR DEALER WITHIN TEN (10) DAYS FOLLOWING THE DATE OF RECEIPT FOR A REFUND.  IF YOU HAVE ANY QUESTIONS ABOUT THIS 
AGREEMENT, CONTACT ENTERASYS, Attn:  LegalTeam@extremenetworks.com.   

 
1. DEFINITIONS.  “Affiliates” means any person, partnership, corporation, limited liability company, or other form of enterprise that directly or 
indirectly through one or more intermediaries, controls, or is controlled by, or is under common control with the party specified. “Intrusion Detection 
System Software” shall refer to the application(s) authorized and licensed for use on the Network Sensor Appliances as authorized herein and as 
further defined within the product documentation.   “Enterprise Management Software” shall refer to the software installed on one or more of Your 
Servers as authorized below that is used to manage IPS and IDS software and related Host Sensor Software.  “Host Sensor Software” shall refer to the 
application software installed on Your servers and/or Network Sensor Appliances to monitor critical resources and detect potential compromises.  
“Server”, for purposes of this license, shall mean a physical computer device or appliance, or virtual appliance as further described within the product 
documentation. “Licensed Materials” shall collectively refer to the licensed software (including the software included within IPS, IDS, the Host Sensor 
and Enterprise Management Software), Firmware, media embodying the software, and the documentation.  “Firmware” refers to any software 
program or code embedded in chips or other media.  “Licensed Software” refers to the Software and Firmware collectively. 
2. TERM.  This Agreement is effective from the date on which You install the License Key or use the Licensed Software.  You may terminate the 
Agreement at any time by destroying the Licensed Materials, together with all copies, modifications and merged portions in any form.  The Agreement 
and Your license to use the Licensed Materials will also terminate if You fail to comply with any term of condition herein. 
3. GRANT OF SOFTWARE LICENSE.  Enterasys will grant You a non-transferable, non-exclusive license to use the machine-readable form of the Licensed 
Software and the accompanying documentation if You agree to the terms and conditions of this Agreement.  You may install and use the Licensed 
Software as permitted by the license type purchased as described below in License Types. The license type and authorized entitlements purchased are 
specified on the invoice issued to You by Enterasys or Your dealer, if any.  YOU MAY NOT USE, COPY, OR MODIFY THE LICENSED MATERIALS, IN WHOLE 
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT. 
4. LICENSE TYPES.   
● Intrusion Prevention System (“IPS”) Network Sensor Software. Under the terms of the IPS license, the license granted to You by Enterasys when 

You install the License Key authorizes You to use the identified Licensed Software on any one, single Server, or any replacement for that Server, for 
internal use only, in a quantity of throughput as identified within the relevant invoice issued to you and corresponding to your quoted usage / size 
entitlements.  Any additional authorization to use the IPS Software beyond the terms and conditions herein must be provided by Enterasys in 
writing. 

● Intrusion Detection System (“IDS”).  Under the terms of the IDS license, the license granted to You by Enterasys when You install the License Key 
authorizes You to use the identified Licensed Software on any one, single computer only, or any replacement for that computer, for internal use 
only, in a quantity as identified within the relevant invoice issued to you and corresponding to your quoted usage / size entitlements.  Any 
additional authorization to use the IDS Software beyond the terms and conditions herein must be provided by Enterasys in writing. 

● Host Sensor Software License Terms.  Under the terms of the Host Sensor Software license, the license granted to You by Enterasys when You 
install the License Key authorizes You to use the identified Licensed Software on any one, single computer only, or any replacement for that 
computer, in connection with the overall management of systems by an authorized use of an Enterprise Management Software instance, in a 
quantity as identified within the relevant invoice issued to you and corresponding to your quoted license pack amounts.  Any additional 
authorization to use the Host Sensor Software beyond the terms and conditions herein must be provided by Enterasys in writing. 

● Enterprise Management Software.  Under the terms of the Enterprise Management Software license, the license granted to You by Enterasys will 
authorize You to install the License Key for the Licensed Software on your authorized Server for management of the specific number of Nodes 
and/or per your defined Enterprise Size as shown on the relevant invoice issued to You for each Node and/or Enterprise Size that You order from 
Enterasys or Your dealer, if any, to access the application software.  A separate license is required for each additional instance of Enterprise 
Management Software. Any additional authorization to use the Enterprise Management Software beyond the terms and conditions herein must 
be provided by Enterasys in writing. 

5. AUDIT RIGHTS.  You agree that Enterasys may audit Your use of the Licensed Materials for compliance with these terms and Your License Type at any 
time, upon reasonable notice.  In the event that such audit reveals any use of the Licensed Materials by You other than in full compliance with the 
license granted and the terms of this Agreement, You shall reimburse Enterasys for all reasonable expenses related to such audit in addition to any 
other liabilities You may incur as a result of such non-compliance, including but not limited to additional fees for unlicensed usage over and above 
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those specifically granted to You.  From time to time, the Licensed Software will upload information about the Licensed Software and the associated 
devices to Enterasys. This is to verify the Licensed Software is being used with a valid license. By using the Licensed Software, you consent to the 
transmission of this information.  Under no circumstances, however, would Enterasys employ any such measure to interfere with your normal and 
permitted operation of the Products, even in the event of a contractual dispute.  
6. RESTRICTION AGAINST COPYING OR MODIFYING LICENSED MATERIALS.  Except as expressly permitted in this Agreement, You may not copy or otherwise 
reproduce the Licensed Materials.  In no event does the limited copying or reproduction permitted under this Agreement include the right to 
decompile, disassemble, electronically transfer, or reverse engineer the Licensed Software, or to translate the Licensed Software into another 
computer language. 
 The media embodying the Licensed Software may be copied by You, in whole or in part, into printed or machine readable form, in sufficient 
numbers only for backup or archival purposes, or to replace a worn or defective copy.  However, You agree not to have more than two (2) copies of the 
Licensed Software in whole or in part, including the original media, in your possession for said purposes without Enterasys’ prior written consent, and 
in no event shall You operate more copies of the Licensed Software than the specific licenses granted to You.  You may not copy or reproduce the 
documentation.  You agree to maintain appropriate records of the location of the original media and all copies of the Licensed Software, in whole or in 
part, made by You.  You agree to include any copyright or other proprietary notice set forth on the label of the media embodying the Licensed Software 
on any copy of the Licensed Software in any form, in whole or in part, or on any modification of the Licensed Software or any such modular work 
containing the Licensed Software or any part thereof. 
7. TITLE AND PROPRIETARY RIGHTS  
(a) The Licensed Materials are copyrighted works and are the sole and exclusive property of Enterasys, any company or a division thereof which 
Enterasys controls or is controlled by, or which may result from the merger or consolidation with Enterasys (its “Affiliates”), and/or their suppliers.  This 
Agreement conveys a limited right to operate the Licensed Materials and shall not be construed to convey title to the Licensed Materials to You.  There 
are no implied rights.  You shall not sell, lease, transfer, sublicense, dispose of, or otherwise make available the Licensed Materials or any portion 
thereof, to any other party. 
(b) You further acknowledge that in the event of a breach of this Agreement, Enterasys shall suffer severe and irreparable damages for which 
monetary compensation alone will be inadequate.  You therefore agree that in the event of a breach of this Agreement, Enterasys shall be entitled to 
monetary damages and its reasonable attorney’s fees and costs in enforcing this Agreement, as well as injunctive relief to restrain such breach, in 
addition to any other remedies available to Enterasys. 
8. PROTECTION AND SECURITY.  In the performance of this Agreement or in contemplation thereof, You and your employees and agents may have 
access to private or confidential information owned or controlled by Enterasys relating to the Licensed Materials supplied hereunder including, but not 
limited to, product specifications and schematics, and such information may contain proprietary details and disclosures.  All information and data so 
acquired by You or your employees or agents under this Agreement or in contemplation hereof shall be and shall remain Enterasys’ exclusive property, 
and You shall use your best efforts (which in any event shall not be less than the efforts You take to ensure the confidentiality of your own proprietary 
and other confidential information) to keep, and have your employees and agents keep, any and all such information and data confidential, and shall 
not copy, publish, or disclose it to others, without Enterasys’ prior written approval, and shall return such information and data to Enterasys at its 
request.  Nothing herein shall limit your use or dissemination of information not actually derived from Enterasys or of information which has been or 
subsequently is made public by Enterasys, or a third party having authority to do so. 
 You agree not to deliver or otherwise make available the Licensed Materials or any part thereof, including without limitation the object or source 
code (if provided) of the Licensed Software, to any party other than Enterasys or its employees, except for purposes specifically related to your use of 
the Licensed Software on a single computer as expressly provided in this Agreement, without the prior written consent of Enterasys.  You agree to use 
your best efforts and take all reasonable steps to safeguard the Licensed Materials to ensure that no unauthorized personnel shall have access thereto 
and that no unauthorized copy, publication, disclosure, or distribution, in whole or in part, in any form shall be made, and You agree to notify Enterasys 
of any unauthorized use thereof.  You acknowledge that the Licensed Materials contain valuable confidential information and trade secrets, and that 
unauthorized use, copying and/or disclosure thereof are harmful to Enterasys or its Affiliates and/or its/their software suppliers. 
9. MAINTENANCE AND UPDATES.  Updates and certain maintenance and support services, if any, shall be provided to You pursuant to the terms of 
an Enterasys Service and Maintenance Agreement, if Enterasys and You enter into such an agreement.  Except as specifically set forth in such 
agreement, Enterasys shall not be under any obligation to provide Software Updates, modifications, or enhancements, or Software maintenance and 
support services to You. 
10. DEFAULT AND TERMINATION. In the event that You shall fail to keep, observe, or perform any obligation under this Agreement, including a failure 
to pay any sums due to Enterasys, or in the event that you become insolvent or seek protection, voluntarily or involuntarily, under any bankruptcy law, 
Enterasys may, in addition to any other remedies it may have under law, terminate the License and any other agreements between Enterasys and You. 
(a) Immediately after any termination of the Agreement or if You have for any reason discontinued use of Software, You shall return to Enterasys the 
original and any copies of the Licensed Materials, and certify in writing that through your best efforts and to the best of your knowledge the original 
and all copies of the terminated or discontinued Licensed Materials have been returned to Enterasys.  
(b) Sections 1, 7, 8, 10, 11, 12, 13, 14 and 15 shall survive termination of this Agreement for any reason. 
11. EXPORT REQUIREMENTS.  You are advised that the Software is of United States origin and subject to United States Export Administration 
Regulations; diversion contrary to United States law and regulation is prohibited.  You agree not to directly or indirectly export, import or transmit the 
Software to any country, end user or for any Use that is prohibited by applicable United States regulation or statute (including but not limited to those 
countries embargoed from time to time by the United States government); or contrary to the laws or regulations of any other governmental entity that 
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has jurisdiction over such export, import, transmission or Use. 
12. UNITED STATES GOVERNMENT RESTRICTED RIGHTS.  The Licensed Materials  (i) were developed solely at private expense; (ii) contain “restricted 
computer software” submitted with restricted rights in accordance with section 52.227-19 (a) through (d) of the Commercial Computer Software-
Restricted Rights Clause and its successors, and (iii) in all respects is proprietary data belonging to Enterasys and/or its suppliers.  For Department of 
Defense units, the Licensed Materials are considered commercial computer software in accordance with DFARS section 227.7202-3 and its successors, 
and use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth herein.  
13. LIMITED WARRANTY AND LIMITATION OF LIABILITY.  The only warranty Enterasys makes to You in connection with this license of the Licensed 
Materials is that if the media on which the Licensed Software is recorded is defective, it will be replaced without charge, if Enterasys in good faith 
determines that the media and proof of payment of the license fee are returned to Enterasys or the dealer from whom it was obtained within ninety 
(90) days of the date of payment of the license fee. 
NEITHER ENTERASYS NOR ITS AFFILIATES MAKE ANY OTHER WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, WITH RESPECT TO THE LICENSED 
MATERIALS, WHICH ARE LICENSED "AS IS".  THE LIMITED WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WHICH ARE EXPRESSLY 
DISCLAIMED, AND STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID.  ONLY TO THE EXTENT SUCH EXCLUSION OF 
ANY IMPLIED WARRANTY IS NOT PERMITTED BY LAW, THE DURATION OF SUCH IMPLIED WARRANTY IS LIMITED TO THE DURATION OF THE LIMITED 
WARRANTY SET FORTH ABOVE.  YOU ASSUME ALL RISK AS TO THE QUALITY, FUNCTION AND PERFORMANCE OF THE LICENSED MATERIALS.  IN NO 
EVENT WILL ENTERASYS OR ANY OTHER PARTY WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THE LICENSED MATERIALS 
BE LIABLE FOR SPECIAL, DIRECT, INDIRECT, RELIANCE, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING LOSS OF DATA OR PROFITS OR FOR 
INABILITY TO USE THE LICENSED MATERIALS, TO ANY PARTY EVEN IF ENTERASYS OR SUCH OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.  IN NO EVENT SHALL ENTERASYS OR SUCH OTHER PARTY'S LIABILITY FOR ANY DAMAGES OR LOSS TO YOU OR ANY OTHER PARTY 
EXCEED THE LICENSE FEE YOU PAID FOR THE LICENSED MATERIALS. 
Some states do not allow limitations on how long an implied warranty lasts and some states do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitation and exclusion may not apply to You.  This limited warranty gives You specific legal rights, and You may 
also have other rights which vary from state to state. 
14. JURISDICTION.  The rights and obligations of the parties to this Agreement shall be governed and construed in accordance with the laws and in the 
State and Federal courts of the State of California, without regard to its rules with respect to choice of law.  You waive any objections to the personal 
jurisdiction and venue of such courts. None of the 1980 United Nations Convention on the Limitation Period in the International Sale of Goods, and the 
Uniform Computer Information Transactions Act shall apply to this Agreement. 
15. GENERAL. 
(a) This Agreement is the entire agreement between Enterasys and You regarding the Licensed Materials, and all prior agreements, representations, 
statements, and undertakings, oral or written, are hereby expressly superseded and canceled. 
(b) This Agreement may not be changed or amended except in writing signed by both parties hereto. 
(c) You represent that You have full right and/or authorization to enter into this Agreement. 
(d) This Agreement shall not be assignable by You without the express written consent of Enterasys. The rights of Enterasys and Your obligations 
under this Agreement shall inure to the benefit of Enterasys’ assignees, licensors, and licensees. 
(e) Section headings are for convenience only and shall not be considered in the interpretation of this Agreement. 
(f) The provisions of the Agreement are severable and if any one or more of the provisions hereof are judicially determined to be illegal or otherwise 
unenforceable, in whole or in part, the remaining provisions of this Agreement shall nevertheless be binding on and enforceable by and between the 
parties hereto. 
(g) Enterasys’ waiver of any right shall not constitute waiver of that right in future.  This Agreement constitutes the entire understanding between the 
parties with respect to the subject matter hereof, and all prior agreements, representations, statements and undertakings, oral or written, are hereby 
expressly superseded and canceled.  No purchase order shall supersede this Agreement. 
(h) Should You have any questions regarding this Agreement, You may contact Enterasys at the address set forth below.  Any notice or other 
communication to be sent to Enterasys must be mailed by certified mail to the following address:  
  

Extreme Networks, Inc.,  
145 Rio Robles.  
San Jose, CA 95134 United States.  
ATTN: General Counsel 
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About This Guide

The Extreme Networks Intrusion Prevention System (IPS) is a solution consisting of an Intrusion 
Detection System (IDS), Distributed Intrusion Prevention, and Intrusion Prevention. 
Administrators can configure a variety of Extreme Networks IPS elements. Administrators are 
responsible for configuring Network Sensors, Host Sensors, and the management tools of the 
Enterprise Management Server (EMS). Depending on your administrative role, you have access to 
the root of the operating system, XML, and/or the GUI configuration methods. It is recommended 
that all configuration available through the GUI be performed using the GUI. XML configuration 
is described in the latter chapters of the book. You may be responsible for placement of Extreme 
Networks IPS components within your network and for the systems with which Extreme 
Networks IPS communicates to execute alerts. 

This guide describes how to configure Extreme Networks IPS (Version 8.3, or higher) using GUI 
management tools. It also describes the placement of Extreme Networks IPS components within 
your network. It is recommended that you read the Installation Guide prior to configuring your 
Extreme Networks IPS system. Instructions in this guide assume that Extreme Networks IPS is 
installed.

Intended Audience
This document is intended for experienced network administrators who are responsible for 
implementing and maintaining an Intrusion Prevention System. 

Version Support
This guide describes Extreme Networks Intrusion Prevention System Version 8.3 and higher.
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Related Documents 
For related IPS manuals, visit:

www.extremenetworks.com/support/enterasys-support/

Conventions 
The following conventions are used in this document.

The following icons are used in this guide:

<installdir> Indicates to enter the path were you installed Extreme Networks IPS. The default 
directory is
/usr/dragon.

bold type Actual user input values or names of screens and commands.

blue type Indicates a hypertext link. When reading this document online, click the text in blue to 
go to the referenced figure, table, or section.

italic type User input value required.

courier Used for command-level input or output.

Note: Calls the reader’s attention to any item of information that may be of special importance.
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Getting Help
For additional support, contact Extreme Networks using one of the following methods:

Before contacting Extreme Networks for technical support, have the following information ready:

• Your Extreme Networks service contract number 

• A description of the failure

• A description of any action(s) already taken to resolve the problem (for example, changing 
mode switches, and rebooting the unit.)

• The serial and revision numbers of all involved Extreme Networks products in the network

• A description of your network environment (for example, layout, and cable type)

• Network load and frame size at the time of trouble (if known)

• The device history (for example, have you returned the device before, is this a recurring 
problem)

• Any previous Return Material Authorization (RMA) numbers

Website www.extremenetworks.com/support/

Phone 1-800-872-8440 (toll-free in U.S. and Canada)

or 1-603-952-5000

To find the Extreme Networks Support toll-free number in your country:

www.extremenetworks.com/support/enterasys-support/contact/

Email support@enterasys.com
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1
Extreme Networks IPS Overview

This chapter provides a high-level description of the Extreme Networks Intrusion Prevention 
System (IPS) solution and components. The Extreme Networks Intrusion Prevention System is 
also known as Dragon.

Extreme Networks IPS Intrusion Detection and Prevention
Extreme Networks IPS provides a reliable solution for detecting and responding to the broad 
array of attacks present in today’s constantly changing security landscape. Extreme Networks IPS 
is an intrusion prevention solution consisting of an Intrusion Detection System (IDS), Distributed 
Intrusion Prevention, and Intrusion Prevention. Extreme Networks IPS is a key component of the 
Enterasys Secure Networks solutions. The Distributed IPS solution detects abnormal behavior on 
the enterprise network, then intervenes to quarantine the offending user or deviant device.

Intrusion defense solutions provide an additional layer of vital security. The Extreme Networks 
IPS defense system can detect suspicious activity, stop the intrusion and assess the damage, and 
provide information to prosecute the perpetrator. 

Extreme Networks IPS provides:

• High-speed sensors to detect and respond to suspicious activity, forensic data to determine 
the impact of network attacks, and the scalability to deploy and manage large numbers of 
sensors without negatively impacting the operation of your network. 

• An integrated solution for detecting and stopping misuse and attacks across the entire IT 
infrastructure. It combines events on the network with those on the hosts, firewalls, routers, 
switches, other IDSs and applications, providing complete detection for the small and large 
environment. With comprehensive analysis and real-time monitoring capabilities, Extreme 
Networks IPS delivers a higher level of defense to your IT infrastructure. 

• Complete intrusion defense with integrated network- and host-based intrusion defense, and 
scalable enterprise management. It is a flexible software- and hardware-based proprietary 

For information about... Refer to page...
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Network Sensor
operating system based on Linux, with support for Windows, Linux, Solaris, AIX, and HP-UX 
hosts.

The Extreme Networks IPS product line consists of three major software components: Network 
Sensor, Host Sensor, and Enterprise Management Server (EMS). These components can be 
installed separately or together on Extreme Networks IPS hardware appliances or on your 
hardware. Figure 1-1 shows an example of a network protected by Extreme Networks IPS Host 
and Network Sensors which are managed by the Extreme Networks IPS EMS.

Figure 1-1  Example Extreme Networks IPS Protected Network

Network Sensor
The Extreme Networks IPS Network Sensor is a packet-based Network Intrusion Detection 
System (NIDS) and response system. It collects network packets and analyzes them for a variety of 
suspicious activities. It monitors network packets for computer criminals, hackers, employee 
misuse, and network anomalies. Suspicious activity may indicate network abuse, probes, 
intrusions, or vulnerabilities. Multiple Network Sensors can operate jointly to provide enterprise 
coverage of complex networks that are managed by the Extreme Networks IPS Enterprise 
Management Server (EMS). Network Sensor can send pages and email alerts when it detects 
suspicious events while taking action to stop the event and record the event for future forensic 
analysis. It can take action to shut down the connection to avoid further damage.

Network Sensor is a software-only package that can be installed on your own hardware or can be 
bought already installed on an Extreme Networks IPS appliance. Network Sensors typically are 
deployed at network aggregation points and ensure the validity of traffic in layers two, three, and 
four. The sensors can reassemble fragmented frames and reconstruct TCP and UDP streams to 
counteract detection evasion tools. Extreme Networks IPS Network Sensors use signature-based 
pattern matching, protocol analysis and decoding, and anomaly detection techniques.

When an attack is detected, Extreme Networks IPS Network Sensor employs a variety of active 
response techniques to block the would-be intruder, including taking action to stop the sessions 
and reconfiguring firewall policies or switch and router Access Control Lists. Extreme Networks 
IPS Network Sensor offers deep forensic capabilities, including flexible packet capture and 
complete session information (such as information about HTTP, FTP, POP, and certain IPs or 
networks) needed to analyze network-based attacks.

Network Sensor features include:
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Host Sensor
• Open tunable signatures which allow implementation, modification, and custom creation of a 
set of signatures designed to detect the attacks that apply to each unique environment

• Multi-interface monitoring that combines multiple network interfaces into a single traffic 
stream for analysis, enabling a dual-tap solution

• IP defragmentation and TCP/UDP stream reassembly that identifies attackers who attempt to 
evade an IDS by distributing attacks over multiple packets 

• Protocol decoding for most commonly targeted protocols that identifies attackers who 
attempt to hide an attack within the protocol 

• IDS Denial of Service (DoS) countermeasures that defeat tools such as “stick” and “snot” that 
attempt to DoS an intrusion detection system

• Event sniping which terminates an attack session via a TCP reset or ICMP unreachable 
message, stopping the attack before real damage can occur

• Probe prevention that defeats or confuses many scanning techniques by issuing false 
responses to the probe, misleading attackers about the true nature of the network and/or 
target system 

• Backdoor and rogue server detection using varied techniques

Virtual Network Sensors allow event routing by IP and subnet address, port, protocol, and VLAN 
ID. They enable a single Extreme Networks IPS Network Sensor to operate like multiple 
individually configurable sensors. They perform in the same manner as traditional Network 
Sensors. Each virtual Network Sensor occupies approximately 200-250 MB of memory. One 
Gigabyte of RAM could handle three to four virtual Network Sensors. It is recommended that you 
have no more than two virtual Network Sensors for every 512 MB of memory.

Host Sensor
Extreme Networks IPS Host Sensor is a host-based Intrusion Detection System (HIDS). It protects 
at the host and application level by monitoring the operating system and critical applications. 
Extreme Networks IPS Host Sensor may be deployed on a protected host where it uses a variety of 
techniques to detect attacks and misuse on the system, including analyzing the security event log, 
checking the integrity of critical configuration files, or checking for kernel level compromises. 
Extreme Networks IPS Host Sensor may also be deployed on a dedicated analysis system which 
receives logs from most commercial firewalls, routers, switches, and other IDS devices. 

Extreme Networks IPS Host Sensor traps and analyzes all calls into the kernel and supports 
detecting kernel activity that may be indicative of rootkits, an absolute requirement in identifying 
compromised systems before an attacker is able to completely cover their tracks. It can also 
identify anomalous privilege escalation states resulting from successful buffer overflows. 
Centrally managed using Extreme Networks IPS Enterprise Management Server for signature and 
configuration updates, Extreme Networks IPS Host Sensor also reports information—including 
event description, source/destination IP, source/destination port, raw log (if applicable), and 
timestamp—to the Extreme Networks IPS Enterprise Management Server for real-time alerting 
and forensic and trend analysis.

Host Sensor features include:

• Kernel monitoring that detects suspicious privilege escalations and other signs that the kernel 
has been compromised

• File attribute monitoring of specific file attributes such as owner, group, permissions, and file 
size 
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EMS
• File integrity checking of files or directories to determine if content has been changed using 
MD5 hash

• Log file analysis that analyzes any file or directory—including the system log, security log, or 
the log of a custom-built application—against a signature policy

• Windows event log analysis monitors the various Windows event logs for signs of misuse or 
attack

• Windows registry analysis which analyzes the Windows registry for attributes that should not 
be accessed and/or modified, essential in identifying attacks against often-targeted Microsoft 
servers

• TCP/UDP (backdoor) service detection looks for opened TCP and UDP ports, providing 
critical protection against backdoor services, which can be used to allow unauthorized access 
through the firewall or to act as a staging point for a distributed denial of service or outright 
attack

• Intrusion prevention for your enterprise web server (IIS or Apache) by monitoring and 
rejecting, if configured, malicious traffic. Refer to the latest release notes for version support 
information.

EMS
The Extreme Networks IPS Enterprise Management Server (EMS) manages multiple Extreme 
Networks IPS Network and Host Sensors. It consists of a server portion and the IPS GUI. The GUI 
includes advanced visualization, correlation, and alerting capabilities. By aggregating all alerts 
into one central database, the EMS updates and relays disparate attack information with a variety 
of web-enabled reporting and analysis tools, customizable alerts via e-mail, and SNMP or 
SYSLOG messages. The EMS contains the following components:

• Extreme Networks IPS Management

• Reporting Tools

Extreme Networks IPS management is used for configuration and management, while the rest of 
the components are tools used for reporting and analysis. In addition to the management tool, 
agents provide configuration and alerting functionality.

Each of the reporting tools supports analysis of IDS events in real time, long-term trending, and 
up close inspection of each event’s detail and associated information. Extreme Networks IPS EMS 
provides 48-hour breakout histograms of events so you can spot trends at a glance.

Extreme Networks IPS Management
The Extreme Networks IPS Management component provides the ability to create policies and 
security zones which manage sensor operation, as well signatures that detect anomalous activity. 
The management component also allows you to configure all Extreme Networks IPS agents and 
provide minimal device-level configuration. 

Host Sensor policies and Network Sensor security zones are responsible for managing sensors. 
Management of the sensors includes reporting the health of the sensor and allowing security 

Note: For information on HIDS processes and services on UNIX, Linux, and Windows platforms, 
refer to Appendix E, HIDS Processes and Services.
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policies to be centrally created and deployed. Policies and security zones allow for configuration 
of all modules.

The policy can get live signature updates from the Enterasys Customer Support Site. The 
Configuration Channel acts like an agent to funnel information from the policy through the Event 
Channel and Cache Manager (where applicable).

Reporting Tools
Refer to the Analysis and Reporting Guide for information about using the Extreme Networks IPS 
Reporting Tools.

Extreme Networks IPS Agents
Extreme Networks IPS agents process events. Agents consume events produced by sensors. 
Extreme Networks IPS agents are important to how Extreme Networks IPS processes and 
forwards events. Some agents work with specific Extreme Networks IPS components and some 
provide global functions to Extreme Networks IPS’s operation. Agents can be platform-specific 
and sensor-specific. All Extreme Networks IPS agents must be associated with device nodes 
running the Linux operating system. Agent configuration is described in Chapter 11, ”Extreme 
Networks IPS Agent Configuration”. The following sections describe Extreme Networks IPS 
agents.

Alarm Tool Agent 
The Alarm Tool agent processes events from Network Sensor and Host Sensor ring buffers (or 
export log), analyzes the event, and possibly initiates delivery of an alert using one or more 
methods based on configuration. Alerts can be real-time or summary. This agent is used to 
generate alerts (for example, email, page, or SNMP Trap) based on the occurrence of specified 
events. 

The Alarm Tool agent should be installed and activated on any Sensor/EFP device node where 
alarming should take place.

Figure 1-2  Alarm Tool Agent

Note: For information on security zones, see Chapter 7, ”Configuration Scopes”. Information 
about how to create Network Sensor signatures is provided in Chapter 9, ”Network Sensor 
Signature Libraries and Signatures” and Appendix B, Signature Creation Overview. Information 
about creating Host Sensor policies is provided in the Creating Host Sensor Policies book. 
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Export Log Agent
The Export Log agent reads events from Network Sensor and Host Sensor and records the events 
in a flat ASCII file that serves as an export log. The export log can be used to export Extreme 
Networks IPS events to third party systems. It is also used by the legacy Reporting tools. 

Figure 1-3  Export Log Agent

MySQL Reporting Agent 
The MySQL Reporting agent provides the event data used by the Extreme Networks IPS 
Reporting features. The MySQL Reporting agent does this by reading events directly from the ring 
and storing them in the Extreme Networks IPS MySQL event database in batches. 

Figure 1-4  MySQL Reporting Agent

Channels 
Channels work like agents in that they send events between components. Channels must be 
present for all devices and are configured at the device level. There are two channels: the Event 
Channel and the Configuration Channel.

Event Channel
The Event Channel is responsible for propagating events between Extreme Networks IPS 
components (for example, between sensors and an Event Flow Processor (EFP). One Event 
Channel is installed on each device in the Extreme Networks IPS Enterprise regardless of what 
components are installed. This agent is capable of handling all inbound and outbound event flows 
regardless of which device initiates the connection. On UNIX machines, a Cache Manager agent 
directs the storage of overflow events until the Event Channel can forward them. The Event 
Channel sends information to the ring buffer (events in memory) or receives event information 
from memory to be passed up the event hierarchy. 

Configuration Channel
The Configuration Channel provides communication between the EMS and managed devices 
such as sensors and EFPs. The Configuration Channel is used to push policies configured on the 
EMS using the EMS management client to managed devices.
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Event Flow Processor
You can set up a Linux server as an Event Flow Processor (EFP) to receive events from one or more 
sensors. These events can either be forwarded along to another EFP, processed locally by Extreme 
Networks IPS agents, or both forwarded and processed locally. EFPs can be installed in a network 
architecture to provide Extreme Networks IPS event aggregation or end-points. Any device on 
your network can become an EFP, with or without running sensors, agents (except the Event 
Channel agent), or EMS.

The Extreme Networks IPS architecture allows multiple EFPs to be placed in a network, allowing 
events to be aggregated at strategic locations for processing by Extreme Networks IPS agents. For 
example, in a managed security environment, local EFPs could be installed to allow each customer 
to view events specific to their location. The events can then be forwarded from each of these 
customer EFPs to an aggregated EFP for overall processing by Extreme Networks IPS agents. This 
allows the managed security provider to view all events and a customer to view only events 
pertaining to their network. EFP data streams operate independently of each other. This means 
that if the connection to one EFP goes down, events are still propagated to all other EFPs.

Note: If you are not planning to use the Enterprise Management Server or the Reporting server, 
select only Sensors & Agents during the installation process.
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2
Understanding Deployment Models

Components of Extreme Networks IPS can be used to fulfill different architectural purposes. You 
can deploy sensors and EFPs (refer to “Event Flow Processor” on page 1-7) in a variety of models. 
These models determine the capabilities of the component. Capabilities include whether the 
component is being managed by Extreme Networks IPS policies, Extreme Networks IPS agents 
are loaded, or events are forwarded up the event hierarchy to another component. 

These components can be combined into purposeful system architectures. Depending on your 
environment, you may have multiple components on a single device or have each component on a 
separate device.

Enterprise Sensor
Sensors managed using polices that forward events to an EFP are Enterprise Sensors (ES). 
Enterprise Sensors consist of a sensor (Extreme Networks IPS Network Sensor and/or Extreme 
Networks IPS Host Sensor), Event Channel agent, and one or more Extreme Networks IPS agents. 
The Configuration Channel agent is used to communicate with policies. 

The Enterprise Sensor initiates communications to send events up the event hierarchy to an EFP as 
shown in Figure 2-5. The Event Channel agent is responsible for forwarding policy information 
and forwarding events up the event hierarchy. The Configuration Channel is used to distribute the 
policies to all nodes. It is important to note that connections to multiple EFPs are independent of 
each other. This allows for a highly available and redundant solution for enterprise environments.

Policies generated by the ES have the ability to forward events to other Extreme Networks IPS 
nodes. The ES can configure sensors, EFPs, Reporting servers, or any of those combinations.

For information about... Refer to page...
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Figure 2-5  Enterprise Sensor

In the Enterprise Sensor model, events are only stored to disk if caching of the memory is 
necessary. Caching allows events to be captured during connectivity issues with the EFP. Once 
connectivity is restored, processing of the events in disk cache proceeds.

EFP Types
An Event Flow Processor is an important component of an Extreme Networks IPS system. Event 
flow processors are usually Linux servers. There are two types of EFPs: one with event forwarding 
(EF) and one without event forwarding (NEF). A single EFP is installed on a single machine.

Event Flow Processor with Event Forwarding
An Event Flow Processor is an aggregation point for events that have been forwarded from one or 
more sensors or other EFPs. The events are aggregated in memory and made available to Extreme 
Networks IPS agents. A minimal EFP is configured with an Event Channel agent that retrieves the 
events from memory, although any of the available Extreme Networks IPS agents may be loaded 
on an EFP. Event flow is always performed by the Event Channel agent. Any EFP may be used to 
forward events to a higher level EFP. This component is useful when building a tiered 
architecture. Events from multiple sensors can be aggregated into an EFP and then multiple EFPs 
can be aggregated into a higher level EFP. This configuration allows events to be aggregated from 
many sensors without inundating the highest level EFP with TCP connections.

Figure 2-6 shows an EFP. In a typical configuration, the Event Channel agent is configured to 
receive events from components such as a sensor and to forward events up the event flow 
hierarchy. The Configuration Channel receives policy management information from the EMS. 
One Event Channel agent is capable of servicing the components both up and down the event 
hierarchy. 
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EFP Types
Figure 2-6  Event Flow Processor with Event Forwarding

Event Flow Processor with No Event Forwarding
An EFP without event forwarding (EFP-NEF) enabled is considered an endpoint or a highest level 
EFP. Functionality is identical to an EFP with event forwarding with the exception that no events 
are forwarded up the event hierarchy from this EFP.

Similar to an EFP with event forwarding, a typical EFP-NEF is configured with an Event Channel 
agent that retrieves the events from memory, although any of the available Extreme Networks IPS 
agents may be loaded on an EFP-NEF.

Figure 2-7 shows an EFP where the connection is initiated from the sensor. In this configuration, 
an Event Channel agent is activated to process the inbound connection attempts from the sensor. 
The Event Channel agent becomes an end-point for communication.

Figure 2-7  Event Flow Processor with No Event Forwarding
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Combined EMS/EFP Architecture
It is possible to combine an EMS server and an Event Flow Processor (EFP) on the same device. 
Figure 2-8 shows multiple sensors forwarding events to a device that has an EFP and an EMS. This 
configuration requires fewer devices for environments where a small number of sensors are 
deployed or event volume is low.

Figure 2-8  Combined EMS/EFP Architecture

Tiered Architecture
Events from multiple enterprise sensors can be aggregated into an EFP with event forwarding and 
then multiple EFPs can be aggregated into a higher level EFP. This tiered configuration allows 
events to be aggregated from many sensors without inundating the highest level EFP with TCP 
connections. Figure 2-9 shows a tiered architecture. In this scenario, an Extreme Networks IPS 
EMS server and client is installed on the highest level EFP device. EFP-EF1 has event forwarding 
and a reporting EMS server. EFP-EF2 does not provide viewing of events. Events are forwarded 
up the event hierarchy from EFP-EF1 and EFP-EF2 to an overall aggregation point provided by 
EFP-NEF3.

This structure can be useful for a Managed Security Provider (MSP) where several Enterprise 
Sensors (ES) are co-located for each customer. The provider manages events from more than one 
customer. These sensors can be managed using an EMS or optionally split between multiple EMSs. 
Events from both Customer A and Customer B can be viewed at the overall aggregation point. The 
physical location of the EFP and EMS components is flexible.

The number of tiers implemented using EFPs is not limited. 
2-4 Understanding Deployment Models



Network Sensor Deployment
Figure 2-9  Tiered Architecture

Network Sensor Deployment
Depending on your network topology, there are generally two models for Network Sensor 
deployment. One approach is to deploy a Network Sensor as close to your perimeter as possible. 
This allows the Network Sensor to see as much network traffic as possible before it is blocked by 
filters or switched to other networks. The second approach is to deploy the Network Sensors close 
to the servers being protected. For example, if there are twenty UNIX servers on a network 
segment that you wish to protect, it may be the right solution to deploy the Network Sensor 
directly on that segment. Each generated event pertains only to the protected servers. This saves 
analysis time by not having to sort out the alerts, and allows analysts to concentrate on the 
important events.

Broadcast Networks
A broadcast network uses hubs to retransmit all traffic to each listening node. Since all network 
traffic is accessible through any of the hub ports, deploying a Network Sensor is as simple as 
connecting it to the hub. The Network Sensor performs all active and passive functionality on 
Broadcast Ethernet networks.
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Figure 2-10  Broadcast Network

Switched Networks
In a switched environment, traffic is only sent to the specific port to which the destination node is 
connected. For these networks, the switch must be configured to provide a mirror or SPAN port to 
receive the traffic contained on other ports.

Figure 2-11  Switched Networks with Port Mirroring

If the port does not support port mirroring, you must use a network tap. Passive network taps are 
highly recommended because they provide access to the traffic without any impact to the 
operational network. Typically, network taps produce two streams of data (inbound and 
outbound).

Figure 2-12  Switched Network Without Port Mirroring
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Alternate Gigabit Network Deployment
For Gigabit networks with exceedingly large amounts of traffic, an alternate method of intrusion 
detection deployment is to utilize a load balancing solution. The traffic can be broken down into 
manageable streams based on different network characteristics. These streams can be forwarded 
to multiple Network Sensors for analysis.

Figure 2-13  Alternate Gigabit Network Deployment
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Network Sensors Behind Firewalls
Network Sensor can supervise the firewall’s security performance and alert on any policy 
violations. Consider loading signatures for protocols that should not pass through the firewall. If 
the only allowed inbound traffic is HTTP directed at a web server, the inbound signatures of other 
protocols are not utilized unless a problem is detected, thus conserving signature processing. 

Figure 2-14  Network Sensor Behind Firewalls

Virtual Network Sensors
A single Network Sensor can operate as multiple individually configurable sensors. Each virtual 
sensor can have its own policies and filtering rules, as well as its own signature set.

Virtual sensors provide a very flexible deployment model for internal enterprise deployments. For 
example, a single physical network sensor could have three different virtual sensors configured, 
with each virtual sensor monitoring a specific user community that is associated with a different 
VLAN. Or each virtual sensor could monitor a different set of applications, TCP/UDP ports, or 
physical interfaces.
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Extreme Networks IPS Configuration Quick Start

Follow this section after you have installed Extreme Networks IPS according to the information in 
the Extreme Networks IPS Installation Guide.

Starting the Extreme Networks IPS Web GUI

To start the Extreme Networks IPS web GUI:

1. Enter the following URL in your web browser:

https://<IP address>:9443/

or

http://<IP address>:8080/

where <IP address> is the IP address of the EMS. 

2. On the IPS log in page, enter your User Name and Password, then click Log In. 
The default User Name is dragon. There is no default password.

For information about... Refer to page...

Starting the Extreme Networks IPS Web GUI 3-1

Auto Discovery, Configuration, and Deployment 3-3

Adding a Device That Was Not Discovered 3-5

What Next? 3-6

Note: Refer to the latest Release Notes for information about supported Web browsers.
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Starting the Extreme Networks IPS Web GUI
The Dashboard view, shown in Figure 3-15, opens with the Views panel and the Tabbed panel 
visible. 
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Auto Discovery, Configuration, and Deployment
Figure 3-15  Dashboard View

In the IPS GUI, configuration tasks are done from the Tabbed panel, the Configuration menu, and 
the Options menu. Some configuration tasks are done from the EMS Client, which you can launch 
from the Configuration menu in the IPS GUI. 

For more information about the IPS GUI and the EMS Client, see Chapter 4, Using the Extreme 
Networks IPS Interfaces.

For more information about the Views panel, see the IPS Analysis and Reporting Guide.

You can also launch the IPS GUI from the EMS Client by selecting Tools > Dragon Analysis & 
Reporting > Launch. 

Auto Discovery, Configuration, and Deployment
By default, the EMS server automatically discovers, configures, and deploys IPS appliances and 
sensors that are running Extreme Networks IPS v8.3 and have valid licenses. The discovered IPS 
appliances and sensors are added to the Systems and Sensors tabs in the Dashboard view of the 
IPS GUI. Discovery and deployment details are listed in the status bar and the Operations panel at 
the bottom of the IPS GUI. 
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Auto Discovery, Configuration, and Deployment
For more information about the Operations panel, see “Operations Panel” on page 4-13.
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Adding a Device That Was Not Discovered
If the discovered IPS appliances and sensors have invalid licenses, they are added to the Systems 
and Sensors tabs but they will not be configured or deployed. 

The configuration that the EMS automatically applies to IPS devices consists of a default 
configuration channel profile and a default event channel profile. If your network sensors have 
virtual sensors, the virtual sensors are added automatically to a default zone. A zone is one of the 
configuration scopes (global, zone, and sensor), which allows for a shared configuration to be 
applied globally, to a group of sensors (a zone), or to a specific sensor. 

You can change the default setting so that discovered appliances and sensors are neither 
configured nor deployed automatically. For information on the default configuration and how to 
change it, see Chapter 5, Default Configuration.

If you have IPS appliances that are not running v8.2, you must discover the appliances manually. 
See Adding a Device That Was Not Discovered. 

Adding a Device That Was Not Discovered
Extreme Networks IPS v8.3 will discover only IPS devices that have IPS v8.3 installed. If you have 
IPS devices that are running a different version of Enterasys IPS, you must add the devices 
manually. Also, if an IPS device is not currently running, such as a secondary EMS for high 
availability, you must add the IPS device manually. 

To add an IPS device manually:

1. On the Systems tab, click the Create System button. 

The Create System window displays. 

2. Provide the name, IP address, and operating system of the device. 
3. Click Create. 
The IPS device is added to the Systems tab. You can now apply a configuration channel profile 
and an event channel profile to the device. For more information, see Chapter 8, Configuration 
Channel and Event Channel Profiles. If your manually added network sensor has virtual sensors, 
you can add the virtual sensors to a zone. For more information, see “Adding a Virtual Sensor” on 
page 6-2.
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What Next?
What Next?
• Learn about the Enterasys IPS interfaces—See Chapter 4, Using the Extreme Networks IPS 

Interfaces

• Create virtual sensors on a network sensor—See Chapter 6, Device Management

• Create a host sensor—See Chapter 6, Device Management

• Configure virtual sensors with signatures, event and traffic filters, IP and port variables, event 
responses, white and black lists, protocol analyzers, and modules—See Chapter 7, 
Configuration Scopes

• Create additional configuration channel profiles and event channel profiles—See Chapter 8, 
Configuration Channel and Event Channel Profiles
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Using the Extreme Networks IPS Interfaces

The configuration features of the IPS GUI are located in the Dashboard, Configuration, and 
Options menus. For information about the Reports, Find Events, and Schedule menus, see the 
IPS Analysis and Reporting Guide.

Dashboard Overview
The Dashboard provides a view into the information you need to know to effectively manage your 
Extreme IPS deployment. This includes status information for the sensors and nodes within a 
deployment. The Dashboard lets you see at a glance both an overview of the status of your 
Extreme IPS deployment and the status of each Extreme IPS component in your network.

For information about... Refer to page...

Dashboard Overview 4-1

The Views Panel 4-2

The Tabbed Panel 4-2

Operations Panel 4-13

Customizing the Dashboard Interface 4-14

Platform-Specific Dashboard Details 4-19
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The Views Panel
The Dashboard is displayed when you first log in to EMS. After navigating away from the 
Dashboard, you can return to the Dashboard by clicking Dashboard on the menu bar.

The Dashboard contains two main areas:

• The Views Panel

• The Tabbed Panel

The Views Panel
The Views Panel on the left side of the Dashboard displays the graphical views. Each individual 
view provides additional information in a tooltip, which you can display by mousing over a chart 
element.

Clicking a chart element within a view, such as a slice in a pie chart or an individual bar in a bar 
graph, applies that chart element as a filter in the Tabbed Panel of the Dashboard. Use this feature 
to zoom in on the specific information you are most interested in. 

For more information about the Views Panel, see the IPS Analysis and Reporting Guide. 

The Tabbed Panel
The Tabbed Panel on the right side of the Dashboard presents detailed information about the 
Extreme IPS components and subcomponents present in your network environment. The 
following top-level tabs are in this panel:
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• Systems Tab

• Sensors Tab

• Interfaces Tab

• EMS/Reporting Tab

• Details Panel

Systems Tab
By default, the Systems tab provides a table of system information for all the Extreme IPS systems 
in your environment. An Extreme IPS system is any system known to the EMS that contains an IPS 
component. Table 4-1 on page 4-3 describes the columns displayed in the Systems tab table.

You can display details about a specific system in the Details tab. For more information, see 
“Details Panel” on page 4-11.

You can create system groups to manage your Enterasys IPS systems more easily. For more 
information, see “Grouping Devices” on page 6-9.

You can also create a filter for reports and the Find Events tab to show results that pertain to the 
specified system group. For more information, see the Enterasys IPS Analysis and Reporting Guide. 

Figure 4-1  The Systems Tab

Table 4-1 Systems Tab Columns 

Column Header Description

Status Refer to Table 4-2 on page 4-4.

Status Message Status messages received from the system. Refer to Table 4-3 on 
page 4-5 for more information.

Deploy Status The deployment status of the system. 

Configuration Channel Status Status of system’s Configuration Channel. Values can be: 

• Connected

• Disconnected

• Unknown (typically, status of Unmanaged systems)

Event Channel Status Status of system’s Event Channel. Values can be: 

• Up

• Down

• Blank, for systems that do not have an Event Channel, such as 
an EMS that is not forwarding events to another server.

Description Description of the system.
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Possible Status column values are described in Table 4-2 below.

MAC Address MAC address of the system. 

Serial Number Serial number of the system. 

Operating System Type of operating system of the system. 

Uptime How long the host system has been up. 

Last Heartbeat On The date and time of the last heartbeat event received from the 
Event Channel on this system.

If this cell is yellow and displays a warning icon, it means that the 
Dashboard has not yet received a heartbeat from this system.

Last Deployed On The date and time of the last deployment of this system.

Event Rate (per sec) Total events processed by the system. For an EMS or Reporting 
Server, this value will include all incoming events.

CPU Usage % Percent of CPU in use by all processes running on the system.

Memory Total (MB) Total memory available on the system, in megabytes.

Memory User (MB, %) Total memory used by all processes, in megabytes and % of total 
available. 

Disk Total (MB) The amount of disk space on the drive or the partition where 
Dragon is installed. 

Disk Used (MB, %) Disk space used by all files and applications on the drive or 
partition where Dragon is installed, in megabytes and % of total 
available.

Version The version of Dragon running on system.

Table 4-2 Status Column Values 

Status Description

Active System is operating normally (the Configuration Channel and Sensor are both 
up).

Inactive System’s Configuration Channel is up but the Sensor is down.

Unavailable System’s Configuration Channel is down and no additional information about the 
system is available.

Upgrading System is in the process of being upgraded.

Unmanaged System is not managed by the EMS.

Never Deployed System has never been successfully deployed.

Deleted System has been manually deleted from the EMS. To remove deleted items from 
the Dashboard display, see “Removing or Applying a Table Filter” on page 4-17.

Table 4-1 Systems Tab Columns  (continued)

Column Header Description
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Messages displayed in the Status Message column are messages received from the system. 
Although we cannot list all possible messages, Table 4-3 lists several examples of status messages 
and their meanings.

Sensors Tab
The Sensors tab, as shown in Figure 4-2, displays information about Network and Host Sensors in 
the Extreme IPS environment. Table 4-4 on page 4-5 describes the type of data shown in the 
Sensors tab table columns.

You can display details about a specific host or network sensor in the Details tab. For more 
information, see “Details Panel” on page 4-11.

Double clicking on a network sensor in the Sensors tab changes the view to the Configuration 
menu’s Security Zones tabs. 

Figure 4-2  The Sensors Tab

Table 4-3 Example Status Messages 

Status Message Condition

No message/blank field This sensor or system is up with no known issues.

Sensor-name is not up A system update occurred and one or more sensors on this system are 
down.

Network Sensor Shutting Down A network sensor or interface is shutting down.

Interface is Down The Interface is link-down.

Table 4-4 Sensors Tab Columns 

Column Header Description

Status Refer to Table 4-2 on page 4-4.

Status Message Status messages received from the sensor. Refer to Table 4-3 on 
page 4-5 for more information.

Deploy Status The deployment status of the sensor. 

Description Description of the sensor.

Last Deployed On The date and time when the sensor was last deployed. 

Operating System Type of operating system of the sensor. 

Type Type of sensor: IDS, IPS, or Host. 

Sensor Uptime How long the sensor process has been running.
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Interfaces Tab
The Interfaces tab displays information about the network interfaces of Extreme IPS systems and 
sensors in the Extreme IPS environment. By default, interface information is grouped in this table 

Last Heartbeat On Time of the last heartbeat event received via the Event Channel.

If the cell is yellow and contains a warning icon, the last heartbeat 
event received is old, as shown by the time in the field. 

Last Deployed On The date and time of the last deployment of this sensor.

Event Rate (per sec) Total events processed by the sensor. 

Packets Read (pps) Packets read by the Network Sensor that were not dropped (in 
packets per second). The bits from these packets contribute to the 
bandwidth license measurement (see Bits Read (Mbps) below.)

Packets Inspected (pps) Packets that are read in successfully and sent through the 
inspection process. Expressed in packets per second. 

Packets Filtered (pps) Packets that are read in successfully, but are filtered out by an 
application filter statement or because they are of a protocol type 
that Extreme IPS does not know how to inspect. Expressed in 
packets per second.

Packets Blocked (pps) In an in-line IPS deployment, the packets that are blocked due to 
either intrusion prevention rules or a black list rule. Expressed in 
packets per second. 

Packets White-listed (pps) In an in-line IPS deployment, the packets that were read in 
successfully and transmitted without inspection due to a white list 
rule. Expressed in packets per second. 

Bits Read (Mbps) Number of bits in packets read by the sensor that were not 
dropped. Expressed in megabits per second. 

This value is compared with the license bandwidth limit to 
determine if the bandwidth limit has been exceeded. 

Bits Inspected (Mbps) Number of bits in packets that were read in successfully and sent 
through the inspection process. Expressed in megabits per 
second. 

Bits Filtered (Mbps) Number of bits in packets that were read in successfully but were 
filtered out. Expressed in megabits per second. 

Bits Blocked (Mbps) Number of bits in the packets that were blocked. Expressed in 
megabits per second. 

Bits White-listed (Mbps) Number of bits in the packets that were read in successfully and 
transmitted without inspection. Expressed in megabits per second. 

CPU Usage % Percent of CPU used by the sensor process.

Memory Total (MB) Total memory available on host system.

Memory Used (MB, %) Memory used by sensor process, expressed in megabytes and in 
percentage of total memory available.

Table 4-4 Sensors Tab Columns  (continued)

Column Header Description
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The Tabbed Panel
by system. Refer to “Sorting, Filtering, and Grouping In Columns” on page 4-15 for information 
about changing the default display options. 

Table 4-5 on page 4-7 describes the type of data shown in the Interfaces tab table columns. 

You can display details about a specific interface in the Details tab. For more information, see 
“Details Panel” on page 4-11.

Figure 4-3  The Interfaces Tab

Table 4-5 Interface Tab Columns 

Column Header Description

Status The Up/Down link status of the port.

Status Message Refer to Table 4-3 on page 4-5.

Last Heartbeat On The last time a heartbeat event was received from the system.

Event Rate (per sec) Events generated for traffic received on this interface.

Packets Read (pps) Packets read by the Network Sensor on this interface that were 
not dropped (in packets per second). The bits from these packets 
contribute to the bandwidth license measurement. 

Packets Dropped (pps) Packets that were dropped at the interface because the sensor 
was too busy to service the queue in time. Any dropped rate 
above zero indicates a gap in security, as these packets are not 
being inspected. Expressed in packets per second. 

Packets Inspected (pps) Packets that are read in successfully and sent through the 
inspection process. Expressed in packets per second. 

Packets Filtered (pps) Packets that are read in successfully, but are filtered out by an 
application filter statement or because they are of a protocol type 
that Extreme IPS does not know how to inspect. Expressed in 
packets per second.
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EMS/Reporting Tab
The EMS/Reporting tab displays Extreme IPS-specific system information about EMS and 
Reporting servers and the agents in this Extreme IPS environment, as shown in Figure 4-4. 

For information on how to configure the agents, see Chapter 11, Extreme Networks IPS Agent 
Configuration. 

Packets Blocked (pps) In an in-line IPS deployment, the packets that are blocked due to 
either intrusion prevention rules or a black list rule. Expressed in 
packets per second. 

Packets White-listed (pps) In an in-line IPS deployment, the packets that were read in 
successfully and transmitted without inspection due to a white list 
rule. Expressed in packets per second. 

Bits Read (Mbps) Number of bits in packets read by the sensor at this interface that 
were not dropped. Expressed in megabits per second. 

This value is compared with the license bandwidth limit to 
determine if the bandwidth limit has been exceeded. 

Bits Inspected (Mbps) Number of bits in packets that were read in successfully at this 
interface and sent through the inspection process. Expressed in 
megabits per second. 

Bits Filtered (Mbps) Number of bits in packets that were read in successfully at this 
interface but were filtered out. Expressed in megabits per second. 

Bits Blocked (Mbps) Number of bits in the packets that were blocked at this interface. 
Expressed in megabits per second. 

Bits White-listed (Mbps) Number of bits in the packets that were read in successfully at this 
interface and transmitted without inspection. Expressed in 
megabits per second. 

Table 4-5 Interface Tab Columns  (continued)

Column Header Description
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Figure 4-4  The EMS/Reporting Tab

If you have set the Dragon database retention period for longer than the event database and 
archive database retention periods, you can, if necessary, restore Dragon database events to the 
MySQL database.

For information on setting the Dragon database retention period, see “Log/Data Policy Editor” on 
page 12-9. For information on setting the event database and archive database retention periods, 
see “Configuring the Dragon2MySQL Agent” on page 11-6.

To restore Dragon database events:

1. In the Reporting section, click Restore Events. 

The Event Restoration window displays. 
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The Event Restoration window lists up to the maximum number of Dragon database files as 
defined by the Dragon database retention period in the Log/Data Policy Editor. 

2. Select the Dragon database files for the days that you want to restore to the MySQL database. 

3. Click Ok. 

Note: If you chose to restore a Dragon database file that has events in the event database or the 
archive database, you will introduce duplicate events to the MySQL database.
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Details Panel
The Details panel, which is below the Systems, Sensors, Interfaces, and EMS/Reporting tabs, lists 
information for the selected system, sensor, or interface. See Figure 4-5.

Figure 4-5  Details Tab
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The Tabbed Panel
To display information in the Details panel:

1. Click the arrow tab above the status bar. See Figure 4-6.

Figure 4-6  Displaying the Details Tab

2. Select the system, sensor, or interface for which you want to display information in the Details 
panel. 
The information for the selected system, sensor, or interface displays in the Details panel. See 
Figure 4-7.

Figure 4-7  Details Panel for a Network Sensor

The information in the Details panel is determined by what you selected (system, host sensor, 
network sensor, or interface). 
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Operations Panel
Auditing View
The Auditing view, shown in Figure 4-8, lists all user based operations. 

Figure 4-8  Auditing View

To launch the Auditing view, select Auditing from the Tools menu.

Operations Panel
The Operations panel lists all activities that occur on the EMS server. 

Figure 4-9  Operations Panel

To view the Operations panel, click Show Operations in the lower right corner of the IPS GUI. 

You can also display the Operations Panel by clicking the lower arrow tab. 
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Customizing the Dashboard Interface
To hide the entire Views panel, click the arrow tab between the Views and Tabs panel, as shown 
in Figure 4-10.

Figure 4-10  Hide Views Panel

Customizing Tables in the Tabbed Panel
The following sections describe customizations you can perform on the tables in the Systems, 
Sensors, and Interfaces tabs.

Resizing Columns
You can resize table columns. For example, to resize a column, mouse over the area between 
columns until the cursor changes as shown in Figure 4-11. Click, drag, and release the column 
separator to resize the column. 
4-14 Using the Extreme Networks IPS Interfaces



Customizing the Dashboard Interface
Figure 4-11  Resizing Table Columns

Moving Columns
To reorganize the layout of columns within tables, click and drag the column name to a new 
location. Figure 4-12 shows the Sensor Uptime column of the Sensors table being repositioned 
between the Status and Status Message columns.

Figure 4-12  Moving Columns

Sorting, Filtering, and Grouping In Columns
All columns in the Systems, Sensors, and Interfaces tab tables have a drop down menu that allows 
you to sort, group, and filter the contents, as appropriate. Figure 4-13 shows the drop down menu 
that is displayed for the Status Message column in the Systems tab. 

Sort Options. With the exception of the Sort options, not all options shown in Figure 4-13 are 
selectable for all columns, depending on what is appropriate for the data in the column.

Figure 4-13  Column Drop Down Menu

Group Options
Use the Group By This Field option to group the report displayed by the values in a specific 
column, as shown in Figure 4-14. When you select Group By This Field, the Show in Groups 
check box is automatically checked. To undo the grouping, uncheck the Show in Groups check 
box.
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Customizing the Dashboard Interface
Figure 4-14  Grouping Options

Filters Options
The Filters option varies, depending on the type of data displayed in the column. For example, as 
shown in Figure 4-15, in the Systems tab table, the Filters option for the Status Message column 
provides a text field in which you can enter the message text you want to filter on, while the Filters 
option for the Configuration Channel column lets you choose from the possible values that can be 
displayed in that column.

Figure 4-15  Column Filters Options
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Selecting Columns to Display
You can select what columns to display in the Systems, Sensors, and Interfaces tab tables, by 
checking and unchecking the desired columns in the Columns option drop down menu. Figure 4-
16 on page 4-17 illustrates how to display a list of columns. Check or uncheck the appropriate 
check box to display or hide specific columns.

Figure 4-16  Selecting Columns to Display

Removing or Applying a Table Filter
The Systems, Sensors, and Interfaces tabs have a Status Totals bar at the top of the tab which 
provides filter buttons you can use to filter the contents of the table, in addition to listing the 
number of items in the table that match each filter. For example, in Figure 4-17 below, the Up filter 
has been applied so that only interfaces with a status of Up are displayed in the table. The Status 
Totals bar also shows that one interface is Up, one interface is Down.

To remove (or apply) a filter in a tabbed view, click the desired filter button at the top of the table. 

Figure 4-17  Remove or Apply a Filter in the Tabbed Panel
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Table 4-6 describes the Systems and Sensors tab status filters. The Interfaces tab has similar filters 
that filter on interfaces with a status of Up, Down, and Unavailable.

Exporting Tables in CSV Format
The tables displayed in the Systems, Sensors, and Interfaces tabs can be exported in CSV (comma 
separated values) format and opened immediately or saved as a file.

1. Click on the CSV button to the far right on the Status Totals bar.

2. When prompted, select Open or Save.
The file is downloaded to your system. 

Resetting the Dashboard Interface to the Default Layout
Dashboard interface settings are stored in Web browser cookies. Removing these cookies lets you 
reset the interface back to its default layout. 

To remove all Dashboard interface layout changes and revert the Dashboard interface back to the 
default settings, remove the Extreme IPS Reporting server cookies as follows.

1. In the Web browser you use to view Extreme IPS Reporting, view stored cookies. In Firefox, 
for example, select Tools > Options from the main menu, then click Privacy. Click Show 
Cookies to see the list of stored browser cookies.

2. Search for the cookies associated with your Extreme IPS Reporting server. In this example, this 
is the set of cookies for the site 10.20.117.245 as shown in Figure 4-18 below.

Table 4-6 Systems and Sensors Tab Status Filters

State Description

Active Filter on Extreme IPS systems/sensors with a status of Active, meaning that they 
are operating normally (the Configuration Channel and Sensor are both up)

Inactive Filter on Extreme IPS systems/sensors with a status of Inactive, meaning that the 
Configuration Channel is up but the Sensor is down

Unavailable Filter on Extreme IPS systems/sensors with a status of Unavailable, meaning that 
the Configuration Channel is down and no additional information about the 
system is available

Upgrading Filter on Extreme IPS systems/sensors with a status of Upgrading, meaning that 
the system/sensor is in the process of being upgraded

Unmanaged Filter on Extreme IPS systems/sensors with a status of Unmanaged, meaning that 
the system/sensor is not managed by the EMS
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Figure 4-18  Removing Cookies

3. Remove this set of cookies and reload the Extreme IPS Reporting main page. 
4. Log in to Extreme IPS Reporting. The Dashboard with the default interface layout appears.

Platform-Specific Dashboard Details
This section provides details about how the various Extreme IPS statistics available in the 
Dashboard are gathered. In addition, differences between supported operating systems in how 
this data is collected are detailed.

Unix and Linux Systems
Unix and Linux Extreme IPS systems use dragonctl, system calls and platform-specific shell 
scripts to provide system status information to Dashboard. The dragonctl process reports system 
statistics, while the host sensor process reports sensor statistics.

System Status
The dragonctl process generates heartbeat events that contain system status. Dashboard uses these 
heartbeat events to provide the following information:

• System CPU used (percentage)

• Total disk space available on the Dragon partition

Note: Unix CPU Used values are averaged from snapshot measurements and may differ from the 
output of running the top command.
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• Total disk space used on the Dragon partition

• Total memory available on the system, in megabytes (MB)

• Total memory used on the system, in megabytes (MB)

• System uptime

• Event rate from the system

Host Sensor Status
On Unix platforms, the Host Sensor is responsible for generating heartbeat events that contain 
Host Sensor status information. Dashboard uses these heartbeat events to report the following 
information:

• Host Sensor uptime

• Host Sensor event rate

• Host Sensor CPU usage

• Host Sensor memory used

• Total system memory

Windows Systems
On Windows systems, the Host Sensor process generates heartbeat events that provide both 
system and Host Sensor status information to the System Dashboard. 

System Status
On Windows systems, Dragon leverages Windows Management Instrumentation (WMI) 
technology, the data management infrastructure for Windows-based operating systems, as well as 
system calls to provide system status information to the System Dashboard.

• System CPU used (percentage)

• Total disk space available on the Dragon partition

• Total disk space used on the Dragon partition

• Total memory available on the system, in megabytes (MB)

• Total memory used on the system, in megabytes (MB)

• System uptime

• Event rate from the system

Note: On Windows systems, if the Host Sensor (DragonSquire Services) is not running, both 
System Status and Host Sensor Status will be unavailable in the System Dashboard. This is 
because the Host Sensor generates both sets of data for Windows systems.

Note: On Windows systems, the System CPU used (percentage) and Host Sensor CPU Usage are 
both instantaneous measurements.
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Host Sensor Status
Dashboard uses Host Sensor heartbeat events on Windows to provide the following Host Sensor 
status information:

• Host Sensor Uptime

• Host Sensor Event Rate

• Host Sensor CPU Usage

• Host Sensor Memory Used

• Total System Memory
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5
Default Configuration

This chapter describes the default configuration applied to a sensor when it is automatically 
configured. The default configuration consists of a configuration channel profile, an event channel 
profile, and a zone. 

Default Configuration
To view the default configuration, click the Options menu and, under Preferences, select Default 
Configuration.

For information about... Refer to page...

Default Configuration 5-1

Default Configuration Channel Profile 5-3

Default Event Channel Profile 5-4

Default Zone 5-5
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Table 5-1 lists the configuration parameters. 

Table 5-1 Default Configuration Parameters

Field Description

Configuration The operations that occur when a sensor is discovered:

• Auto Configure and Deploy: The sensor is configured with the default 
configuration and deployed automatically.

• Auto Configure: The sensor is configured with the default 
configuration. The sensor is not deployed. You must deploy the sensor 
manually. 

• Disable: The sensor is not configured or deployed. You must configure 
and deploy the sensor manually.

Security Zone The default security zone applied to sensor. For more information, see 
“Default Zone” on page 5-5.

Config Channel The default configuration channel profile applied to sensor. For more 
information, see “Default Configuration Channel Profile” on page 5-3.

Event Channel The default event channel profile applied to sensor. For more information, 
see “Default Event Channel Profile” on page 5-4.
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Default Configuration Channel Profile
The default configuration channel profile applied to auto-configured sensors is Standard 
Configuration Channel.

To view the default configuration channel profile: 

1. Select Configuration > Profiles. 

2. On the Config Channel tab, select Standard Configuration Channel. 

The Secondary Info fields are used to configure high availability. For more information about 
high availability, see Appendix A, Configuring EMS High Availability. 

For more information about configuration channel profiles, see Chapter 8, Configuration Channel 
and Event Channel Profiles.

Host Configuration The host sensor configuration for each supported OS. 

Discovery Shared Secret(s) One or more shared secrets used during the discovery process.

Table 5-1 Default Configuration Parameters

Field Description
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Default Event Channel Profile
The default event channel profile applied to auto-configured sensors is Standard Event Channel.

To view the default event channel profile: 

1. Select Configuration > Profiles. 

On the Event Channel tab, select Standard Event Channel. 

For more information about event channel profiles, see Chapter 8, Configuration Channel and 
Event Channel Profiles.
5-4 Default Configuration



Default Zone
Default Zone
The default zone applied to auto-configured sensors is Standard Security Zone. 

To view the default zone: 

1. Select Configuration > Security Zones. 

2. Expand Global. 
3. Select Standard Security Zone. 

The zone scope, like the global and sensor configuration scopes, includes settings for signature 
libraries, filters, variables, IPS settings, and advanced settings. For more information about 
configuration scopes, see Chapter 7, Configuration Scopes.
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Device Management

This chapter provides information about configuring your EMS server, network sensors, and host 
sensors. Many of the operations described in this chapter are launched from the right click menus 
available on the Dashboard view’s System and Sensors tabs. 

Virtual Sensors 
On your network sensor, you can configure virtual sensors that function as Intrusion Detection 
System (IDS) or Intrusion Prevention System (IPS) sensors. 

Each physical network sensor must contain at least one virtual network sensor. You can create up 
to 32 virtual sensors on each physical Network Sensor, based on your available memory. Enterasys 
recommends no more than two virtual network sensors for 512 MB of RAM on the device. 
Appliances with 1 GB of RAM could handle four virtual sensors. Security zones and signatures 
are then attached to virtual sensors. 

Each virtual sensor can be configured to look at only a subset of traffic coming over its associated 
device. Define what traffic the virtual sensor should accept and analyze. Any other traffic will be 
ignored by the virtual sensor, unless it is configured as the default sensor.

Note that at least one virtual sensor must be configured on a Network Sensor device, because 
security zones and signatures can only be assigned to virtual network sensors.

For information about... Refer to page...

Virtual Sensors 6-1

Adding Host Sensors 6-6

Changing the Host Sensor Policy 6-7

Viewing a Sensor’s Log 6-7

Moving Sensors 6-8

Grouping Devices 6-9

Deploying Changes 6-13

Configuring System and Network Sensor Settings 6-13

Adding a Description for a Sensor 6-15

Starting and Stopping Devices and Sensors 6-15

Deleting Devices and Sensors 6-16
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Adding a Virtual Sensor
To add a virtual sensor:

1. In the Dashboard view of the IPS GUI, click the Systems tab. 

2. Right click the system on which you want to add a virtual sensor and select Configure Virtual 
Sensor. 

3. In the Configure Virtual Sensor(s) window, click Create IDS or Create IPS.

4. In the Create IDS Virtual Sensor window or Create IPS Virtual Sensor window, do the 
following:
a. Enter the name of the virtual sensor. 

Each virtual sensor must have a unique name. By default, the sensor is given the name 
<host name>-IDS or <host name>-IPS. 

b. Select the interfaces from the drop down list. 

Each IDS or IPS virtual sensor can have one or more physical network interfaces on the 
same system associated with it. For example, if you’re creating an IDS virtual sensor that 
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will be used to connect to the two outputs of a network tap, you would associate two 
interfaces. IPS virtual sensors always have two bridged interfaces associated with them.

c. Select the zone from the drop down list. 

d. Click OK. 

The virtual sensor is added to the Configure Virtual Sensor(s) window. 

5. Set the sensor traffic selection filters for the virtual sensor.
This traffic filter information is inclusive. You can create exclusive traffic filters for the virtual 
sensor on the Filters tab. For more information, see “Adding a Traffic Filter” on page 7-9.

a. Double-click the appropriate field in the virtual sensor’s entry. 

The field becomes read/write. 

b. Enter the appropriate values in the field. 

6. When you have finished setting the values, click Save Changes. 
The virtual sensors are added under the appropriate zone in the Security Zones view 
(Configuration > Security Zones). In the Security Zones view, you can configure settings for a 
specific virtual sensor. For more information, see Chapter 7,”Configuration Scopes”.
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Modifying a Virtual Sensor
To modify a virtual sensor:

1. In the Dashboard view of the IPS GUI, click the Systems tab. 

2. Right click the system on which you want to modify a virtual sensor and select Configure 
Virtual Sensor. 

3. In the Configure Virtual Sensor(s) window, select the virtual sensor that you want to modify.
4. Double-click the appropriate field in the virtual sensor’s entry. 

The field becomes read/write. 

5. Enter the appropriate values in the field. 
6. When you have finished setting the values, click Save Changes. 
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Ordering Virtual Sensors
If you have multiple virtual sensors on a network sensor, you can use packet filtering on the 
virtual sensors to determine which virtual sensor should receive which packets. When a packet 
arrives, it is compared to the inclusive filtering rules on each sensor, in the order in which the 
sensors were created or in the order configured on the sensor. If the packet matches a filtering rule 
of one of the sensors, it is sent to that sensor.

If a packet does not match any of the rules on any of the virtual sensors, the packet is sent to the 
sensor marked as default. If no sensor is marked as default, the packet is sent to the first sensor 
created or ordered as the first.

To order the virtual sensors:

1. In the Dashboard view of the IPS GUI, click the Systems tab. 

2. Right click the system on which you want to order the virtual sensors and select Configure 
Virtual Sensor. 

3. In the Configure Virtual Sensor(s) window, select the virtual sensor that you want to re-
order.

4. Drag and drop the virtual sensor to the appropriate position in the list. 
To set a virtual sensor as default, right click the appropriate virtual sensor and select Set as 
Default. The default sensor, marked with the padlock icon, is moved to the bottom of the list. 
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Adding Host Sensors
To add a host sensor:

1. In the Dashboard view of the IPS GUI, click the Systems tab. 

2. Right click the system on which you want to add a host sensor and select Add Host Sensor. 

3. In the Create Host Sensor window, enter a name for the host sensor and select the host policy. 
Host sensor policies are containers for a series of configuration items. For the Host Sensor, a 
policy contains each of the three Host Sensor Engines (EDE, EFE, and EAE) and the applicable 
modules contained in each engine, which may contain resources and signatures associated 
with those resources. Enterasys supplies some Master policies and some Custom policies. You 
can create your own custom libraries.

To create new policies for the sensor, see Chapter 13,”Host Sensor Policy Configuration”.

4. Click Create. 
The host sensor is added to the Sensors tab. 
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Changing the Host Sensor Policy
To change the policy of a host sensor:

1. In the Dashboard view of the IPS GUI, click the Sensors tab.

2. Right click the host sensor and select Set Host Policy. 

3. In the Set Host Policy window, select the host policy from the drop down list. 

4. Click OK. 
To create new policies for the sensor, or to copy existing policies, see Chapter 13,”Host Sensor 
Policy Configuration”.

Viewing a Sensor’s Log
To view a sensor’s log:

1. In the Dashboard view of the IPS GUI, click the Sensors tab.

2. Right click the sensor and select View Log. 

The log for the selected sensor opens. 
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To clear the log, click Clear Log. 

Moving Sensors
By default, auto-configured sensors are added to Standard Security Zone. If you move a sensor to 
another zone, zone-specific settings will be applied to the sensor. 

To move a sensor to another zone:

1. In the IPS GUI, select Configuration > Security Zones. 

2. Expand the security zone to which the sensor that you want to move is currently assigned. 
3. Right click the sensor and select Move to Zone. 

4. In the Move Sensor window, select the zone to which you want to move the sensor from the 
drop down list. 
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5. Click OK. 

Grouping Devices
On the Systems tab, you can create a system group to manage your Enterasys IPS devices more 
easily. You can set a host policy for the group and run operations for the group. For example, you 
can create a group called WebServer2003 that contains all Microsoft 2003 web servers, and then 
apply a host policy to the group.

Creating a System Group
To create a system group: 

1. On the Systems tab, click the  button to the right of the Group drop down menu. 

The Create System Group window opens. 

2. Enter a name for the group. 
3. Click Ok. 

The group is added to the Group menu on the Systems tab. 

4. Add systems to the group.
a. In the Systems tab, right click a system that you want to add to a group.

b. From the menu, select Group > Add selected to Group.
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The Select Group window opens.

c. From the drop down list, select the group to which you want to add the system. 

d. Click Ok. 

e. Repeat Step a through Step d to add more systems to the group. 

The Group menu is updated to indicate the number of systems in a created group. 

If you select a group from the Groups menu, the Systems tab view changes to show the systems in 
the group.

Once you have created a group and added systems to the group, you can perform the following 
operations on the group:

• Deploy the systems in the group

• Start the systems in the group

• Stop the systems in the group

• Restart the systems in the group

• Set host policy for the group

• Filter report and Find Event results for the group

Deploying, Starting, Stopping, and Restarting a System Group
To deploy, start, stop, or restart the systems in a system group:

1. From the Groups menu on the Systems tab, select the group on which you want to perform 
the operation. 

2. Right click a system in the group.
3. From the menu, select Group > Operations and the appropriate operation.
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Setting a Host Policy for a System Group
To set the host policy for the systems in a system group:

1. From the Groups menu on the Systems tab, select the group for which you want to set the 
host policy. 

2. Right click a system in the group.
3. From the menu, select Group > Set Host Policy on Systems in Group <name>.

The Select Policy window opens. 

4. From the drop down list, select the host policy that you want to apply to the systems in the 
group.

5. Click Ok. 
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Deleting a System Group
To delete a system group:

1. From the Groups menu on the Systems tab, select the group that you want to delete. 

2. Click the  button to the right of the Group drop down menu.

The Delete Group window opens. 

3. Click Yes. 
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Deploying Changes
To deploy changes on your device or sensor:

1. In the Dashboard view, click the Systems tab or the Sensors tab, as appropriate.

2. Right-click on the desired system or sensor and select Operations.
– If you are deploying changes on a system, select Deploy or Full Deploy. 

– If you are deploying changes on a sensor, select Deploy. 

Configuring System and Network Sensor Settings
From the Configure System window, you can set the following:

• For a device:

– Description information (description, MAC address, serial number)

– Configuration channel profile

– Event channel profile

– Heartbeat rate

• For a device’s network sensors:

– Enable debug

– Performance reporting

The system settings are displayed on the Systems tab. 

To configure system and network sensor settings:

1. On the Systems tab, right click a device and select Configure System

The Configure System window opens.
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2. Configure the system and network sensors as appropriate. See Table 6-1.
3. Click Save. 

Table 6-1 Configure System Parameters

Field Description

System Settings

Description A description of the system.

MAC Address The system MAC address.

Serial Number The system serial number. 

Config Profile The currently assigned config profile. If you have configured multiple config 
profiles, you can select a different config profile from the drop down menu.

Event Profile The currently assigned event profile. If you have configured multiple event 
profiles, you can select a different event profile from the drop down menu.

Heartbeat Rate This value, in minutes, specifies the interval between sending heartbeat 
messages from the system and its network sensors and host sensors. Valid 
range is 1–1440 minutes. Default value is 1 minute. 

Network Sensor Settings

Enable Debug Verbose information, including runtime output of the various internal 
operations, will be written to the logs/<instance_name>.log file.

Performance Reporting

Seconds Specifies the number of elapsed seconds before the performance report is 
written to the dragon.log.

Check Packet Length Instructs the sensor to show the packet count by length. 

Note: This option can generate large amounts of data.

Check Port Stats Instructs the sensor to show the packet count by port.
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If you set Seconds, Check Packet Length, or Check Port Stats, the sensors will report 
performance data to the NetworkSensor.log file in the <installdir>/logs directory.

Adding a Description for a Sensor
You can add a description for a sensor. The description is displayed on the Sensors tab. 

To add a description for a sensor: 

1. On the Sensors tab, right click a sensor and select Set Description. 

The Set Description window opens.

2. Enter the description for the sensor.
3. Click Save. 

Starting and Stopping Devices and Sensors
You can start, stop, or restart devices and sensors. Any action executed for the device is 
propagated to all associated nodes.

To start, stop, or restart sensors:

1. In the Dashboard view, click the Systems tab or the Sensors tab, as appropriate.

2. Right-click on the desired system or sensor and, select Start, Stop, or Restart from the 
Operations sub-menu.
The appropriate action is taken.
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Deleting Devices and Sensors
To delete a device or a sensor from the database:

1. In the Dashboard view, click the Systems tab or the Sensors tab, as appropriate.

2. Right-click on the appropriate device or sensor and select Delete. 
The device or sensor is deleted from the database. 
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Configuration Scopes

This chapter describes the configuration scopes that you can apply to IDS and IPS virtual network 
sensors.

Overview
There are three configuration scopes:

• Global —As the name suggests, the settings in the global configuration scope apply to all 
virtual sensors unless you override the settings at either the zone or sensor scope. 

• Zone —The settings in the zone configuration scope apply to a group of virtual sensors. You 
can create multiple zones. By default, virtual sensors are added to the Standard Security Zone. 
You can select the zone when you create the virtual sensor or you can move the virtual sensor.

• Sensor —The settings in the sensor configuration scope apply only to a specific virtual sensor. 

For information about... Refer to page...

Overview 7-1

Accessing the Configuration Scopes 7-2

Configuring a Scope 7-2

Creating a Zone 7-18

Deleting a Zone 7-18

Moving a Sensor to a Different Zone 7-19

Viewing Scope-specific Settings 7-19

Protocol Analyzers 7-19

Modules 7-28

Note: In previous Extreme IPSreleases, you could create network sensor policies. In Extreme IPS 
v8.2, zones replace network sensor policies. 
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Accessing the Configuration Scopes
To access the configuration scopes:

1. In the IPS GUI, select Configuration > Security Zones. 

2. Select the appropriate scope. 
Zones are nested under Global and sensors are nested under zones. 

3. If you want to see the settings for a specific zone or sensor, select the zone or sensor from the 
list. 

Configuring a Scope
Each configuration scope includes settings on five tabs:

• Signatures Tab

• Filters Tab

• Variables Tab

• IPS Settings Tab

• Advanced Tab
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Signatures Tab
This section only provides the information to associate signatures to the virtual network sensor. To 
create custom signatures, you must use the Signature Editor. For more information, see Chapter 9, 
Network Sensor Signature Libraries and Signatures and Appendix B, Signature Creation 
Overview.

By default, the STANDARD-IPS signature library is included in the scope. 

Adding a Signature Library
To add a signature library to a scope:

1. Select the scope in which you want to add the signature library. 

2. Click the Signatures tab.
3. Click Add Library. 

The Add Libraries window opens. 

4. From the list, select the library that you want to add. 
You can use Ctrl-click to select multiple signatures.

5. Click Save. 
The signature library is added to the list of libraries in the Signature tab. The scope to which 
you added the signature library is listed in the Scope column. 

Consolidating Signature Libraries
You can consolidate common signature libraries that have been assigned to either all sensors in a 
zone or all zones. 

To consolidate common signature libraries assigned to all sensors in a zone:
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1. In the Security Zones view, right click the zone that includes the sensors for which you want 
to consolidate the common signature libraries.

2. Select Consolidate shared libraries for this zone. 

The common signature libraries will now be listed in the Signatures tab for the zone. Only the 
signature libraries that are not assigned to all sensors in the zone will be listed in the 
Signatures tab for the sensors.

To consolidate common signature libraries assigned to all zones:

1. In the Security Zones view, right click the Global configuration scope. 

2. Select Consolidate Globally Shared Libraries. 

The common signature libraries assigned to all zones will now appear in the Signatures tab 
for the Global configuration scope. Only the signature libraries that are not assigned to all 
zones will be listed in the Signatures tab for the zones.
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Viewing Signatures in a Signature Library
To view the signatures in a signature library, select a signature library. 

In the Signatures pane at the bottom of the Signatures tab, the signatures in the library display. 

Use the Search field to find a specific signature. The search function is case insensitive. 

To view the Event Details and Event Analysis windows for a selected signature, right click a 
signature and select Signature Details or Event Analysis. 
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The Event Details or Event Analysis window opens, as appropriate. 

Enabling or Disabling a Signature
To enable or disable a signature:

1. In the Signatures pane, right click the signature that you want to enable or disable.

2. Select the Enable or Disable option from the menu. 

The value in the Enabled column changes accordingly. 

Note: The Event Analysis menu option is available only for certain user roles. 
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Deleting a Signature Library
To delete a signature library from a scope:

1. Select the scope from which you want to delete the signature library. 

2. Click the Signatures tab.
3. Select the signature library that you want to delete.
4. Click Remove Library. 

The Removing signature warning opens. 

5. Click Yes. 

Filters Tab
You can create event filters and traffic filters on the Filters tab. 

• Event filters: Suppress the network sensors from sending out events based on the event name 
and traffic attributes such as IP addresses, IP ports or protocol. Each filter entry is associated 
with an Event ID. You may have multiple event filter statements against the same event name.

Events generated by signatures have the same name as the signature. For example, when 
traffic matches the signature named RLOGIN:ROOT, the corresponding event is named 
RLOGIN:ROOT. 

• Traffic filters: Specify which traffic the network sensor should exclude from analysis.

Filters that you create through the Tuning Wizard are included in the list of event or traffic filters, 
as applicable. For more information about the Tuning Wizard, see the IPS Analysis and Reporting 
Guide. 

Filter Language
Table 7-1 lists the valid keywords of the filter language. 

Table 7-1 Filter Language Keywords 

Keyword Description Example

host Will match both source IP and destination IP addresses. host 10.100.100.10

srchost Will only match the source IP address. srchost 10.100.100.1

dsthost Will only match the destination IP address. dsthost 10.100.100.205

port Will match both source and destination ports. port 1234

port $port variable

srcport Will only match on the source port. srcport 80

srcport $port variable
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The valid operators are AND, OR, and NOT. 

You can nest keyword rules and operators by using parentheses to define precedence order.

Adding an Event Filter
To add an event filter:

1. Select the scope to which you want to apply the event filter. 

2. Click the Filters tab. 
3. Under Event Filters, click Add. 

4. Select an event from the Event Name drop down list.
You must select an event. 

5. (Optional) In the Filter field, enter the filter condition.
For filter help, click the help button next to the Filter field. 

6. Select the scope to which you want to apply the filter.

dstport Will only match on the destination port. dstport 6000

dstport $port variable

net Will match on the specified CIDR block or set of IP 
addresses in the IP variable. 

net 10.100.100.0/24

net $IP variable

srcnet Will only match against the source IP address or set of IP 
addresses in the IP variable.

srcnet 10.100.100.0/24

srcnet $IP variable

dstnet Will only match against the destination IP address or set 
of IP addresses in the IP variable.

dstnet 10.100.100.0/24

dstnet $IP variable

protocol Will only match the specific protocol (TCP, UDP, ICMP) protocol tcp 

vlan Will only match the specific VLAN or VLAN range. vlan 10

vlan 10-12

probe Will only match the specific probe. probe 2

Note: Traffic filters do not support AND, OR, and () operators. 

Table 7-1 Filter Language Keywords  (continued)

Keyword Description Example
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The Scope drop down list changes depending on which scope you have selected in the left 
pane. 

7. Enter a description for the filter. 
8. Click Update. 

Adding a Traffic Filter
To add a traffic filter:

1. Select the scope to which you want to apply the event filter. 

2. Click the Filters tab. 
3. Under Traffic Filters, click Add. 

4. In the Filter field, enter the filter condition. 
You must enter a filter condition. For filter help, click the help button next to the Filter field. 

5. Select the scope to which you want to apply the filter.
The Scope drop down list changes depending on which scope you have selected in the left 
pane. 

6. Enter a description for the filter. 
7. Click Update. 

Deleting a Filter
To delete an event or a traffic filter:

1. Select the scope from which you want to delete the filter. 

2. Click the Filters tab. 
3. Under Event Filters or Traffic Filters, select the filter that you want to delete. 
4. Click Remove. 
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Variables Tab
On the Variables tab, you can create, modify, or delete IP variables or port variables for a scope. 
You can include variables in filter definitions and network sensor signatures.

By default, the following IP variables and port variables are configured in the global scope.

• IP variables — A group of network assets. You can include and exclude specific IP addresses. 

– DnsServers

– FtpServers

– ProtectedNetwork

– SmtpServers

– WebServers

• Port variables — Specific ports or ranges of ports. 

– A — Any ports. Search traffic above port 0.

– B —Not web. NOOP overflows. Ignore port 80.

– FTP-PORTS — Port information for FTP analysis.

– H — High ports. Search traffic above port 1023.

– H-UDP-FILTER — Search for P2P traffic between hosts infected with the Conficker Worm.

– H225-PORTS — Port information for H225 analysis

– H245-PORTS — Port information for H245 analysis

– HTTP-PORTS — Port information for HTTP analysis
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– L — Low ports. Search traffic below 1023. 

– M — Net manage. Search SNMP traffic to port 161 and between ports 32771–32800 (RPC/
Solaris).

– MGCP-PORTS —Port information for MGCP analysis.

– MSRPC —Search for all traffic related to Microsoft Remote Procedure Call on ports 135, 
137–139, 445, and 1024–5000.

– N — Compromise. Search for NT keywords on ports 23, 53, 80, 135, and 139.

– P — Misuse. Search FTP, web, and NNTP for unwanted activities.

– PROBE-DETECTION-PORTS — Default monitored port ranges 

– Q — Search traffic going to/from ports 27900–27999.

– R — Search RPC traffic

– RPC-PORTS — Port information for RPC analysis

– S — SSH abuse. Search for SSH servers not on port 22. 

– SIP-PORTS — Port information for SIP analysis

– SMB — Searches for all Server Message Block traffic on ports 134, 137–139, and 445.

– SNMP-PORTS — Port information for SNMP analysis

– T — Used by TELCONVERT to specify ports to decode Telnet options.

– TELNET-PORTS — Port information for Telnet analysis.

– U — Search for NT keywords on ports 23, 53, 80, 135, and 139.

– W — Search for web traffic on ports 80, 3128, and 8080 (common proxy ports).

– X — Search for X Windows events on ports 6000-6070.

Creating a Variable
To create an IP variable or a port variable:

1. Select the scope in which you want to create an IP variable or a port variable. 

2. Click the Variables tab. 
3. Click the Add button and select IP Variable or Port Variable. 

The IP Variable or Port Variable section of the Variables tab opens.

4. In the Name field, enter a name for the variable. 
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You must name the variable. 

5. (Optional) In the Description field, enter a description of the variable. 
6. Specify the scope of the variable. 
7. Continue as follows for IP variables or port variables:

For IP variables:

a. From the drop down list, select whether the variable includes or excludes the IP address.

- IP—Include the specified IP address

- Not IP—Exclude the specified IP address

b. Specify the IP address and mask. 

If you don’t specify the mask, the mask is set to 32.

c. Click the  button to add the IP address to the variable. 

d. Repeat Step a through Step c to add more IP addresses to the variable. 

e. Click Update when you have finished adding IP addresses to the variable. 

For Port variables:

a. Specify whether the variable includes or excludes a port or port range.

- Port—Include the specified port

- Not Port—Exclude the specified port

- Port Range—Include the specified port range

- Not Port Range—Exclude the specified port range

b. Specify the port or port range.

c. Specify the traffic direction. 

d. Click the  button to add the port or port range to the variable.

e. Repeat Step a through Step d to add more ports or port ranges to the variable.

f. Click Update when you have finished adding ports or port ranges to the variable. 

Modifying a Variable
To modify an IP variable or a port variable:

1. Select the scope in which you want to modify an IP variable or a port variable. 

2. Click the Variables tab. 
3. Select the IP variable or port variable that you want to modify.

The IP Variable or Port Variable section of the Variables tab opens.

4. Modify the variable as appropriate. 
5. To delete an IP address, a port, or a port range from a variable, click the  button next to the 

appropriate entry. 
6. Click Update when you have finished modifying the variable. 
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Deleting a Variable

To delete an IP variable or a port variable:

1. Select the scope from which you want to delete an IP variable or a port variable. 

2. Click the Variables tab.
3. Select the IP variable or port variable that you want to delete. 
4. Click the Remove button above the variable list. 

IPS Settings Tab
On the IPS Settings tab, you can create event responses, a white list, and a black list for a scope. 

Creating an Event Response
An event response allows you to respond to a specific event with an action:

• Drop — Drops the packet.

• Reset — Generates a TCP reset in response to TCP traffic and sends an ICMP port unreachable 
message for UDP traffic.

• Block — Blocks the event. 

If you create an event response for a signature library, you can use the action set in the signature 
library’s meta data. For information about viewing a signature library’s meta data, see ”Viewing 
Signature Library Meta Data”.

To create an event response:

1. Select the scope for which you want to create an event response

2. Click the IPS Settings tab. 
3. In the Event Response section, click Add. 

4. From the Event Resource drop down list, select a signature library (master, custom, or 
dynamic), network sensor signature, or event. 

Notes: You should not delete a variable that is used in a filter definition. You should first remove the 
variable from the filter definition or delete the filter before deleting the variable. 

You cannot delete the predefined IP variables and port variables from the global scope. 

Note: Enterasys Networks recommends that you create an event response for the STANDARD-IPS 
signature library. Use the recommended actions defined in the signature library’s meta data.
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To filter the list, enter a search term in the Event Resource drop down list.
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5. Do one of the following, depending on what you chose in Step 4:
– If you selected a master signature library and you want to use the recommended action 

defined in the meta data for each signature in the library, click Recommended. 

For example, the STANDARD-IPS signature library includes signatures with the 
recommended actions of sending an alert and blocking traffic. If you create an event 
response using the STANDARD-IPS signature library and check the Recommended check 
box, the event response will use the defined recommended action to respond to an event 
that matches a signature. 

To view the recommended actions for the signatures in a master signature library, select 
the appropriate master signature library in Configuration > Network Signatures. See 
Figure 9-1 on page 9-2 and Table 9-1 on page 9-2.

– If you selected a network sensor signature, an event, or a signature library for which you 
do not want to use the event response defined in the meta data:

(1) Select the appropriate action (Drop, Reset, or Block).

(2) Depending on which action you chose, set values in the Reset & Duration, Block & 
Time, or Threshold fields.

To set a permanent block time, set the Block & Time field to 0.

6. (Optional) Add a filter condition in the Filter field. 

7. In the Description field, create a description for the event response.
8. Click Add.

Viewing Signature Library Meta Data
To view signature library meta data: 

1. In the Event Response list, right click the signature library and select Library Details from the 
right click menu.

The Signatures window opens.

Note: You can use parenthetical operators if you are creating a filter for events. You cannot use 
parenthetical operators if you are creating a filter for traffic. 
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Setting the White List and Black List
You can set a white list and black list for an IPS virtual sensor. 

To create a white list or black list. 

1. In the White List or Black List section, click Add. 

2. In the IP field, specify the IP address to be added to the white list or black list. 
3. (Optional) Specify the following:

– Host

– Protocol

– Port

– Direction

– Scope

4. In the Description field, create a description for the white list or black list entry. 
5. Click Update. 
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Deleting an Entry from the White List or Black List
To delete an entry from the white list or the black list:

1. In the White List or Black List section, select the entry that you want to delete.

2. Click Remove. 

Advanced Tab
On the Advanced tab, you can configure the protocol analyzer and module settings for a scope. 

The following protocol analyzers and modules are supported:

• Protocol analyzers

– FTP

– H225

– H245

– HTTP

– ICMP

– MGCP

– RPC

– SIP

– SNMP

– Telnet

• Modules

– Active Response

– Application Filter

– DoS Check

– Dynamic

– Network Layer

– Probe Detection

– Signature Direction

– Transport Layer

For information about the specific protocol analyzer and module settings, see “Protocol 
Analyzers” on page 7-19 or “Modules” on page 7-28.

To configure a protocol analyzer or module setting:

1. Select the scope for which you want to configure the protocol analyzer or module.

2. Click the Advanced tab. 
3. Select the protocol analyzer or module that you want to configure. 

To configure a module, select the appropriate module from the Set drop down list. 

4. Double-click the protocol analyzer or module setting that you want to configure. 
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The Value field becomes a read/write drop down list. 

5. Select the appropriate value. 
6. Click the Update/Override button. 

If you are in the Global scope or you are configuring a setting that was previously set for a 
zone or a sensor, the button is Update. 

If you are in the overriding a global setting, the button is Override. 

Creating a Zone
You can create multiple zones. 

To create a zone:

1. In the scope list, right click the Global scope and select Add Zone. 

2. In the Add Zone window, enter the name of the zone. 
3. Click OK. 

The new zone is added to the list of zones. You can now set the configuration of the zone and 
assign sensors to the zone. 

Deleting a Zone
To delete a zone: 

1. If you have any sensors assigned to the zone that you want to delete, move the sensors to 
another zone. 

You cannot delete a zone that has sensors assigned to it. 

2. In the scope list, select the zone that you want to delete. 
3. Right click the zone and select Delete. 
4. Click Yes. 

Moving a Sensor to a Different Zone
By default, all sensors are assigned to Standard Security Zone. 

To move a sensor to a different zone: 

1. Right click the sensor that you want to move and select Move to Zone. 

2. Select the zone to which you want to move the sensor. 
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Viewing Scope-specific Settings
By default, the scope tabs display settings for both the selected scope and the global scope. 

To view scope specific settings: 

1. Select the appropriate zone or sensor. 

2. In the upper right corner of the scope tabs pane, select the Zone Only or Sensor Only button.

The tabs panel refreshes to show only the zone or sensor-specific settings. 

To show all settings, select the Everything button. 

Protocol Analyzers
The Protocol Analyzers, set on the Advanced tab, allow you to configure the Network Sensor to 
perform analysis on a variety of protocols. The Protocol Analyzers check whether packets meet 
the requirements of the relevant protocol RFCs. 

FTP

The FTP protocol works by establishing a control connection and a data connection when data 
needs to be sent. The control connection can use Telnet commands that begin with the IAC byte 
(0xff). FTP analysis watches the control connection for these types of commands and interprets 
them for signature matching. 

Many times when an IAC command is sent in an FTP control connection, it is used as an attempt 
to evade an IDS. When FTP analysis is enabled, an event is generated for these types of evasions.

In addition, FTP analysis decodes TCP port 21 packets and streams that specify a port command 
for file transfer (port-request-check property). The decode extracts the command string which is 
of the form port x,x,x,x,p,p where x,x,x,x is the destination IP address and p,p is the destination 
port. If the destination IP address is not equal to the source address of this packet, the packet is 
logged as a security event [FTP-BOUNCE].

This attack may indicate FTP port scanning, FTP mail bombing, FTP hijacking and a variety of 
other suspicious events. However, this attack could also result from a non-passive FTP file transfer 
attempt from a network address translated client. It also looks for general port requests (the p,p 
from the x,x,x,x,p,p), which specify addresses lower than port 1024. Such a port may indicate 
attempts at email spoofing, remote login attempts, and other types of attacks. 

Table 7-2 lists the FTP protocol analyzer parameters and their default global values.
FTP 

Table 7-2 FTP Protocol Analyzer Parameters

Parameter Default Value

Debug false

Enable true
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H225

H.225 is the ITU-T’s call signaling protocol that can be used in session establishment for Voice over 
IP (VoIP). The H.225 protocol analyzer verifies that a legal message type is used, as defined in the 
ITU-T H.225 specification. The protocol analyzer also verifies that the H.225 message contains all 
of the mandatory IEs (Information Elements) and that any optional IEs used are legitimate. The 
format for each IE is checked to be correct and that the values of each field is within the proper 
range where applicable. Also, the H.225 Analyzer verifies that the User-User IE which is packed 
using PER (Packed Encoding Rules) uses the correct protocol identifier. If any of these conditions 
fail, then the H.225 protocol decoder raises an event [H225:INVALID-MESSAGE].

Analysis of this protocol is disabled by default because not all infrastructures support VoIP. 

Table 7-3 lists the H225 protocol analyzer parameters and their default global values.

Port Information FTP-PORTS

Port Request Check true

Verbose false

Table 7-2 FTP Protocol Analyzer Parameters

Parameter Default Value

Note: If the H.225 messages are encrypted, then the protocol decoder will generate an event for 
every message.

Table 7-3 H225 Protocol Analyzer Parameters 

Parameter Default Value

Connect Acknowledge 
Forbidden

true

Debug false

Disconnect Forbidden true

Enable false

Malformed Alerting Message true

Malformed Call Proceeding 
Message

true

Malformed Connect Message true

Malformed Facility Message true

Malformed Info Message true

Malformed Notify Message true

Malformed Progress 
Message

true

Malformed Release Message true

Malformed Set Ack Message true
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H245

H.245 is also an ITU-T call signaling protocol that can be used in session establishment for Voice 
over IP (VoIP). The H.245 protocol analyzer verifies that capability exchange, command, request, 
and response messages are legal, as defined in the ITU-T H.245 specification. If any errors are 
found, then the H.245 protocol decoder raises an event [H245:INVALID-MESSAGE].

Analysis of this protocol is disabled by default because not all infrastructures support VoIP. 

Table 7-4 lists the H245 protocol analyzer parameters and their default global values.

Malformed Setup Message true

Port Information H225-PORTS

Proto Discriminator Error true

Release Forbidden true

Resume Ack Forbidden true

Resume Forbidden true

Suspend Ack Forbidden true

Suspend Forbidden true

TPKT Bytes Error true

Unknown Message true

Verbose false

Table 7-3 H225 Protocol Analyzer Parameters  (continued)

Parameter Default Value

Note: If the H.245 messages are encrypted, then the protocol decoder will generate an event for 
every message.

Table 7-4 H245 Protocol Analyzer Parameters 

Parameter Default Value

Choice Index Command 
Mismatch

true

Choice Index Indication 
Mismatch

true

Choice Index Mismatch true

Choice Index Request 
Mismatch

true

Choice Index Response 
Mismatch

true

Debug false

Enable false
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HTTP

HTTP Analysis configuration simulates a web server when analyzing web traffic. The Network 
Sensor signatures that are string-based (not an exact binary match) are run through a filter before 
having their signatures matched. It protects the Network Sensor’s integrity by performing several 
transforms on the collected data that can be used to confuse the Network Sensor.

The HTTP Analysis settings includes the following properties that can be enabled or disabled:

• doc-root — If the doc-root attribute is enabled, then the HTTP Analysis module will log 
attempts by a web client to navigate to portions of the web server fleshiest that are not within 
the web server root directory. Such a web request would include a string like "../" or "..\".  If 
such a request is detected, then a [WEB:DOCROOT] event is generated.

• fast-analyze — Fast Analyze is a component of the Adaptive Pattern Matching Engine which 
provides streamlined processing for HTTP responses. HTTP response headers are examined 
and the payload is selectively inspected for signature-related events.

• iis-unicode — IIS-unicode interprets Unicode representations the way that IIS does. 

• unicode — Unicode decodes Unicode representations that are allowed in the Unicode 
Standard version 2. The main advantage to turning on unicode is that any web attack, such as 
/cgi-bin/phf, can be encoded using Unicode and evade common IDS web signatures. Any URL 
can be encoded with a valid Unicode representation of an ASCII character, and Network 
Sensor substitutes the correct character so signatures can match.

• multi-method — Multi-method is used to detect multiple requests made within a single 
packet. 

• null-method — Null method is used to detect multiple requests made within a null packet. 

The Allow Method section of the HTTP Analysis Settings window lists selected RFC 2616 (HTTP 
1.1) methods that you can select as acceptable for use on web servers located on the protected 
network.

Table 7-5 lists the HTTP protocol analyzer parameters and their default global values.

Extension Bit Mismatch true

Object ID Mismatch true

Port Information H245-PORTS

Verbose false

Table 7-4 H245 Protocol Analyzer Parameters  (continued)

Parameter Default Value

Note: If you have a problem with web signatures not triggering events when the HTTP Analysis 
module is turned on, set the fast-analyze property to no. Commit and then Deploy the change to 
your sensors. 

Table 7-5 HTTP Protocol Analyzer Parameters

Parameter Default Value

Connect false

Debug false
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ICMP
The ICMP protocol is used by a variety of normal and hacker activities. Logging all of that activity 
generates a lot of information. 

Table 7-6 lists the ICMP protocol analyzer parameters and their default global values.

MGCP

The Media Gateway Control Protocol (MGCP) was developed by the Internet Engineering Task 
force (IETF) organization. MGCP is designed for controlling a media gateway from external call 

Delete false

Doc Root false

Enable true

Events Use X Forwarded For false

Fast Analyze true

Get false

Head false

IIS Unicode true

Multi Method true

Null Method false

Option false

Port Information HTTP-PORTS

Post false

Propfind false

Put false

Trace false

Unicode true

Verbose false

Table 7-5 HTTP Protocol Analyzer Parameters

Parameter Default Value

Table 7-6 ICMP Protocol Analyzer Parameters

Parameter Default Value

Debug false

Enable true

Large 1400

Verbose false
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control elements called Media gateway controllers or Call agents. The MGCP protocol is an ASCII-
text based protocol (like HTTP and SIP) and is described in RFC 3435 [1]. 

This MGCP protocol decoder implementation is a top-down parser of the MGCP message 
(excluding the content). The protocol decoder for the MGCP protocol performs the following two 
functions: 

• The protocol decoder verifies that the MGCP message, consisting of the command line and 
has the proper BNF syntax as specified in Appendix A of RFC 3435 [1]. If the syntax of the 
MGCP message is not correct the protocol decoder generates an event. 

• The protocol decoder checks that the parameter names present in the MGCP message conform 
to the constraints (regarding their presence in the command present in the command line) 
listed in the Table present in section 3.3 RFC 3435 [1]. 

The protocol decoder assumes that the MGCP messages will be present on the port configured by 
the EMS. 

The protocol decoder assumes that the MGCP messages arriving on the configured port are not 
encrypted. If encrypted messages arrive, then the protocol decoder will generate an event for 
every message. 

The protocol decoder is stateless. It does not keep track of “connection” related to the message — 
that is, it does not try to associate an S message with a connection (existing or new). It takes a 
message, verifies that it conforms to the BNF syntax and generates an event if the message does 
not conform to the syntax. 

Table 7-7 lists the MGCP protocol analyzer parameters and their default global values.

Table 7-7 MGCP Protocol Analyzer Parameters 

Parameter Default Value

Bearer Info true

Call ID true

Capabilities true

Command Line Failed true

Conn ID true

Conn Mode true

Conn Parameters true

Debug false

Detect Events true

Digit Map true

Enable false

Event States true

Local Conn Opt true

Max Datagram true

Notified Entity true

Observed Events true
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RPC

The RPC Analysis feature uses several different techniques:

• The Network Sensor looks for RPC traffic that is attempting to connect to a portmapper 
(rpcbind) and issuing a SET, GETPORT, DUMP, or REDIRECT command. All UDP and TCP 
traffic on port 111 or ports in the 3277x range (Solaris sometimes starts RPC services higher 
up) are checked for RPC traffic. When such traffic is observed, one of the PMAP events is 
generated.

To cause the Network Sensor to attempt an RPC decode of every packet it sees, regardless of 
destination port, enable the any-port property. However, this property should only be enabled 
when your specific Network Sensor implementation has spare CPU cycles. Enabling any-port 
helps find intruders who are trying to go directly to various RPC ports without conversing 
with the portmapper service first.

By default, only inbound traffic to the protected network is monitored. To enable RPC 
monitoring of all traffic, disable the inbound-only property.

• The Network Sensor also inspects packets going to an RPC service for IDS evasion techniques 
and DoS attacks. These attacks use inherent obfuscations within the RPC protocol. RPC 
analysis converts the RPC payload into the correct format for the signatures to match. If you 
enable the verbose property, the sensor will also log RPC events when certain evasions occur. 

You can configure the sensor to watch only for specific RPC traffic, by configuring ignore and log 
rules in the RPC Log Elements area of the Analysis Settings window. These rules require that you 
enter the RPC program number.

Package List true

Port Information MGCP-PORTS

Quarantine Handling true

Reason Code true

Request Events true

Request ID true

Request Info true

Response Ack true

Restart Delay true

Restart Method true

Second Conn ID true

Second Endpoint ID true

Signal Requests ID true

Space Delimit true

Specific Endpoint ID true

Verbose false

Table 7-7 MGCP Protocol Analyzer Parameters  (continued)

Parameter Default Value
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Table 7-8 lists the RPC protocol analyzer parameters and their default global values.

SIP

The IETF’s SIP protocol is used in initial session establishment and session teardown for Voice 
over IP (VoIP). The protocol decoder for SIP performs two functions. First, it verifies that the SIP 
message (consisting of the Request/Status line and a sequence of message headers) has the proper 
BNF syntax as specified in section 25 of RFC 3261. Second, the SIP protocol analyzer checks that 
the field names present in the SIP message confirm to the constraints listed in section 20 of RFC 
3261. If either of the above conditions fail, the SIP protocol decoder raises an event.

Analysis of this protocol is disabled by default because not all infrastructures support VoIP. 

Table 7-9 lists the SIP protocol analyzer parameters and their default global values.

Table 7-8 RPC Protocol Analyzer Parameters

Parameter Default Value

Any Port false

Debug false

Enable true

Inbound Only true

Port Information R

Verbose false

Note: If the SIP messages are encrypted, then the protocol decoder will generate an event for 
every message.

Table 7-9 SIP Protocol Analyzer Parameters 

Parameter Default Value

Debug false

Enable false

Header Num Max true

Invalid Header Format true

Invalid Request Line true

Port Information SIP-PORTS

Token Length Exceed Bound true

Unrecognized Header true

Unrecognized Header Name true

Verbose false

Zero App Data Length true
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SNMP

The SNMP analysis feature provides quick SNMP protocol decodes. The evasion consists of 
obscuring the Object Identifier in an SNMP packet. Many signature-based IDSs rely on the Object 
Identifier to detect an attack, so this evasion is important if a user is running many SNMP 
signatures on a Network Sensor.

For example, using the Windows LanManager Object Identifier, 1.3.6.1.4.1.77, a Network Sensor 
signature matches this Object Identifier, but if the SNMP evasion technique is used, the 
LanManager Object Identifier becomes 1.3.06.01.04.01.077 and would successfully evade the IDS. 
With SNMP Analysis, the obscured LanManager Object Identifier gets converted back into 
1.3.6.1.4.1.77 and correct detection occurs.

Table 7-10 lists the SNMP protocol analyzer parameters and their default global values.

Telnet

The Telnet protocol, as defined by RFC 854 and companion RFCs, allows for in-band command 
communication. Therefore, it is possible to embed Telnet commands into the character stream to 
obscure an attack.

Functionality can be divided into three categories. First, the Network Sensor will look for and 
remove all of the defined in-line Telnet commands (and associated attributes). It will remove all 
backspace/delete characters and the associated characters that were deleted. Lastly, it will collapse 
spaces to a single space character. Analysis is applied to both Telnet and FTP. There is a possibility 
that Telnet events may be falsely generated on an FTP port and vice-versa.

Table 7-11 lists the Telnet protocol analyzer parameters and their default global values.

Table 7-10 SNMP Protocol Analyzer Parameters

Parameter Default Value

Debug false

Enable true

Port Information SNMP-PORTS

Verbose false

Table 7-11 Telnet Protocol Analyzer Parameters 

Parameter Default Value

Bad Cmd true

Binary true

Debug false

Enable true

Port Information TELNET-
PORTS

Verbose false
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Modules
The modules, set on the Advanced tab, allow you to configure the Network Sensor to perform 
analysis on a variety of protocols. The Protocol Analyzers check whether packets meet the 
requirements of the relevant protocol RFCs. 

A Network Sensor security zone contains modules that define the operation of the virtual sensor 
to which the security zone is applied. Each module provides the parameters to configure the 
behavior of the sensor relative to a logical grouping of sensor tasks.

Your choice of modules to include in a security zone depends on the configuration of the virtual 
sensor to which the security zone will be applied. You should consider:

• the types of traffic and packets that will be received by the virtual sensor,

• the address of the network the sensor is protecting (its protected network)

That is, you must know the types of traffic and packets that will be received by the virtual sensor, 
as well as the address of the network the sensor is protecting (its protected network) to create 
security zones that generate or suppress (filter) the desired events by the sensor and configure the 
desired logging/SNMP trap behavior by the sensor.

The following sections briefly describe the high-level behaviors that can be configured by each of 
the security zone modules. 

Active Response
Table 7-12 lists the Active Response module parameters and their default global values.

Table 7-12 Active Response Module Parameters

Parameter Description Default Value

Enable Module When set to true, the module is enabled. true

Enable TCP-ECM When set to true, the Virtual Sensor can spoof several 
responses to these highly specific probes. The responses 
will contain random TCP flag combinations. The random 
combinations defeat the automatic lookup of the expected 
response from the scanned server. The real response from 
the scanned server is still sent to the scanning computer, 
but most automatic scanners believe the first packets 
received from the scan. 

false
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Application Filter

This module defines traffic criteria that can be ignored by the sensor. Use this module to refine the 
data that the sensor analyzes, by telling the sensor what types of traffic and packets to ignore. By 
reducing the amount of data that the sensor has to look at, and therefore the number of events 
generated, you can often improve the performance of the sensor as well as the analysis process. 

Application filters are applied before any inspection of data occurs. Therefore, if a filter is 
matched, the sensor does not do any further processing of the data — that is what is meant by 
saying that the data is “ignored.” In general, if you know of a particular class of traffic that can be 
ignored (for example, from a particular IP address or VLAN), then you should use a filter, since 
this will generally lessen the load on the sensor.

Use the settings to configure the sensor to ignore traffic based on direction with respect to the 
sensor’s protected network. 

The sensor can ignore traffic that is:

• Entirely within the protected network (both source and destination addresses inside protected 
network)

• Entirely external to the protected network (both source and destination addresses outside of 
protected network)

• From the protected network (only source address within protected network)

• To the protected network (only destination address within protected network)

You can potentially improve performance by watching only the traffic that is coming into or out of 
your protected networks and ignoring internal traffic. For example, if you have a lot of internal 

Enable TCP-ECM 
(continued)

The sensor will send four different random responses to 
the target server. Each packet will have the correct source 
port and IP address reversed. The hardware source and 
destination addresses will also be reversed. 

This behavior may be used by hackers to identify the 
existence of a Network Sensor. Normally, the Network 
Sensor is completely passive, but this features is a double-
edged sword. Hackers may also spoof scans from places 
like www.whitehouse.gov and cause the Network Sensor 
to send these random packets back to them - USE WITH 
CAUTION! 

The TCP-ECM packets are generated only if the probe 
packets are to a protected network. It will not work for 
outbound, external, or internal packets. Also, the Network 
Sensor does not generate events which record the 
occurrence of the TCP-ECM events. 

Interface The interface that should be used to send TCP RST 
packets to knock down TCP connections. If Extreme 
Networks IPS is sniffing on eth1 and eth0 is used to 
manage Extreme Networks IPS (that is, eth0 has an IP 
address assigned to it but eth1 does not), then you should 
set this interface value to eth0.

eth0

Table 7-12 Active Response Module Parameters

Parameter Description Default Value
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network traffic such as NFS, Microsoft file sharing, or internal DNS lookups, then ignoring 
internal traffic will result in a noticeable performance increase. With Linux, the performance 
increase will result from Extreme IPS’s quick decision to drop internal packets.

Ignoring all entirely external packets to the protected networks allows the Network Sensor to 
concentrate only on packets that involve the protected network in some way.

Ignoring all packets sourced within the protected networks and destined for IP addresses not in 
the protected networks allows the sensor to concentrate on packets entering the set of protected 
network ranges.

Ignoring all packets with a destination IP address in the protected networks and a source IP 
address not in the protected networks allows the sensor to concentrate on packets leaving the set 
of protected ranges.

Table 7-13 lists the Application Filter module parameters and their default global values.

DoS Check

This module allows you to add Denial of Service checking to a Network Sensor. When Denial of 
Service checking is enabled, the Network Sensor searches packets for distinct trademarks of 
specific denial of service tools that are in use and freely available. The sensor will generate 
different DOS internal events, depending on the tool. If a Denial of Service attack is observed, the 
event data will contain the attack information.

The DoS check module implements two classes of tests for DoS/DDoS agents: 

• Rate-based tests. For example, high rates of inbound SYN packets may indicate a SYN flood 
DoS.

• Packet header tests. For example, the “Bonk” DoS tool is detected through a specific IP ID 
value in the IP header along with a specific IP offset value.

The DoS check module can generate the following events, each of which describes a different DoS/
DDoS tool or condition: 

Table 7-13 Application Filter Module Parameters 

Parameter Description Default Value

Ignore External Traffic Ignore traffic entirely external to the protected network 
(both source and destination addresses outside of 
protected network).

false

Ignore From Traffic Ignore traffic from the protected network (only source 
address within protected network).

false

Ignore Internal Traffic Ignore traffic entirely within the protected network (both 
source and destination addresses inside protected 
network).

false

Ignore To Traffic Ignore traffic to the protected network (only destination 
address within protected network).

false

Table 7-14 DoS Check Module Events 

Event DoS/DDoS Tool or Condition

[DOS-JOLT] icmp,jolt/win95ping
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Table 7-15 lists the DoS Check module parameters and their default global values.

Dynamic

Dynamic Logging enables the sensor to record packets from IP addresses that are involved in 
events. When an event occurs, the Network Sensor makes a best effort to grab subsequent packets 
from the source and destination IP addresses of the event packet. The number of recorded packets 
is determined by the specific alarm or signature. Additional amounts of Dynamic packet logging 
can be set for all events, by specifying the number of Cushion packets the Network Sensor should 
collect in addition to the normal number of packets specified by the signature or alarm. 

For example, if a PHF attack signature has a Dynamic packet capture level of 10 packets and the 
Cushion value is set to 5 packets, the Network Sensor will attempt to collect 15 packets. This 

[DOS-MODEM] icmp,modem-attack

[DOS-1234] icmp,x1234

[DOS-JOLT2] icmp,jolt2

[DOS-BONK] udp,bonk

[DOS-BOINK] udp,boink

[DOS-TEARDROP] udp,teardrop/overdrop

[DOS-NEWTEAR] udp,newtear

[DOS-NESTEA] udp,nestea/nestea2

[DOS-OSHARE] udp,oshare

[DOS-SAIHYOUSEN] udp,SAIHYOUSEN

[DOS-SYNDROP] tcp,syndrop

[DOS-LAND] tcp,land/latiera

[DOS-TARGA] tcp,winnuke-targa

[DOS-WINNUKE] tcp,winnuke

[SYN-BOMB] target=%d.%d.%d.%d,%s,%s,%s

[SYN-BOMB] target=%d.%d.%d.%d,%s,%s,%s

Table 7-15 DoS Check Module Parameters

Parameter Description Default Value

Enable Denial of Service 
Check

When set to true, DoS checking is enabled. true

Enable Denial of Service 
Debugging

When set to true, debugging information is logged in the 
NetworkSensor.log. 

You should not enable debugging unless requested to 
do so by Enterasys Technical Support.

false

Enable Verbose Mode Log the DoS checking in verbose mode. false

Table 7-14 DoS Check Module Events  (continued)

Event DoS/DDoS Tool or Condition
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parameter is meant as an easy way to quickly turn up the sensitivity of a Network Sensor. The 
extra logging may have a negative impact on system performance or on Network Sensor hard 
drive space.

Table 7-16 lists the Dynamic module parameters and their default global values.

Network Layer

The Network Layer module defines what IP packet header fields the Network Sensor should 
analyze and what actions the sensor should take when it finds certain anomalous values in those 
fields (malformed headers, headers that don’t match the relevant RFCs). You can also configure 
certain fragment rebuilding parameters.

• IP packets can be logged or ignored based on IP option type and source IP address, or on IP 
protocol and source address. 

• Fragmented packets can be logged or ignored based on source address and protocol.

• Packets from a particular network or IP address can be logged.

• Packets with strange broadcast destination addresses can be logged. These packets are most 
likely denial of service attacks, network probes, or malfunctioning routers. 

Table 7-17 lists the Network Layer module parameters and their default global values.

Table 7-16 Dynamic Module Parameters

Parameter Description Default Value

Enable Logging When set to true, dynamic packet logging is enabled. true

Number of Cushion Packets The number of additional packets to capture. 0

Table 7-17 Network Layer Module Parameters 

Parameter Description Default Value

Check IP Options for Zero 
Length or EOL

Tells the sensor to look for any packets with IP options of 
zero length or post EOL (End Of Line) IP options. 

There are non-compliant IP stacks in existence that 
make a variety of violations in normal everyday traffic. 
This means that this setting may result in many false 
positives. Some denial of service attacks exist for 
network devices that simply consist of post EOL IP 
options.

true

Checksum Verification 
Frequency

If Is the Checksum Verification Frequency Option 
Active is true, this value indicates how often this test 
should be carried out. For example, a value of 5 
indicates that the test should be carried out every 5th 
packet. 

1
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Drop Packets with minimum 
TTL

Causes the Network Sensor to drop packets that 
destination machines may never receive, rather than try 
to reassemble them. If a Network Sensor is n hops in 
front of a protected network, the Network Sensor should 
ignore all packets with a TTL of n-1.

Topology can be used against packet-based IDS 
products. IP packets with low TTLs may not make it to 
their destination. If the Network Sensor is not aware of 
these topology constraints, it might attempt to 
reassemble packets that destination machines never 
even see.

2

Enable Debugging Tells the sensor to output the current status of the 
network layer fragment reassembly algorithm and how it 
is rebuilding fragmented traffic. Do not enable this option 
unless told to do so by Enterasys Technical Support.

false

Enable Fragment Rebuild The Network Sensor attempts to rebuild all IP fragments 
that are traveling to the protected network. For 
performance reasons, the Network Sensor does not 
attempt to reassemble fragments from the protected 
network.

Fragments are reassembled when the total amount of 
data is equal to the packet length determined by the 
fragment without the more fragments (MF) bit set. When 
a pseudo-packet is rebuilt, it is injected into the Network 
Sensor packet processing engine for evaluation. If an 
event occurs with this packet, an extra event is also 
generated indicating that the packet was reconstructed. 
For packet analysis, these pseudo-packets have an IP 
checksum of zero, a TTL of 255 and an ID value of 0xffff. 
If an event occurred and was rebuilt from IP fragments, it 
will also include an event name of [FRAG-REBUILD] 
and message data of (this-event-was-reconstructed).

true

Enable Large Fragment The Network Sensor alerts on any fragment offset larger 
than a fixed value of 565. Since fragment offsets are 
measured in units of 8 bytes, an event is generated for 
any fragment whose initial position in the original packet 
is larger than 4520 bytes. The value is currently set to be 
larger than a fragmented packet from an FDDI network.

true

Enable Network Layer 
Analysis

Enables Network Layer Analysis. This option is enabled 
by default.

true

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value
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Favor Old Tells the Network Sensor to favor old data when it 
receives overwriting data.

When IP fragments are reassembled, it is possible for a 
hacker to generate traffic that overwrites itself. Imagine a 
single packet split into two fragments. If a hacker sends 
the first fragment, followed by a fake first fragment, some 
operating systems will keep the original data while 
others will believe the second fake fragment. This 
discrepancy can be used to confuse a network sensor. 

Windows NT and Solaris systems tend to keep the data 
in the first few packets and discard any overwriting data. 
Other systems, such as Linux, Irix, and HP-UX, favor 
new data. You can choose to favor old data on the 
system.

An alert titled [FRAG-OVERLAP] is generated during IP 
fragmentation reconstruction if overlapping data is 
detected. This may indicate that a network problem has 
occurred or that a malicious user is attempting to bypass 
the packet-based IDS system or the firewall.

All networks tend to have overwriting IP fragments that 
result from corrupted packets and broken equipment. An 
analysis of the overwritten data and the subsequent 
packets from the IP addresses involved should be 
conducted for each event of this type. If the data is very 
random or seems like garbage, it is fairly safe to ignore 
these events. On the other hand if the event is web 
traffic, email traffic or something that is recognizable, 
some time should be invested to discern the nature of 
the event. In most cases, the responses from the target 
will not be fragmented and can be used to provide some 
clue as to what is happening.

true

Is the Checksum Verification 
Frequency Option Active

Selecting this option tells the sensor to validate the IP 
checksums of packets that are directed at the protected 
network. 

Purposely crafted IP packets with bad checksums can 
fool packet-based IDS devices into accepting packets 
that a destination host would reject. Although the 
frequency value provides a statistical sampling 
technique designed to balance performance with IP 
checksum verification, in many cases, this option should 
not be enabled. 

Modern routers drop any IP packets that do not have the 
correct checksums. In an Internet environment, it is very 
difficult for an attacker to send corrupted IP packets 
unless they are one hop away from the Network Sensor. 
This prevents Internet attackers from using this 
technique. However, insiders and attackers who have an 
intimate knowledge of your topology could exploit this. 
All of these factors (including the impact on 
performance) should be weighed when enabling or 
disabling this feature.

false

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value
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Log <= TTL Value Tells the sensor to log any packet with an IP time-to-live 
value less than or equal to the specified value. The 
default value is 0. A common value for the TTL value is 
5. The maximum value is 10.

The intent of this option is to record traceroute packets 
as well as attempts to bypass intrusion detection 
systems with small TTL settings. When packets are 
logged, the protocol and ports are recorded.

The Network Sensor will report a [LOWTTL-UDP] or a 
[LOWTTL-TCP] event if the packet is UDP or TCP, less 
than the TTL value, and the destination port is less than 
1024. This is to differentiate possible traceroute attempts 
to ports above 1024 with events names such as 
[TRACE-TCP] and [TRACE-UDP]. ICMP-based 
traceroute events are labeled [TRACE-ICMP]. Finally, 
unknown low TTL packets that are not UDP, TCP or 
ICMP are labeled [LOWTTL-UNKNOWN].

0

Log First Fragmented Packet Enables the sensor to decode any TCP fragments with 
an IP fragment offset of zero. The fragment must contain 
enough information in the packet to obtain the source 
port, destination port and TCP flags. 

Offsets of zero occur naturally on some networks, but 
also occur when hackers want to artificially create 
fragmented packets for Syn scanning, bypassing of 
firewalls, and other activities. Selecting this option tells 
the Network Sensor to record any of these packets and 
decode the source and destination port as well as the 
TCP flags. Basically, when TCP traffic is fragmented, 
this setting will attempt to log the beginning of the 
fragmented packet for further analysis. These events are 
labeled [FIRST-TCP-FRAG].

true

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value
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Log Frag TCP Flags Overlay Enables the sensor to decode TCP packets with a 
fragment offset of 1.

Fragment offsets of 1 happen on some networks, but 
they are extremely rare. More likely they are artificial 
packets generated by a hacker. It is a technique used to 
bypass some firewalls and avoid port scanning 
detection. Using an offset of 1 creates packets that have 
source and destination ports in one packet, and the TCP 
flags in another. This confuses many network devices 
including firewalls and some intrusion detection 
systems. The Network Sensor will record the entire 
packet, and gather subsequent packets if Dynamic 
logging is enabled. However, if other portions of the 
fragmented packet arrive first, it may not be recorded. 
These events are labeled [TCP-FRAG-OVERLAY].

This setting most commonly picks up on NMAP 
fragmented Syn scans where the TCP destination and 
source ports arrive in the first fragment, but the TCP 
flags arrive in the second packet. It also occurs when a 
remote attacker attempts to bypass a network IDS by 
artificially fragmenting their packets into smaller packets.

true

Log LocalHost Traffic Tells the sensor to log any packet with a source or 
destination address to or from 127.0.0.0/8. This address 
space is reserved. A variety of attacks choose their 
source addresses from this block. This option is selected 
by default.

Application Note for Ethernet Only: Because these 
packets are probably spoofed, the hardware address is 
recorded for these packets for further analysis. Keep in 
mind that if a hacker has local layer 2 network access, 
they can spoof the source hardware address. However, 
if the attacker is remote, the hardware address can tell 
you where the attack is coming from on your network.

There is also a good chance that these events result 
from incorrectly configured routers. In this case, the 
hardware address is also useful in debugging these 
problems. 

Many tools that use IP source address spoofing that 
choose from the range of 0.0.0.0 to 255.255.255.255 
have a one in 256 chance of choosing an address in the 
127.0.0.0/8 range. Tools like NMAP have this problem 
when they spoof decoy packets.

true

Log Max MTU Events Tells the sensor to log Max MTU events. true

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value
7-36 Configuration Scopes



Modules
Log Null Source or 
Destination Address

Tells the sensor to log packets with the same address as 
both source and destination and to log packets with a 
null value for source or destination address. These 
options are selected by default.

These types of packets could be an attack, a NAT 
problem, or a wide variety of other issues. Regardless, 
these events are interesting and recorded. For Ethernet 
sensors, the data portion of these events also includes 
the hardware address for further analysis. Most 
commonly, these events occur with poorly configured 
routers and multicast protocols. Keep in mind that denial 
of service attacks do not need to reply back to their 
source address, but most attacks do.

true

Log Packets with Reserve Bit 
Turned On

Causes the sensor to log any IP packet with the 
reserved bit turned on. This bit is not used by IP 
networks, but is still part of the IP header. It is reserved 
for future use. Several years ago, many packet filters 
could be bypassed simply by enabling this bit. Old 
routers incorrectly treated this bit as part of the IP 
fragmentation offset field.

true

Log Same Source and 
Destination Address

Tells the sensor to log packets with the same address as 
both source and destination and to log packets with a 
null value for source or destination address. These 
options are selected by default.

These types of packets could be an attack, a NAT 
problem, or a wide variety of other issues. Regardless, 
these events are interesting and recorded. For Ethernet 
sensors, the data portion of these events also includes 
the hardware address for further analysis. Most 
commonly, these events occur with poorly configured 
routers and multicast protocols. Keep in mind that denial 
of service attacks do not need to reply back to their 
source address, but most attacks do.

true

Maximum MTU Size (Bytes) Tells the sensor to drop any IP packet to the protected 
network that has the don’t fragment (DF) bit set and is 
larger than this specified value. For example, suppose a 
Network Sensor is in front of a network segment with an 
MTU of 1300 bytes, possibly a VPN. If a packet destined 
for the WWW server shows up with a size of 1350 bytes 
and its don’t fragment bit set, the border device will drop 
the packet and probably issue an ICMP fragmentation 
needed message. If the sensor is not aware of this 
topology issue, it may incorrectly pick up that packet and 
become confused, especially if this packet was crafted to 
look like it was part of an ongoing attack session.

You should specify a value equal to the maximum 
segment size (MSS) of your network. Packets that are 
larger will require fragmentation. The default, and 
maximum, value is 1500 bytes.

1500

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value
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Probe Detection

The parameters set with this module configure the way the Network Sensor tracks probing 
activities that cannot be detected by rule-matching or protocol anomaly detection. The probe 
detection module builds vast internal tables to keep track of the following factors: 

• Number of destination hosts

• Number of destination ports

• Number of source hosts

• Time over which the packets were sent

The module provides configuration settings that control how the sensor collects information and 
generates events under certain situations.

The Probe Detection module has two areas for configuration:

• The options in the Probe Detection Settings area configure the thresholds used by the 
Network Sensor when it performs port scan and port sweep analysis.

• The Port Ranges table is used to specify which port ranges you want the Network Sensor to 
consider when analyzing for port scans and sweeps.

Table 7-18 lists the Probe Detection module parameters and their default global values.

Small Fragment Offsets Tells the Network Sensor to alert on any IP fragment 
offset that is larger than 0 but smaller than the specified 
byte length. 

There are several tools available that will automatically 
fragment traffic for a hacker. Many of these tools 
generate fragments with small payloads. These 
payloads of 24, 16 or even 8 bytes seldom occur 
naturally. They are a good indication that someone may 
be performing a denial of service attack on your network 
or attempting to bypass a packet-based intrusion 
detection system. If the fragments are all of an offset of 
1, this is a common signature of a fragmented port scan.

The offset value is specified in fragmented units, which 
means that a value of 1 translates to eight bytes. Values 
of 16 and 24 are good choices. 

32

Table 7-17 Network Layer Module Parameters  (continued)

Parameter Description Default Value

Table 7-18 Probe Detection Module Parameters 

Parameter Description Default Value

Debug It is recommended that you do not set this to true, which 
causes debug output for the specific module to be 
written to the log file. The debug output can cause the 
log file to grow significantly in a short amount of time. 
The debug setting should not be left active for long 
durations.

false

Enable When set to true, the Probe Detection module is 
enabled.

true
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Hosts per Port Threshold This field specifies the maximum number of destination 
hosts that can be accessed on a specific port before the 
network sensor determines that these hosts have been 
swept and generates a [TCP-SWEEP] or [UDP-SWEEP] 
event.

5

Monitored Port Range 
Variable

Specifies the monitored port range. PROBE-
DETECTION-
PORTS

Ports per Host Threshold This value specifies the maximum number of destination 
ports that must be accessed per destination host before 
the network sensor determines that the destination host 
has been scanned and generates a [UDP-SCAN] or 
[TCP-SCAN] event.

5

Protocols per Host Threshold When the number of different protocols used by an 
external host to probe a computer on the protected 
network exceeds the protocol scan event threshold, a 
[PROTOCOL-SCAN] event is generated.

3

Sliding window length in 
seconds

This option tells the Network Sensor how long (in 
seconds) it will collect unique network packets or events 
before evaluating the entire collection for sweeps and 
scans. Packets are collected for unique protocol, 
destination service, source IP address, and destination 
IP address values. For example, if IP #1 sent an ICMP 
echo request to IP #2, this packet would be collected. 
Subsequent echo requests from IP #1 to IP #2 would not 
be collected because they are not new traffic. Likewise, 
if IP #1 visited IP #2’s web server on port 80, the first 
packet would be collected but all other port 80 traffic 
between them would not.

Once this value is reached, the Network Sensor 
conducts an analysis of the data collected during the 
specified time period. After that, the probe engine buffer 
is flushed. The maximum number of seconds is 1209600 
(two weeks).

Adjusting this parameter changes the sensitivity of the 
Probe Detection module. To detect slow port scans, this 
value should be set to a longer duration. However, a 
longer duration could allow an overwhelming amount of 
data to accumulate, which could lower Network Sensor 
performance.

50000

Verbose Specifies an ordered list of the information used to 
generate an alert. For a port scan, this option instructs 
the sensor to provide a list of all of the ports that were 
probed. In the case of a sweep, all of the IP addresses 
that were probed are placed in the event payload.

The size of the payload is limited to 1500 bytes. The 
sensor will include as much of the detail as possible and 
leave (...) at the end if the payload was truncated.

true

Table 7-18 Probe Detection Module Parameters  (continued)

Parameter Description Default Value
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Signature Direction
Table 7-19 lists the Signature Direction module parameters and their default global values.

Transport Layer
Use the Transport Layer module to configure Transport Layer logging and event generation 
options.

Table 7-20 lists the Transport Layer module parameters and their default global values.

Table 7-19 Signature Direction Module Parameters 

Parameter Description Default Value

External same as towards Applies rules to external network traffic as if it had come 
toward the protected network.

false

Internal same as from Applies rules to internal network traffic as if it had come 
from the protected network.

false

Toward same as any Applies rules to all network traffic as if it had come 
toward any protected network. Selecting this option 
allows ‘toward’ signatures to match in the situation 
where (a or the) protected network is incorrectly 
specified or incomplete.

false

Table 7-20 Transport Layer Module Parameters 

Parameter Description Default Value

Check for Non-Zero SYN 
bytes

Tells sensor to analyze all of the data in captured SYN 
packets for non-zero bytes. Most operating systems that 
pad SYN packets with a small payload of data, do it with 
zeros. This alert indicates that a SYN packet was 
received that contains a non-zero event. There is a very 
high false positive rate with this event. These events are 
labeled [SYN-DATA-NZ], but includes a non-zero data 
element in the event message data.

true

Check for Zero Length TCP 
Options

Tells the sensor to look for any packet that has a zero 
length TCP option or a post EOL TCP option. The events 
generated by this option are labeled [TCP-OPTS].

There are a lot of poor IP stacks out there that do not 
conform to the standards. There is a large set of normal 
traffic that has poor TCP option implementations and this 
setting may produce false positives. However, tools such 
as NMAP make extensive use of TCP options for remote 
operating system identification. Some denial of service 
attacks against Windows platforms also use TCP 
options. 

false
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Enable Stream Building Reconstructs UDP and TCP sessions for all types of 
traffic. Consider a busy web server farm where you only 
wish to analyze web traffic inbound to the farm, but not 
outbound. The performance gain is immense, but this 
makes the sensor blind to outbound attacks from your 
protected networks, which are spread across multiple 
packets. Normally this is an acceptable risk, but it is still 
a consideration. 

If a UDP or TCP session is rebuilt and an event occurs, 
that event will have a tcp-stream or udp-stream message 
in its event message data.

true

Enable Transport Layer 
Analysis

Enables this module. This parameter is selected by 
default.

true

Force Rebuild Allows the Network Sensor to continue stream 
reassembly (for example, Telnet sessions) even if an 
individual packet has been logged as an event. Typically, 
the Network Sensor will not continue stream reassembly 
if one of the packets triggers an event due to the 
overhead processing involved.

true

Log TCP Checksum Events Logs event [BAD-TCP-CKSUM] when TCP Checksum 
Verification discovers a discrepancy. 

false

Log Zero Valued Source and 
Destination Ports

Logs any TCP or UDP packet with a source or 
destination port of zero. Such packets may be the result 
of NAT devices, busy DNS servers and a variety of 
hacker scanning and probing attacks. This alert ignores 
fragments.

Some tools send TCP packets to port zero in an effort to 
identify the type of operating system based on the 
response from such a query. Not every operating system 
responds on port zero the same way. These tools can 
keep a database of unique responses for each operating 
system, then determine the remote type with one or two 
packet probes. 

false

Rebuild All Traffic Rebuilds all UDP and TCP traffic to and from the 
protected network as well as within the protected 
network.

true

Session Window Specifies the size of the buffer, in bytes, into which 
Extreme IPS reassembles data for each TCP session. 
Therefore, it is the number of rebuilt bytes of application 
session data that the Network Sensor will send to the 
pattern matching engine for each TCP session. 

Possible values are 0–2500 bytes. Zero indicates that no 
session data is sent.

100

Stream Rebuilding Verbose Log the rebuilt traffic streams in verbose mode. false

SYN Data Max Sets the maximum length of data, in bytes, that a SYN 
packet can have before an alert is generated. The event 
generated is [SYN-DATA]. The default value is 10 bytes. 
The maximum value is 64 bytes.

10

Table 7-20 Transport Layer Module Parameters  (continued)

Parameter Description Default Value
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SYN-Bomb Threshold The Network Sensor counts the number of TCP packet 
types entering and leaving the protected networks. 
Every time it sees a SYN packet, a counter is 
incremented. When an Rst, Syn-Ack, or Fin packet is 
received, the counter is decremented by three. There 
are separate counters for outbound and inbound traffic.

When a counter exceeds the value of the Syn Bomb 
Threshold, the Network Sensor collects the next 500 
SYN packets and assumes that the most common 
destination address is under SYN attack. The event 
generated is named [SYN-BOMB].

False SYN-BOMB events may be reported if a network 
server has gone down. Anytime there is an imbalance 
between the number of SYN packets and other TCP 
packets, a SYN-BOMB event may occur.

Keep in mind that for large web sites, when a URL grows 
stale or when a web server goes down for maintenance, 
all of the normal network traffic may look like a SYN 
bomb since none of those sessions will be receiving 
Syn-Acks or Rst packets from the web servers. 

500

TCP Checksum Verification 
Frequency

Tells the Network Sensor to verify the integrity of 
inbound TCP packets by calculating their checksum and 
comparing it to the value in the packet. If a discrepancy 
is discovered, the packet is dropped.

The checksum verification will only be applied to non-
fragmented traffic. Fragmented packets will only be 
evaluated after Extreme IPS has reconstructed the 
underlying IP packet.

The value entered is used to indicate how often this test 
should be carried out. For example, a value of 5 checks 
every 5th packet. The valid range is 0 to 255.

0

Trust Tells the sensor not to check for TCP sequence and 
acknowledgement numbers, including checks on the 
sequence number in RST packets attempting to shut 
down TCP connections. Enterasys recommends that 
you leave this option disabled.

false

Table 7-20 Transport Layer Module Parameters  (continued)

Parameter Description Default Value
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Configuration Channel and Event Channel Profiles

Extreme Networks IPS is pre-configured with default configuration channel and event channel 
profiles: Standard Configuration Channel and Standard Event Channel. You can modify these 
profiles or create additional profiles to assign to systems.

For information about... Refer to page...

Creating a Configuration Channel Profile 8-2

Changing the Configuration Channel Profile Used by a System 8-4

Deleting a Configuration Channel Profile 8-5

Viewing Configuration Channel Profile Usage 8-5

Creating an Event Channel Profile 8-6

Changing the Event Channel Profile Used by a System 8-9

Deleting an Event Channel Profile 8-10

Viewing Event Channel Profile Usage 8-10
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Creating a Configuration Channel Profile
Creating a Configuration Channel Profile
To create a configuration channel profile:

1. In the IPS GUI, select Configuration > Channel Profiles.

2. On the Config Channel tab, click Add. 
3. In the Add Config Channel Profile window, enter a name for the new configuration channel 

profile. 

4. Click OK. 
The new configuration channel profile is added to the list and it displays in the right pane. 

The new configuration channel profile takes on the attributes of the configuration channel 
profile that you selected to launch the right click menu. 

The connection information of the EMS server is supplied in the Primary Info fields. Use the 
Secondary Info fields to configure high availability. For more information about high 
availability, see Appendix A, Configuring EMS High Availability. 

5. Configure the new configuration channel profile. Table 8-1lists the parameters.

Table 8-1 Configuration Channel Profile Parameters 

Parameter Description

Description A description of the configuration channel profile.
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Creating a Configuration Channel Profile
Shared Secret Used in the encryption algorithm. This setting must match the value entered 
during the installation process on this device, and it must exactly match the 
shared secret established on the EMS server for a Configuration Channel 
connection to be established. 

The maximum number of bytes is determined by the encryption type (set in the 
Encryption Type field under Advanced Config Channel Settings). For 
Blowfish connections, the shared secret can be up to a maximum of 56 bytes, 
and cannot contain any embedded spaces. For AES connections, the shared 
secret can be up to a maximum of 32-bytes, and cannot contain any 
embedded spaces. 

Do not use the following characters in the shared secret:

• & - &amp;

• < - &lt;

• > - &gt;

• “ - &quot;

• ‘ - &#39;

• \

Connection Info

Primary Info

Host Name The name of the primary EMS server. 

IP The IP address (IPv4 or IPv6) of the primary EMS server. 

Port The port used by the configuration channel profile on the primary EMS server. 
This value must match the port number you entered during the installation 
process on this device. It is recommended that you accept the default value of 
9111.

Secondary Info

Host Name The name of the secondary EMS server. 

IP The IP address (IPv4 or IPv6) of the secondary EMS server.

Port The port used by the configuration channel profile on the secondary EMS 
server. 

Advanced Config Channel Settings

Encryption Type Select the encryption type you entered during the installation process on this 
device. Possible values are AES and Blowfish. 

Connection Type This value must match the connection type you entered during the installation 
process on this device.

• Sensor to Server indicates that the host system will initiate the 
Configuration Channel connection. 

• Server to Sensor indicates that the EMS will initiate the Configuration 
Channel connection.

Retry Interval The number of seconds to wait to reestablish connections for each retry. 
Default is 5 seconds. 

Table 8-1 Configuration Channel Profile Parameters  (continued)

Parameter Description
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Changing the Configuration Channel Profile Used by a System
6. Click Save.

Changing the Configuration Channel Profile Used by a System
By default, Standard Configuration Channel is assigned to systems. 

To find out which configuration channel profile your system is currently using:

1. In the Dashboard view of the IPS GUI, select the Systems tab. 

2. Select the appropriate system from the list. 
3. Open the Details panel. 

The currently assigned configuration channel profile is listed under Configuration Channel. 

To change the configuration channel profile used: 

1. In the Dashboard view of the IPS GUI, select the Systems tab. 

2. Right click the appropriate system in the list. 
3. From the right click menu, select Configure System. 

Retries Indicates the number of times the device should attempt to reestablish the 
Configuration Channel. Note that this field can only be configured if the 
Connection Type is Server to Sensor, which means that the EMS will 
attempt to reestablish the channel.

By default, 0—unlimited retries—is selected. 

Table 8-1 Configuration Channel Profile Parameters  (continued)

Parameter Description
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Deleting a Configuration Channel Profile
4. In the Configure System window, select the configuration channel profile from the Config 
Profile drop down list. 

5. Click Save. 

Deleting a Configuration Channel Profile

1. In the IPS GUI, select Configuration > Profiles. 

2. On the Config Channel tab, right click the configuration channel profile that you want to 
delete and click Delete. 

3. Click Yes. 

Viewing Configuration Channel Profile Usage
To view the list of systems that use a configuration channel profile:

1. In the IPS GUI, select Configuration > Profiles. 

2. On the Config Channel tab, select a configuration channel profile.
3. In the right pane, expand Systems Using this Profile. 
The list displays the names of the systems that use the currently selected configuration channel 
profile.

Note: Do not delete a configuration channel profile that is currently assigned. 
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Creating an Event Channel Profile
The event channel profile includes cache manager agent settings. On UNIX platforms, Extreme 
Networks IPS uses a ring buffer to hold events generated by the Network and Host Sensors. These 
events reside in memory and are made available to any Extreme Networks IPS agent that is 
enabled. For example, in an enterprise configuration, any events generated by the Host Sensor are 
placed in the ring buffer until the Event Channel agent consumes the event and sends it over the 
network. During periods of time where the agents cannot consume events at the pace that the 
Sensor is generating events, caching will occur.

To create an event channel profile:

1. In the IPS GUI, select Configuration > Channel Profiles.

2. Click the Event Channel tab.

3. On the Event Channel tab, click Add. 
4. In the Add Event Channel Profile window, enter a name for the new event channel profile. 
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Creating an Event Channel Profile
5. Click OK. 
The new event channel profile is added to the list and it displays in the right pane. 

The new event channel profile takes on the attributes of the event channel profile that you 
selected to launch the right click menu. 

6. Configure the new event channel profile. Table 8-2 lists the parameters.

Table 8-2 Event Channel Profile Parameters 

Parameter Description

Description A description of the event channel profile.

Shared Secret Used in the encryption algorithm. This setting must match the value entered 
during the installation process on this device, and it must exactly match the 
shared secret established on the EMS server for an event channel connection 
to be established. 

For Blowfish connections, the shared secret can be up to a maximum of 56 
bytes, and cannot contain any embedded spaces. For AES connections, the 
shared secret can be up to a maximum of 32-bytes, and cannot contain any 
embedded spaces. 

Do not use the following characters in the shared secret:

• & - &amp;

• < - &lt;

• > - &gt;

• “ - &quot;

• ‘ - &#39;

• \

Connection Info To add a connection to the event channel profile, see Step 7.

Advanced Event Channel Settings

Encryption Type Select the encryption type you entered during the installation process on this 
device. Possible values are AES and Blowfish. 

Connection Type This value must match the connection type you entered during the installation 
process on this device.

• Sensor to Server indicates that the host system will initiate the event 
channel connection. 

• Server to Sensor indicates that the EMS will initiate the event channel 
connection.

Retry Timer The number of seconds to wait to reestablish connections. Default is 5 
seconds.
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7. Add a connection. 
On Windows device nodes, the Event Channel can have only one destination, defined in the 
Event Channel Settings with the Remote Server IP address. Also, a Windows device node 
cannot have any event source nodes configured.

On Linux/UNIX device nodes, each agent can support multiple Event Channel connections 
between the local node and other event source or event destination nodes. Each connection 
can be configured with different settings. 

a. Under Connection Info, click Add Connection. 

b. Enter the name of an existing device node or select one from the Hostname drop-down 
menu. This node will send events to the device being configured.

The IP Address field is automatically filled in with the IP address of the device after you 
select the host name.

It is recommended that you do not change the Port number from the default. This port is 
the TCP port used for Event Channel communications.

c. Click Update. 

8. Click Save. 

Enable Debug Debugging means that verbose information is written to the logs/
<instance_name>.log file as Extreme Networks IPS operates. This information 
includes run time output of various internal operations the sensor performs. It 
is not recommended that you enable debugging unless requested to do so by 
Enterasys Tech Support.

Cache Manager Agent Settings

Number of Cache Files The number of cache files among which the Cache Manager will split all 
cached events. This number should not be changed from the default unless 
the customer frequently caches large numbers of events.

Maximum Cache File Size This value in bytes is used to limit the overall size of the cache used by a 
server to prevent running out of disk space. This value is limited by the 
available disk space on the server.

Enable Debug Outputs additional information to assist the Enterasys Networks support team 
to isolate problems that are found in the field. This should not be enabled 
unless instructed to do so by the Enterasys Networks Support team.

Note: Each Event Channel connection can have its own set of parameters, as long as they are 
consistent between the local node and the other end of the connection. 

Table 8-2 Event Channel Profile Parameters  (continued)

Parameter Description
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Changing the Event Channel Profile Used by a System
By default, Standard Event Channel is assigned to systems. 

To find out which event channel profile your system is currently using:

1. In the Dashboard view of the IPS GUI, select the Systems tab. 

2. Select the appropriate system from the list. 
3. Open the Details panel. 

The currently assigned event channel profile is listed under Event Channel. 

To change the event channel profile used: 

1. In the Dashboard view of the IPS GUI, select the Systems tab. 

2. Right click the appropriate system in the list. 
3. From the right click menu, select Configure System.

4. In the Configure System window, select the event channel profile from the Event Profile drop 
down list. 

5. Click Save. 
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Deleting an Event Channel Profile
Deleting an Event Channel Profile

1. In the IPS GUI, select Configuration > Profiles. 

2. On the Event Channel tab, right click the configuration channel profile that you want to delete 
and click Delete. 

3. Click Yes. 

Viewing Event Channel Profile Usage
To view the list of systems that use an event channel profile:

1. In the IPS GUI, select Configuration > Profiles. 

2. On the Event Channel tab, select an event channel profile.
3. In the right pane, expand Systems Using this Profile. 
The list displays the names of the systems that use the currently selected event channel profile.

Note: Do not delete an event channel profile that is currently assigned. 
8-10 Configuration Channel and Event Channel Profiles



9
Network Sensor Signature Libraries and

Signatures

Network Sensor Signatures Overview
The Network Sensor has a powerful signature recognition engine that can quickly process a 
packet or network session for suspicious data strings in the data portion of packets. These 
suspicious data strings are defined in signatures, which are stored and read each time the 
Network Sensor is started.

When a signature data pattern is matched, the Network Sensor can drop the packet, send a 
transport layer error packet (a TCP reset for TCP connections or an ICMP port unreachable 
message for UDP traffic), and/or activate a persistent firewall blocking rule, in addition to 
generating an event.

Extreme Intrusion Prevention System includes a comprehensive set of vulnerability and 
exploit-based signatures. These predefined signatures are organized in master libraries and 
dynamic libraries, as shown in Figure 9-1. A dynamic library is a collection of signatures that 
match query criteria. 

You can also create additional dynamic libraries and custom libraries. The custom libraries can 
contain master signatures and custom signatures. 

You can assign the signature libraries to a configuration scope (to a network sensor, to a security 
zone, or globally).

For information about... Refer to page...

Network Sensor Signatures Overview 9-1

Signature Libraries and Event Categories 9-3

Using the Signature Editor 9-5

Modifying Master Library Signatures 9-22

Custom Signature Libraries 9-23

Custom Signatures 9-26

Dynamic Signature Libraries 9-27
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Network Sensor Signatures Overview
Figure 9-1  Signatures View

To view a list of the signatures in a signature library, select a signature library in the left pane. The 
list of signatures displays in the right pane. Table 9-1 describes the columns in the right pane. 

Table 9-1 Signature Pane Columns 

Column Description

Name The name of the signature.

Recommended Action The action, recommended by Extreme Networks, to be taken when a matching 
event occurs:

• blank (no action listed)—Send an alert.

• alert—Send an alert.

• block—Block the traffic for flows in which the event is detected.

You can use the recommended action in an event response. For more information, 
see “Creating an Event Response” on page 7-13.

Score The severity score of the signature. Possible scores are Critical, High, Medium, 
and Low.

Enabled Whether the signature is enabled or disabled. 

Event Group The event group to which the signature belongs.

Date Modified The latest revision date of the signature.

Type Indicates whether the signature is a master signature or a custom signature.

User Edited Indicates, with a check mark, if signature has been modified by the user. 
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Signature Libraries and Event Categories
Signature Libraries and Event Categories
Each predefined signature included with Extreme IPS is assigned an event category based on the 
signature's function. Master libraries organize the signatures into collections by their event 
category. When an event is generated as a result of a signature match, the event is named with the 
name of the signature. For example, if the signature AFS:OVERFLOW-TCPDUMP (from the 
ATTACKS Master Library) is matched, an event named AFS:OVERFLOW-TCPDUMP is 
generated. 

In the Extreme IPS reports, generated events are organized by event groups, which have the same 
names as the master libraries. You can use event groups as a way to filter event reporting.

When you create your own custom signature libraries and custom signatures, the events 
generated will be named with the name of your custom signature and will be assigned to the event 
category specified during signature configuration. 

Table 9-2 describes the type of signatures contained in the predefined master libraries, and 
therefore, the types of events grouped under the equivalent event categories in the Extreme IPS 
reporting tools. 

Description The description of the signature

Table 9-1 Signature Pane Columns  (continued)

Column Description

Table 9-2 Master Libraries and Event Categories 

Master Library/ 
Event Category

Description

Applications (APPS) This category contains signatures for applications that are not suspicious or a form of misuse. A 
signature may be placed in APPS if it is traffic that does not fit into MISUSE or SUSPICIOUS, 
because the applications themselves are normally used in business (unlike P2P clients and other 
apps).

ATTACKS An ATTACK is an event that is most commonly generated from a potential “attacker” and is destined 
to one or more “victims” (that is, in TCP, the establisher of a connection). The results of an ATTACK 
may not always result in remote access to the end host. However, it will always have the potential to 
compromise the integrity of the end system. This could come in the form of (but not limited to) data 
leakage or modification, access loss (DoS), or actual remote access.

What doesn't belong here: Any string that can be transmitted or seen in legal/normal traffic.

BETA This category is used mostly for the converted signature set, but also contains any signature that 
has been tested with Extreme IPS, but not tested for all environments. Any signature of this type is 
placed in this classification for a short time for customers to test.

COMPROMISE A COMPROMISE is an event which generally comes from a “victim” to one or more potential 
“attackers.” Events in this category will be the direct result of something that would/should be in any 
of the other categories, except VIRUS.

What doesn't belong here: Any string that can be transmitted or seen in legal/normal traffic.

DYNAMIC This category is for follow-on signatures, which are signatures that are applied to packets captured 
as a result of another signature match.

FAILURES This category is for signatures that detect errors sent from one host to another indicating that a 
particular request could not be fulfilled.
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LEGACY Since signatures are never deleted, this category contains signatures that have been deprecated for 
some reason. This category also includes old signatures that are false positive prone (for example, 
maybe the application is no longer used). The signatures are kept in this category for historical 
reference. 

MALWARE This category contains signatures to detect traffic specific to malware that do not belong in the 
TROJAN, SUSPICIOUS or VIRUS categories. Examples include 180solutions and HotBar, where 
user-agents and setting updates are tracked.

MISUSE This category contains signatures that detect anything that does not directly compromise the 
integrity of a host, but is typically forbidden by corporate policy for legal/security reasons. This type 
of traffic includes such things as, for example, chat, porn, or job searching.

What doesn't belong here: Things that are against most corporate security policies like system 
management applications (for example, pcAnywhere), or data hiding and encryption channels, or 
anything else that typically requires additional analysis (anything that might belong in SUSPCIOUS).

MISUSE-P2P This category contains signatures that detect the use of peer-to-peer software, for example, file 
sharing networks such as Limewire, Gnutella, or Napster. 

NETWORK This category was created for network applications and signatures that detect their traffic.

PROBE A PROBE is generally a characteristic of a scanner of some kind. For example, seeing “Host: 
Nessus” in a web request would point to someone running a probe against you.

What doesn't belong here: A PROBE is not related to the target application/service itself. For 
instance, AnyForm is an application that has not been updated in many years and has many 
vulnerabilities. It is typically probed for by automated scanners, but this still does not make its 
presence in a request a probe. Its presence is indeed suspicious, but requires further analysis to 
determine its true reason for being there. For this reason, an event like that would be placed in the 
SUSPICIOUS category.

SCADA This category contains signatures that are related to Supervisory Control And Data Acquisition 
(SCADA) networks. This includes any type of infrastructure processes.

STANDARD-IPS This category contains signatures that have low rates of false-positives, and can be trusted to be run 
inline, that is, in IPS mode instead of IDS mode. 

SUSPICIOUS Many events in this category will be attacks, but their presence is not 100% indicative of an attack. 
This category consists of events that do have the chance of occurring naturally and legally in traffic. 
These events require a bit more analysis to ensure they are positive alarms.

What doesn't belong here: Anything that can go into another category with 100% certainty (or 
close to it). For example, a bunch of NOOPs followed by shellcode and /bin/sh in Telnet traffic is 
definitely an ATTACK.

TROJAN This category contains signatures that detect any indication of a back channel actually being set up, 
or of someone remotely accessing a system. Back Orifice and NetBus channels are example of 
such traffic.

Table 9-2 Master Libraries and Event Categories  (continued)

Master Library/ 
Event Category

Description
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Using the Signature Editor
Using the Signature Editor
Use the Signature Editor to create or edit a signature. 

In the Signature view, you can launch the Signature Editor from the Create menu or from a 
specific menu. You can also launch the Signature Editor from anywhere in the IPS GUI where a 
signature is listed. 

The Signature Editor has four sections: 

• Base (see “Base Section Parameters” on page 9-6)

• Match Criteria (see “Match Criteria Section Parameters” on page 9-8)

• Advanced (see “Advanced Section Parameters” on page 9-18)

• References (see “References Section Parameters” on page 9-21)

VIRUS This category contains signatures that detect any program that automatically propagates itself and 
carries a Trojan or system logs as its payload. The key differentiator between this category and other 
likely categories is that the program tries to spread and infect other hosts in the process, all 
automatically.

What doesn't belong here: Not the actual sending of a log back to an attacker, or someone trying 
to access a Trojan/backdoor that was installed by a virus. Most of that type of activity is ATTACK, 
SUSPICIOUS, or COMPROMISE activity. Also, viruses that do not carry a backdoor or send out 
sensitive information are typically not looked for by Extreme IPS, as virus scanners are much more 
adept at finding this behavior.

VOIP The VOIP category is for signatures that trigger on any of the VoIP protocols. The VoIP decoders 
also generate events.

VULNERABILITY These signatures are passive in nature. These are systems on the network that could leave you 
open to attack. For example, telnet sessions to routers where a password is not required, or old 
servers that are riddled with vulnerabilities like outdated sendmail servers. These signatures are just 
looking for banners indicating that one of these systems are on your network, not that someone has 
tried to attack it.

What doesn't belong here: Any activity related to someone trying to gain access to a system. 
Someone sending a NULL password is not a VULNERABILITY. The fact that a router let the person 
log on with a NULL password is a VULNERABILITY.

WEB-APPLICATION-
ATTACK

These signatures refer to any type of web application attack, which includes web servers, and any 
type of attack that does not fit in the other web categories.

WEB-BROWSER-
ATTACK

Signatures detecting any attack against a web browser, such as Internet Explorer, Firefox, Chrome, 
Opera, and Lynx, are placed in this category.

WEB-FILE-INCLUDE These signatures refer mostly to PHP applications that are vulnerable to remote-file include 
vulnerabilities.

WEB-SQL-ATTACK These signatures include any type of web attack that is a form of SQL injection.

WEB-XSS-ATTACK Signatures for Cross-Site Scripting (XSS) attacks are placed in this category.

Table 9-2 Master Libraries and Event Categories  (continued)

Master Library/ 
Event Category

Description
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Using the Signature Editor
Base Section Parameters

Table 9-3 describes the parameters in the Base section of the Signature Editor window. 

Table 9-3 Base Section Parameters 

Field Description

Name The name of the signature. If you are editing an existing signature, this field will be greyed out. 
Signature names should not exceed 63 characters in length. 

A signature name can contain any combination of characters, excluding spaces. Usually, signature 
names have at least two fields, with the first two fields separated by a colon (:). The first field 
indicates the highest-layer protocol affected by the exploit/vulnerability. The second field indicates 
the specific application that is affected. All following fields are separated by a dash (-). Often, a third 
field is added as a one-word description of the event taking place, and in cases of overlap with 
existing signatures, a fourth field is added indicating the component of the application that is 
vulnerable or the difference from other exploits.

For example, a suitable name for a signature for a PHP email application called “phpemail” that 
allows for an arbitrary file on the server to have its contents revealed could be either:

WEB:PHPEMAIL-DISCLOSURE or SMTP:PHPEMAIL-DISCLOSE-WEB

Enabled Enables the signature being configured after configuration is complete. Disabled signatures are 
globally excluded from being output to any sensor.

Follow on Signature Creates a follow on signature, which is evaluated only when dynamic packets have been collected 
as a result of a match by another signature. (See the Dynamic Collection option below.)

OS The operating system that would likely see the signature:

• UNIX

• Solaris

• Windows

• Novell

• Embedded

• Any

This field is blank by default. Currently, this field is for the your information only, and it is not used by 
the sensor.

Score Assign a severity (Critical, High, Medium, Low) to the signature. The score can be used by a 
Security Information Manager (SIM) such as the Enterasys Security Information and Event 
Manager.
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Classification The Event Group of the signature. For more information about Event Groups, see Signature 
Libraries and Event Categories on page 9-3. 

Dynamic Collection Specify how many packets of the conversation the sensor should collect after the signature is 
matched. A conversation is defined by source and destination IP address and source and 
destination ports. 

For example, for a Telnet login failure, the signature could instruct the Virtual Sensor to capture the 
next 5 packets between the Telnet server and the IP address that had the login failure. This allows a 
greater level of analysis to be applied to a security event.

Direction Service direction refers to the signature port. Select:

• any if the signature should match packets with either or both destination and source ports that 
match the configured Signature Port value. any can be used to watch traffic in both directions. 
(default)

• source if the signature should match packets with a source port that matches the configured 
Signature Port value. Typically, source is used for packets originating from the server.

• destination if the signature should match packets with a destination port that matches the 
configured Signature Port value. Typically, destination is used for packets directed to a well 
known port on a server. 

• both if the signature should match packets with both a source and destination port that matches 
the configured Signature Port value. 

Traffic direction refers to the direction of flow with respect to the protected network defined on the 
virtual sensor. Select:

• any to apply the signature to all traffic (default). 

• toward to apply the signature to traffic toward the protected network.

• from to apply the signature to traffic originating from the protected network. 

• internal to apply the signature to traffic that is entirely internal to the protected network. That is, 
both source and destination are located within the protected network.

• external to apply the signature to traffic that is entirely external to the protected network. That is, 
both source and destination are located outside the protected network.

Protocol Specify the protocol to which the signature applies: 

• TCP (default)

• UDP

• ICMP

Signature Port Specify the layer 4 port or ports to which the signature applies. 

• To specify a single port, select Port and enter the port number. 

• To specify multiple ports or port ranges, select Port Variable and then select the desired macro 
from the pull-down menu. 

• Select Match Negative if you want the signature to match if the port is not the value specified. 
For example, if you selected the pre-defined port macro W, which specifies ports 80, 8080, and 
3128, and then selected Match Negative, the signature would apply to all ports except 80, 8080, 
and 3128.

Description Describe the attack the signature is designed to detect, and any additional information that might be 
useful for analysis.

Table 9-3 Base Section Parameters  (continued)

Field Description
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Match Criteria Section Parameters

Table 9-4. describes the parameters in the Match Criteria section of the Signature Editor window. 

Table 9-4 Match Criteria Section Parameters 

Field Description

Flow Specifies that Extreme IPS should generate an event only if the corresponding TCP session is in the 
specified state. For example, to force a signature to match only if a packet originated from the server 
side of an established TCP session, you would select a direction of source-server and a state of 
established.

• Direction: Select from:

target-server — Match traffic flowing toward the server.

target-client — Match traffic flowing toward the client.

source-server — Match traffic flowing from the server.

source-client — Match traffic flowing from the client.

• State: Select from:

established — Match established TCP connections.

no-state — Match regardless of the state of the stream processor. This is useful for packets that 
are designed to cause machines to crash.

stream-strict — Match only rebuilt stream packets.

no-stream — Do not match on rebuilt stream packets. This is useful for when you want your 
match elements to apply to individual packets and not rebuilt stream payload.
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Match Element To add a match element to the signature:

1. Click Add Match Element

2. Set the parameters in the Signature Match Settings. See “Match Element Settings” on page 9-10 
for more information.

3. Click OK. 

When you create multiple match elements, you can reorder them using the up and down arrows, 
and Extreme IPS will automatically change the match order.

1. To edit a match element:

2. Double-click the match element.

3. Edit the parameters.

4. Click OK.

5. Click Update.

To delete a match element:

1. Select a match element.

2. Click Remove Match Element

3. Click Save.

Source • Address—A single source IP address and network mask. Network masks can range from 0-32 
for IPv4 and 0-128 for IPv6. 

If you select Match Negative, the signature will match if the source address of the packet is not 
the address specified.

Note: To specify more than one IP address or a range of IP addresses, use the IP Variables 
parameter. 

• Port—Enter the source port or ports to match. 

To specify a single port, select Port and enter the port number. Valid values range from 0 to 
65536.

To specify multiple ports or port ranges, select Port Variable and then select the desired macro 
from the pull-down menu. 

Select Match Negative if you want the signature to match if the port is not the value specified. 
For example, if you selected the pre-defined port macro W, which specifies ports 80, 8080, and 
3128, and then selected Match Negative, the signature would apply to all ports except 80, 8080, 
and 3128.

• IP Variables—Select one or more IP variables to create a signature that will match on more than 
one specific IP addresses or a network range. 

• Specify an IP variable to create , you must use a IP Variable as the source address can only 
contain a single address or network.

• Add one or more IP variables. You can specify IP variables instead of specifying an IP address 
and mask in the Address field. 

Table 9-4 Match Criteria Section Parameters  (continued)

Field Description
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Match Element Settings

Clicking Add Match Element launches the Signature Match Settings window. 

Signature match settings define the pattern in the data portion of packets that the signature is 
looking for. 

Destination • Address—Enter the destination IP address and network mask. Network masks can range from 0-
32 for IPv4 and 0-128 for IPv6. 

If you select Match Negative, the signature will match if the destination address of the packet is 
not the address specified.

• Port—Enter the destination port or ports to match. 

To specify a single port, select Port and enter the port number. Valid values range from 0 to 
65536.

To specify multiple ports or port ranges, select Port Variable and then select the desired macro 
from the pull-down menu. 

Select Match Negative if you want the signature to match if the port is not the value specified. 
For example, if you selected the pre-defined port macro W, which specifies ports 80, 8080, and 
3128, and then selected Match Negative, the signature would apply to all ports except 80, 8080, 
and 3128.

• IP Variables—Add one or more IP variables. You can specify IP variables instead of specifying an 
IP address and mask in the Address field. 

Table 9-4 Match Criteria Section Parameters  (continued)

Field Description
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Specifying Signature Pattern Strings

The Network Sensor has several string definition features that allow you to create powerful, yet 
efficient pattern searches. The most basic string definition is to simply type a string of letters and 
numbers without any spaces such as this:

This-is-a-test-string

To specify non-printable characters, you can use the ‘/’ (slash) character as an escape character to 
specify two alphanumeric values which represent a hex number. The hex ASCII code for ‘-’ is 0x2d 
which means that the above example could be represented like:

This/2dis/2da/2dtest/2dstrings

To search for a ‘/’ character, use the hex value for ‘/’ which is 0x2f. Here i a string that searches for 
/cgi-bin/phf:

/2fcgi-bin/2fphf

You can use the 0x20 character to represent a space. The following example searches for “see spot 
run” followed by a new line:

see/20spot/20run/0a

Wild Cards

There are four available wild card characters. All wild cards represent a single byte that may be 
used to represent the following ranges:

• ? – Any byte

• * – Any printable character (alpha-numeric, /n, /r, and so on)

• $ – Any non-printable character (negative of printable character set)

• # – Any number

Because these characters are used as wild cards, attempting to search for them in normal traffic 
requires that the corresponding hex escape code by used. The escape codes are:

• ? – 0x3f

• * – 0x2a

• $ – 0x24

• # – 0x23
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Table 9-5 Signature Match Configuration Parameters

Field Description

Match Type Select the match type:

• Extended Pattern—allows a pattern to take into account HTTP header fields with the HTTP 
Region option and URL-encoded data with the Normalize option. See Table 9-6 for Extended 
Type parameters. 

• PCRE—allows you to configure a Perl Compatible Regular Expression match against network 
traffic. See Table 9-7 on page 9-13 for PCRE parameters.

Note: In general, if you know the exact format of the content you are trying to match (including 
the proper number of spaces), use the Extended Pattern type. For any data that may be variable, 
use PCRE. Strict content checks (of sufficient length) are generally more efficient than regular 
expressions. 

• Payload Test—allows you to verify binary values or convert representative byte strings to their 
binary equivalent and test them. See Table 9-8 on page 9-14 for Payload Test parameters.

• Payload Jump—uses values within packet data as the input to the number of bytes to jump 
further into the packet for additional payload tests. See Table 9-9 on page 9-15 for Payload Jump 
parameters.

• Payload Position—can be used with other signatures to verify that there is data at a byte offset 
from a previous match. See Table 9-10 on page 9-16 for Payload Position parameters.

Distance Specifies the number of bytes required between two successive matches within a packet. That is, 
you can tell the sensor how far into the packet it can go, relative to the end of the previous pattern 
match, before it starts looking for the pattern match (exclusive). Using this option requires that at 
least two Application Layer matches be configured. The valid range is between 0 and 1514 bytes. 

Within Specifies within how many bytes from the end of the previous pattern the next pattern must occur 
(inclusive). This option is relative to Distance or previous pattern match. Using this option requires 
that at least two Application Layer matches be configured. The valid range is between 0 and 1514 
bytes. 

For example, if you set distance = 8 and within = 4 in the same match element, this tells Extreme 
IPS to start searching for the pattern after 8 bytes from the end of the previous pattern AND the 
newly searched pattern must be within 4 bytes from the start of a match. That is, the pattern should 
be found between bytes 9 and 12, inclusive, after the end of the end of the previous pattern match.

Offset Specifies how many bytes to skip from the beginning of the packet payload before matching starts 
(exclusive). An offset of 10 would tell the sensor to index 10 bytes into the data field of the packet 
before beginning to look for a match. The valid range is between 0 and 1514 bytes.

Depth Specifies in bytes when the sensor should stop trying to match a pattern (inclusive). The bytes are 
measured from the start of the packet payload if Offset has not been configured. If Offset has been 
configured, the bytes are measured relative to the offset. For example, if an Offset of 10 and a Depth 
of 30 are specified, then the sensor will search from byte 11 through byte 40.

Table 9-6 Extended Pattern Parameters 

Field Description

Pattern Enter the pattern to search for. Use the same notation for specifying hex codes as used with Basic 
patterns. Refer to “Specifying Signature Pattern Strings” on page 9-11 for information.
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Type Select the type of match to perform.

• binary — A binary match searches to an exact match of the search string, including all unique 
upper case and lower case characters.

• string — The sensor converts the data to be searched to lower case, then attempts to match it 
with the signature pattern. If the pattern has upper case letters, the strings will never match.

• negative — A negative signature is based on the absence of data. The signature looks for an 
initial pattern and then, if one or more different strings do not immediately follow it, the signature 
evaluates as true. The negative pattern must immediately follow the initial pattern. Unlike the 
combination signature there can be no characters between the two patterns.

HTTP Region You can limit the search for a signature match to a specific HTTP header field:

• none — Do not limit the search for a signature match to a specific HTTP header field.

• client-body — Inspect any content in the body portion of the HTTP request.

• cookie — Inspect the cookie value listed in both HTTP request and response headers.

• header — Inspect any key/value pair in the HTTP request and response headers.

• method — Inspect the method in the HTTP request header.

• uri — Inspect the URI in the HTTP request header.

• stat-code — Inspect the status code in the HTTP response header.

• stat-msg — Inspect the status message in the HTTP response header.

• file-data — Inspect decompressed/dechunked encoded content in the HTTP response. 

Note: To use HTTP Region, you must set the Fast Analyze parameter in the HTTP Protocol 
Analyzer to false. For more information, see “HTTP” on page 7-16.

Normalize • Yes — Tell the sensor to decode the pattern before being sent through the pattern matcher. That 
is, application layer data in packets that contain encoded characters such as "%2f" are 
normalized to contain their ASCII equivalent ("%2f" = "/") before the signature comparison is 
made. This makes it harder for an attacker to URI-encode an attack in an effort to evade the 
network sensor.

Note: To use this option, you must enable the HTTP Protocol Analyzer for the Network Sensor. 
Ensure that you configure the HTTP Protocol Analyzer so that the signature ports of the 
signatures match the ports analyzed by the HTTP Protocol Analyzer. For more information, see 
“HTTP” on page 7-16.

• No — The pattern is not decoded before being sent through the pattern matcher. 

Table 9-6 Extended Pattern Parameters  (continued)

Field Description

Table 9-7 PCRE Parameters 

Field Description

Pattern Enter the Perl compatible regular expression.

Anchored Treats the regular expression as though it begins with the “^” meta-character. 

Caseless Match alphabetic characters regardless of case.

Dollar-End-Only Changes the default meaning of the "$" character within a PCRE so that the pattern will only match 
at the end of a string.

Extended Allows the PCRE to contain whitespace and comments within the signature, but they will be ignored 
during the actual signature comparison against network traffic.
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Multiline Treat packet data as multiple lines. This only makes a difference if there are actually newline 
characters in the packet data. 

Single Line Change behavior of the “.” character to include the matching of new lines in addition to any 
character. Without this flag, newlines are not matched against the expression.

Ungreedy Changes greedy operators such as “*” and “+” into non-greedy operators. 

Relative to Previous Restricts the match to where a previous match ended within packet payload data. This option 
requires multiple application layer tests to be configured. 

The previous match pointer is set if the previous option is Extended Pattern, PCRE, or Payload 
Jump. If the previous option is Payload Test or Payload Position, the previous match pointer will not 
be set. 

Match Negative Matches the signature if the Pattern specified is not found within the packet payload data.

HTTP Region You can limit the search for a signature match to a specific HTTP header field:

• none — Do not limit the search for a signature match to a specific HTTP header field.

• client-body — Inspect any content in the body portion of the HTTP request.

• cookie — Inspect the cookie value listed in both HTTP request and response headers.

• header — Inspect any key/value pair in the HTTP request and response headers.

• method — Inspect the method in the HTTP request header.

• uri — Inspect the URI in the HTTP request header.

• stat-code — Inspect the status code in the HTTP response header.

• stat-msg — Inspect the status message in the HTTP response header.

• file-data — Inspect decompressed/dechunked encoded content in the HTTP response. 

Note: To use HTTP Region, you must set the Fast Analyze parameter in the HTTP Protocol 
Analyzer to false. For more information, see “HTTP” on page 7-16.

Normalize • Yes — Tell the sensor to decode the pattern before being sent through the pattern matcher. That 
is, application layer data in packets that contain encoded characters such as "%2f" are 
normalized to contain their ASCII equivalent ("%2f" = "/") before the signature comparison is 
made. This makes it harder for an attacker to URI-encode an attack in an effort to evade the 
network sensor.

Note: To use this option, you must enable the HTTP Protocol Analyzer for the Network Sensor. 
Ensure that you configure the HTTP Protocol Analyzer so that the signature ports of the 
signatures match the ports analyzed by the HTTP Protocol Analyzer. For more information, see 
“HTTP” on page 7-16.

• No — The pattern is not decoded before being sent through the pattern matcher. 

Table 9-7 PCRE Parameters  (continued)

Field Description

Table 9-8 Payload Test Parameters 

Field Description

Num Bytes Specify the number of bytes to pick up from the packet to use as input from the packet for the parent 
operation. Valid range is 0 to 1514 bytes.
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Comparison op Select the operator to use to perform the test. 

• lt — less than

• gt — greater than

• and — bitwise AND

• or — bitwise XOR

• eq — equal to

Comparison Val Specifies the value to test the converted value against.

String Format Specifies the type of number being read.

• none — String is not numbers.

• hexidecimal — The converted string data is represented in hexadecimal.

• octal — The converted string data is represented in octal.

• decimal — The converted string data is represented in decimal.

Jump Specifies the number of bytes to jump into the payload before starting processing. Valid range is 0 to 
1514 bytes. If Relative to Previous is selected, this value is an offset from the previous match.

Endian Specifies the byte order of the number being read.

• big — Highest order byte first. This is the default.

• little — Lowest order byte first.

String Data Select this option if data is string data.

Match Negative Match if the tested field is not the value specified.

Relative to Previous Restricts match to where a previous match ended within packet payload data. This option requires 
multiple application layer tests to be configured. 

The previous match pointer is set if the previous option is Extended Pattern, PCRE, or Payload 
Jump. If the previous option is Payload Test or Payload Position, the previous match pointer will not 
be set. 

Table 9-8 Payload Test Parameters  (continued)

Field Description

Table 9-9 Payload Jump Parameters 

Field Description

Num Bytes Specify the number of bytes to pick up from the packet to use as input from the packet for the parent 
operation. Valid range is 0 to 1514 bytes.

Endian Specifies the byte order of the number being read.

• big — Highest order byte first. This is the default.

• little — Lowest order byte first.

String Format Specifies the type of number being read.

• none — String is not numbers.

• hexidecimal — The converted string data is represented in hexadecimal.

• octal — The converted string data is represented in octal.

• decimal — The converted string data is represented in decimal.
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Legacy Signature Pattern Matching Capabilities

Table 9-11 describes the pattern matching parameters for signatures in the LEGACY library.

Jump Specifies the number of bytes to jump into the payload before starting processing. Valid range is 0 to 
1514 bytes. If Relative to Previous is selected, this value is an offset from the previous match.

Jump Multiplier The value read from the packet/payload at the current cursor location is multiplied by this jump 
multiplier value, and the result is used as the value by which to move the cursor in the 
packet/payload ready for the next step of the signature. 

Jump From Current Select this option to perform the jump from the current location in the packet payload. When you 
select this option, the tracking pointer is not updated for the next extended pattern match, so a 
Relative to Previous match can apply to the current location (that is, before the payload jump was 
applied). 

Selecting both the Jump From Current and Relative to Previous options at the same time is only 
useful if the Align option is also selected.

Align Update the tracking pointer to the nearest full byte boundary.

String Data Select this option to tell Enterasys IPS to interpret the value read from the packet/payload as a 
number represented in ASCII, meaning Enterasys IPS will convert it into an integer automatically.

Relative to Previous Select this option to perform the jump from where a previous match ended within packet payload 
data. This option requires multiple application layer tests to be configured. 

The previous match pointer is set if the previous option is Extended Pattern, PCRE, or Payload 
Jump. If the previous option is Payload Test or Payload Position, the previous match pointer will not 
be set.

Table 9-9 Payload Jump Parameters  (continued)

Field Description

Table 9-10 Payload Position Parameters 

Field Description

Byte Offset Specify the byte location to test for data.

Relative to Previous Select this option to cause the offset to be relative to the location where a previous match ended 
within the packet payload data. This option requires multiple application layer tests to be configured. 

The previous match pointer is set if the previous option is Extended Pattern, PCRE, or Payload 
Jump. If the previous option is Payload Test or Payload Position, the previous match pointer will not 
be set.

Note: Legacy signatures are supplied only for historical reference. Though you cannot create 
legacy signatures, you can edit the existing legacy signatures. 
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Table 9-11 Signature Match Settings for Legacy Signatures 

Field Description

Match Type Signature type:

• standard — A standard signature uses one pattern string.

• combo — A combination signature uses two patterns. If the pattern defined in the Pattern field is 
found, the signature continues to search for the pattern defined in the Alternate Pattern field. If 
both patterns are found in this order, then the signature pattern is matched. Otherwise, if the 
patterns are not in this order, the signature pattern will not match the payload.

• negative — A negative signature is based on the absence of data. The signature looks for an 
initial pattern and then, if one or more different strings do not immediately follow it, the signature 
evaluates as true. The negative pattern must immediately follow the initial pattern. Unlike the 
combination signature there can be no characters between the two patterns.

• overflow — The overflow signature is designed to look for buffer overflows in ASCII style 
protocols. This Network Sensor signature format can look for keywords that specify the beginning 
of a login string followed by an unusually large string of data. The number of bytes that indicate 
an overflow is specified in the Pattern Parameters group.

Offset Specifies how many bytes to skip from the beginning of the packet payload before matching starts 
(exclusive). An offset of 10 would tell the sensor to index 10 bytes into the data field of the packet 
before beginning to look for a match. The valid range is between 0 and 1514 bytes.

Depth Specifies in bytes when the sensor should stop trying to match a pattern (inclusive). The bytes are 
measured from the start of the packet payload if Offset has not been configured. If Offset has been 
configured, the bytes are measured relative to the offset. For example, if an Offset of 10 and a Depth 
of 30 are specified, then the sensor will search from byte 11 through byte 40.

Negative Patterns For negative signature pattern type only, define the Negative Patterns. These patterns are patterns 
that must immediately follow the pattern defined in the Pattern field. If they do not immediately follow 
(that is, they are absent), then an event is generated.

negative — A negative signature is based on the absence of data. The signature looks for an initial 
pattern and then, if one or more different strings do not immediately follow it, the signature evaluates 
as true. The negative pattern must immediately follow the initial pattern. Unlike the combination 
signature there can be no characters between the two patterns.

Overflow For overflow signature pattern type only. If the specified number of bytes is found following the 
signature pattern before a newline character, then an event is generated. 

For example, in FTP, a user specifies their username with a command of USER, followed by a space 
and the username. Most usernames are eight bytes long, so searching for usernames larger than 
256 bytes could show some denial of service attacks and possibly some buffer overflows. For such a 
signature, you would specify an overflow value of 256 and a pattern of USER/20.

Secondary Pattern For combo signature pattern type only, define the second pattern to be searched for in the 
Secondary Pattern field. For example, to write a signature that searches for both “/cgi-bin/” and 
“/etc/passwd,” you would enter “/2fcgi-bin/2f” in the Pattern field and “/2fetc/2fpasswd” in the 
Secondary Pattern field.

Pattern The signature pattern. See “Specifying Signature Pattern Strings” on page 9-11 for information about 
creating pattern search strings.

For combo signature pattern type only, define the second pattern to be searched for in the Alternate 
Pattern field. For example, to write a signature that searches for both “/cgi-bin/” and “/etc/passwd,” 
you would enter “/2fcgi-bin/2f” in the Pattern field and “/2fetc/2fpasswd” in the Alternate Pattern 
field.

For negative signature pattern type only, define the Negative Patterns. These patterns are patterns 
that must immediately follow the pattern defined in the Pattern field. If they do not immediately follow 
(that is, they are absent), then an event is generated.
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Advanced Section Parameters

This section does not appear for signatures marked as Legacy in the upper right corner of the 
Signature Editor. 

Table 9-12 describes the parameters in the Advanced section of the Signature Editor window. 

Table 9-12 Advanced Section Parameters

Field Description

Payload Size These settings allow you to configure a signature to match only if the payload portion of a packet 
matches the search criteria specified by the Payload Size options. Use these settings to check for 
abnormally sized packets, or to detect buffer overflows.

• Minimum payload size in bytes to match. Valid values range from 0 to 1514 bytes. If you are 
specifying a single value, enter the same value in the Maximum field also.

• Maximum payload size to match. Valid values range from 0 to 1514 bytes.

• Match Zero to match on the value zero if specified by a Minimum or Maximum value and the 
packet contains the value zero in the tested field.

• Select Match Negative if you want the signature to match if the payload size is not the value 
specified.
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Communicating State with Flow Tags

The flow tag editor allows you to configure signatures to communicate state information to each 
other. For example, it is possible to write one signature to detect whether a particular condition is 
met within network traffic (for example, the key exchange phase in an SSL session, or that a 
certain command has been executed within a cleartext protocol), and then have a separate 
signature only fire after the condition has been met. This is accomplished by testing whether a 
particular tag has been set from one signature to the next.

Tags can be unset by signatures as well, to allow follow-on tests to be disabled after a condition 
has been met within network traffic. The flow tag test can apply to Extreme IPS signatures that just 

Event Limit Sets a limit on the number of times a signature must match against network traffic before an event is 
generated. See “Setting Event Limits” on page 9-20 for more information.

• Set Mode:

• limit—set the number of times a signature match must occur before an event is generated, 
regardless of the time period involved.

• threshold—set the number of times a signature match must occur within a specified period of 
time before an event is generated. 

• both—

• If you set Mode to limit, specify the period of time in which the number of signature matches 
must occur in the Interval (secs) field. Valid values range from 10 to 8,400 seconds.

• In the Apply To field, select:

src if the signature matches must all be from the same source.

dst if the signature matches must all be directed to the same destination.

In the Number of Alerts field, specify the number of signature matches that must occur before an 
event is generated. Valid values range from 1 to 4,294,967,296.

Flow Tags • Enter the Tag value. You can enter any meaningful text string.

• Select the desired Action:

define — When this signature matches, set the flow tag.

test-defined — Evaluate this signature if the flow tag has already been set.

test-not-defined — Evaluate this signature if the flow tag has not been set.

clear — If the flow tag has been set, clear it.

• If you do not want to generate an event, select Suppress Alert.

For more information, see Communicating State with Flow Tags on page 9-19.

Flags This option group allows you to specify tests against TCP flags set within the TCP packet header. 
Note that flags that should be masked (that is, should not influence whether a match is successful) 
are specified in the Masks option group. 

• Select any of the flags listed.

• Select Match Negative if you want the signature to match if the selected flag is not set.

• Select Match Specific to cause the signature to match only if the specified flags are set.

• Select Match Or to generate an event if any of the specified flags are set, even though other 
flags are also set.

Table 9-12 Advanced Section Parameters

Field Description
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match against packet headers and do not contain application layer tests. However, typically flow 
tags are most useful for those signatures that do match against packet payload data. 

To use flow tags to communicate state between signatures:

1. In the first signature, create the desired flow tag. Give the tag a meaningful name, set the 
action to define, and if desired, suppress the alert. 

Selecting the define action means that when this signature is matched, the flow tag will be set 
and can be checked by any following signatures.

Suppressing the alert tells the sensor not to generate an event when this signature is matched. 

2. In the second signature, create one or more flow tags with the same name used in the first 
signature and set the action to test-defined, test-not-defined, or clear. 

– If you want the signature to be evaluated if the flow tag has been previously set, select 
test-defined. 

– If you want the signature to be evaluated if the flow tag has not been set, select test-not-
defined. 

– Use clear if you want the flow tag to be cleared if set.

You can set multiple flow tags per signature.

You can configure multiple signatures to take action with the same flow tag.

Example

The following example shows two signatures configured with the flow tag sslv3_hello_request. 

The first signature sets the sslv3_hello_request but does not generate an alert. 

The second signature checks to see if the sslv3_hello_request tag has been set and generates an 
alert if it has been set. Then, the signature clears the set tag.

Setting Event Limits

The Event Limit feature allows a threshold to be set of the number of times a signature must match 
against network traffic before an event is generated. For example, a signature that is designed to 
detect a failed login attempt in an unencrypted network stream is most effective when combined 
with a threshold. After all, three consecutive matches on such a signature from a single IP is 
probably not significant since this could easily be caused by a legitimate user mis-typing a 
password, but 10,000 matches from a single IP mostly likely indicates a brute force password 
cracking attempt. 
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Event limits, like flow tags, can also apply to Extreme IPS signatures that do not contain 
application layer tests, but in general this feature is most useful for those signatures that do match 
against packet payload data. 

Example 

This example instructs Extreme IPS to generate an event only if the corresponding signature has 
matched at least 20 times within 60 seconds from the same source IP address. 

References Section Parameters

The References section provides a place to record the third-party source of any information used 
to design the signature.

Table 9-13 describes the parameters in the Advanced section of the Signature Editor window. 
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Modifying Master Library Signatures
In previous versions of Enterasys IPS, you could enable or disable master library signatures but 
you could not modify the signatures. In Enterasys IPS version 8.2, an administrator can modify 
master signatures.

To modify a master library signature:

1. In the IPS GUI, select Configuration > Network Signatures. 

2. Select the appropriate library in the Type: Master section of the left pane of the Signature 
view. 

3. In the signature list in the right pane of the Signature view, launch the Signature Editor from 
the appropriate signature. 

You can launch the Signature Editor by either double clicking the signature or right clicking 
the menu and selecting Signature Editor from the menu.

4. Modify the signature. See Using the Signature Editor on page 9-5 for information about 
Signature Editor parameters.

5. Click Save. 

Table 9-13 References Section Parameters

Field Description

Reference To add a reference:

1. Click Add Reference.

2. Select the Reference Type from the pull-down menu. The choices are:

BUGTRAQ

CVE

NESSUS

CERT

URLREF

3. Add a value.

4. Click Update.

To edit a reference:

1. Double click the reference.

2. Edit the reference.

3. Click Update.

To delete an existing reference, select the reference you want to delete and click Remove 
Reference. 

Meta Data Read only. Meta data is provided, as applicable. with master library signatures. 

Note: Enterasys IPS retains a copy of a master library signature that has been updated by the Live 
Update process. Modified master library signatures WILL NOT be updated by the Live Update 
process. 
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Custom Signature Libraries
You can assign the predefined signature master libraries to a configuration scope. However, when 
you assign a master library to a configuration scope, all of the signatures belonging to that master 
library are assigned to that scope. 

If you want to assign only some of the signatures belonging to a master library, you can create a 
custom library based on an existing master library, but containing only those predefined 
signatures that you want to include.

You can also create an empty custom library and then create your own signatures to add to your 
custom library and/or selectively add predefined signatures from multiple master libraries.

A custom library can consist of referenced master library signatures, custom signatures, or a 
combination of the two.

Creating a Custom Library

To create a custom library:

1. In the IPS GUI, select Configuration > Network Signatures. 

2. In the Signatures view, click Create > Custom Library.
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The Create Custom Library window opens. 

3. In the Custom Library Name field, enter a name for the library you’re creating.

If you are creating an empty library, go to Step 5.

4. Add signatures to the custom library.

You can select one or more whole libraries to add to your custom library, or you can select one 
or more individual signatures from various libraries. To select individual signatures, click the 
expansion symbol next to a library, then select the desired signatures.

5. Click Create. 

Your custom library is listed under Type: Custom in the left panel. Select your custom library 
to display the included signatures in the right pane of the Signature view. 

For information on creating custom signatures to add to a custom library, see “Creating a 
Custom Signature” on page 9-26.

Modifying a Custom Library

To modify a custom library:

1. In the IPS GUI, select Configuration > Network Signatures. 

2. In the library list, right click the appropriate custom library and select Edit. 
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You may have to expand the Type: Custom category to display the custom libraries.

3. In the Edit Custom Library window, add and remove signatures as appropriate.

The signatures currently included in the custom library are listed under the custom library’s 
name. 

4. Click Update. 

You can also remove a signature from a custom library by doing the following:

1. Select the custom library that includes the signature you want to remove.

2. In the signature list, right click the appropriate signature and select Remove Selected 
Signature(s) from Library.

Deleting a Custom Signature Library

To delete a custom signature library:
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1. Ensure that the custom library that you want to delete is not assigned to a configuration scope. 

2. In the IPS GUI, select Configuration > Network Signatures. 

3. In the Signatures view, right click the custom library that you want to delete and select Delete.

Custom Signatures
Once you have created a custom signature library, you can create custom signatures for that 
library, and you can edit signatures that have already been added to the library.

For signature creation guidelines, see Appendix B, Signature Creation Overview.

For an example of custom signatures, see Appendix C, Example of Custom Signature Creation.

Creating a Custom Signature

To create a custom signature:

1. In the IPS GUI, select Configuration > Network Signatures from the menu bar. 

2. Right click the custom library for which you want to create the custom signature and select 
Create Signature. 

3. In the Signature Editor, set the parameters for the custom signature. See Using the Signature 
Editor on page 9-5 for information about Signature Editor parameters.

4. Click Save. 

Modifying a Custom Signature

To modify a custom signature:

1. In the IPS GUI, select Configuration > Network Signatures from the menu bar. 

2. In the library list, select the appropriate custom library. 

You may have to expand the Type: Custom category to display the custom libraries.

3. In the signature list, right click the appropriate signature and select Signature Editor. 

4. Modify the signature. See Using the Signature Editor on page 9-5 for information about 
Signature Editor parameters.

5. Click Save. 

Deleting a Custom Signature

To delete a custom signature:

1. In the IPS GUI, select Configuration > Network Signatures from the menu bar. 

2. In the library list, select the appropriate custom library. 

You may have to expand the Type: Custom category to display the custom libraries.

3. In the signature list, right click the appropriate signature and select Remove Selected 
Signature(s) from Library.
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Dynamic Signature Libraries
You can create dynamic signature libraries based on signature filter criteria. When you run the 
query, the dynamic signature library is updated to include the signatures that match the specified 
criteria.

You can include dynamic in an Alarm Tool event group. For more information, see “Configuring 
Event Resource Groups” on page 14-20.

You can also use a dynamic library as part of an event response. For more information, see 
“Creating an Event Response” on page 7-13.

Creating Dynamic Signature Libraries

To create a dynamic signature library:

1. In the IPS GUI, select Configuration > Network Signatures. 

2. In the Signatures view, click Create > Dynamic Library. 
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The Create Dynamic Library window opens. 

3. In the Dynamic Library Name field, specify a name for the dynamic library. 

4. Specify and/or select the appropriate criteria. See Table 9-14.

5. Click Create.

All signatures that match the query criteria you specified are included in the library. The number 
of signatures that match the query criteria is listed in the signatures pane. 

Table 9-14 Dynamic Library Filter Criteria

Field Description

Signature Properties

 Name Contains To filter based on signature name, enter any text characters contained in the signature name. For 
example, if you want to display all the signatures in the APPS Master Library that look for Chat 
traffic, enter WHOIS in this field. This filter would limit the display to only three signatures with 
WHOIS in their names.

 Description Contains To filter based on the signature description, enter any text characters contained in the signature 
description.

Score Select a score if you want to filter by the signature severity score used by a Security Information 
Manager (SIM). Options include Low, Medium, High and Critical.
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Operating System To filter based on operating system, select the operating system to which the signature applies from 
the drop-down menu. Choices are UNIX, Solaris, Windows, Novell, Embedded, Any, or All 
Operating Systems. The default is All Operating Systems.

Classification To filter on an event group name (which is synonymous with master library name).

 Protocol Signatures can be applied against TCP, UDP, ICMP, or any IP protocol.

Port For UDP or TCP signatures, a port value is used to specify which particular protocol to apply the 
signature to. To filter signatures based on port number, specify a port value using the numeric 
representation of the protocol. For example, use 25 for SMTP, 80 for HTTP, 6000 for X Windows. 

Service Direction Signatures can look for the direction of packets going to or originating from a network server. For 
example, email attacks on port 25 flow to the server. Events such as telnet login failures happen on 
port 23, but come from a server. If looking for web server attacks, you would probably wish to 
inspect packets going to the server (destined for port 80). If interested in malicious JAVA downloads, 
you would probably search for packets with a source port of 80. 

To filter signatures based on service direction:

• Select destination if the signature applies to packets with a destination port that matches the 
signature port parameter. Typically, destination is used for packets directed to the well known port 
on a server. 

• Select source if the signature applies to packets with a source port that matches the signature 
port parameter. Source is used for packets originating from the server. 

• Select both if the signature applies to packets with both a source and destination port that 
matches the signature port parameter. 

• Select any if the signature should apply to packets with either or both destination and source 
ports that match the signature port parameter. Any can be used to watch traffic in both directions.

The default value is All Service Directions.

Traffic Direction To filter signatures based on the direction of packets with relation to the protected network:

• Select any if the signature applies to all traffic. 

• Select toward if the signature applies to traffic toward the protected network.

• Select from if the signature applies to traffic originating from the protected network. 

• Select internal traffic if the signature applies to traffic that originates from the protected network 
destined for other systems also on the protected network. 

The default value is All Traffic Directions.

Type Filter signatures in a library based on whether they are legacy or standard signatures.

Active State Filter signatures in a library based on whether they are enabled or disabled.

Reference Properties

Type To filter by the signature’s reference type, select the desired reference type from the drop-down list. 
Options include Any, BUGTRAK, CVE, NESSUS, CERT, and URLREF.

 Value Contains To filter by a reference string, enter the desired reference string to filter on.

Created Filter based on the date the signature was created. Select either before or after, then enter the date 
in yyy-mm-dd format, or click the Choose button to display a calendar from which you can select a 
date.

Table 9-14 Dynamic Library Filter Criteria (continued)

Field Description
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Modifying Dynamic Signature Libraries

To modify a dynamic signature library:

1. In the IPS GUI, select Configuration > Network Signatures. 

2. In the Signatures view, right click the dynamic library that you want to edit and select Edit.

Modified Filter based on the date the signature was modified. Select either before or after, then enter the 
date in yyy-mm-dd format, or click the Choose button to display a calendar from which you can 
select a date.

Table 9-14 Dynamic Library Filter Criteria (continued)

Field Description
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The Edit Dynamic Library window opens.

3. Edit the filter criteria as appropriate. 

4. Click Update. 

The dynamic library query will run based on the revised criteria. The affected dynamic library 
will change based on the signatures that now match the query criteria. 

5. Deploy the changes. 

Deleting Dynamic Signature Libraries

To delete a dynamic signature library:

1. Ensure that the dynamic library that you want to delete is not assigned to a configuration 
scope. 

2. In the IPS GUI, select Configuration > Network Signatures. 

3. In the Signatures view, right click the dynamic library that you want to delete and select 
Delete.
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Configuring Users

This chapter describes how to configure users for the GUI clients when local user authentication 
has been selected. If RADIUS or LDAP user authentication methods are being used for Extreme 
Networks IPS, you cannot perform any user configuration from the EMS client.

If you are using RADIUS or LDAP for user authentication, see the Enterasys Intrusion Prevention 
System Installation Guide for more information about Extreme Networks IPS configuration 
requirements.

Roles Overview
Access to Enterasys IPS functionality is based on user roles. The roles are defined as follows:

• General installer — installs hardware and/or software and gets things up and running in the 
network. During installation, root administrator privileges are used. This user does not 
perform any custom configuration. Hardware and software installation are described in the 
Extreme Networks Intrusion Prevention System Installation Guide.

• Administrator — takes over once the hardware or software is installed and performs user 
setup and custom configuration. This user needs knowledge of the entire product’s purpose 
and function. There are two general types of administrators. 

– Root administrator — has access to all OS functions and command line tools, typically on 
an Extreme Networks IPS appliance. Upon installation, root user access is granted. 
However, this access must be restricted for future tasks. The root administrator is limited 
to command line tasks.

– GUI Dragon administrators — have GUI-only access to defined aspects of the Extreme 
Networks IPS management GUI. There are many types of GUI administrators as 
described in “Adding a GUI User” on page 10-3.

• Analyst — manipulates only reporting data. This user has GUI-only access to the web-based 
reporting tools. Analyst operations are described in the Analysis and Reporting Guide. 

For information about... Refer to page...

Roles Overview 10-1

Managing Passwords 10-2

Setting Up Users 10-2
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Managing Passwords
Creating strong passwords is a vital part of ensuring network security. The following 
recommendations can assist you in ensuring network security for Extreme Networks IPS.

• Make the password at least eight characters in length.

• Include mixed-case alphabetic characters.

• Include at least one non-alphabetic character.

• Do not share passwords.

Setting Up Users

Root Administrator
A root administrator account is available on both an appliance and a software installation. Root 
can execute OS -level commands, but has no access to the Extreme Networks IPS GUI.

After installation, the default root user account can be disabled for SSH access. This provides 
additional security for the root account.

To disable SSH access for the default root account:

1. Use vi to edit the sshd configuration file.

vi /etc/ssh/sshd_config

The configuration file opens.

2. Modify the line PermitRootLogin yes by changing the yes to no.
3. Save the file.
4. Restart sshd:

/etc/rc.d/rc.sshd restart
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Adding a GUI User
To add a GUI user:

1. In the IPS GUI, select Tools > User Management.

The User Management window opens.

2. Enter the user’s name in the User Name field.
3. Enter the user’s password in the Password field and in the Confirm field.
4. Select the desired roles. Refer to Table 10-1 on page 10-3 for descriptions of the available roles.

Use Ctrl-click to select multiple roles.

5. Click the Create button.
The user is added to the database.

6. When all users for this session have been entered, click Close to exit.
Table 10-1 describes the GUI user roles that you can assign to users that you create.

Table 10-1 User Roles

Role Description

DragonSuperAdmin   Complete access to all management GUI and reporting tasks including:

• Deploy configuration

• Change configuration/commit

• View configuration

• Reports

• Configure Users
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DragonAdmin   Broad access to all management GUI tasks including:

• Deploy configuration

• Change configuration/commit

• View configuration

This user cannot access reports or configure users.

DragonDeployAdmin   Access to some management GUI tasks including:

• Deploy configuration

• View configuration

This user cannot access reports, configure users, or change configuration.

DragonCommitAdmin   Access to some management GUI tasks including:

• Change/Commit configuration

• View configuration

This user cannot access the reports, configure users, or deploy configuration.

DragonViewConfigAdmin   Access to some management GUI tasks including:

• View configuration

This user cannot access reports, configure users, commit, or deploy 
configuration.

DragonViewAdmin This user cannot access the reports, configure users, commit, view 
configuration, or deploy configuration. The display area is left unpopulated.

DragonReports Access only to reports.

This user, also referred to as an analyst, cannot access management. See the 
Analysis and Reporting Guide for more information.

DragonUserAdmin Access only to user creation management GUI tasks. 

This user can create other users, but cannot perform any other management 
GUI tasks. This role may be combined with other roles.

Table 10-1 User Roles (continued)

Role Description
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Modifying a GUI User

To modify a user’s password or roles:

1. In the IPS GUI, select Tools > User Management.

The User Management window opens.

2. Select the user that you want to modify from the list at the top of the User Management 
window.
Clicking on a user in the list will populate the User Name and Roles fields. The user’s 
password is not displayed. 

3. (Optional) Change the password by entering the new password in the Password and Confirm 
Password fields.

4. (Optional) Select the user’s roles from the Roles list. Refer to Table 10-1 on page 10-3 for 
descriptions of the available roles.
Use Ctrl-click to select multiple roles.

5. Click Update.
6. If you changed the user’s password, click OK on the password change confirmation window. 

Notes: You cannot modify the user that you have logged in as. To change the password of the user 
you have logged in as, see “Changing Your Own Password” on page 10-6.

Only SuperAdmin and UserAdmin users can modify the attributes of other users.
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Changing User Passwords
You can change your own password and the passwords of other users.

Changing Another User’s Passwords
To change another user’s password, see “Modifying a GUI User” on page 10-5.

Changing Your Own Password
To change the password of the IPS user that you are logged in as: 

1. In the IPS GUI, click on the user name and select Change Password.

The Change Password window opens. 

2. Enter the user’s current password, then enter the new password in the New Password and 
Confirm Password fields.

3. Click OK.

Changing User Passwords Using the Command Line
When you create a user, the password is encrypted when it is saved in the MySQL database. You 
can delete an existing password using the command line, but you cannot change an existing 
password. 

To delete a password using the command line:

1. Enter the following commands to connect to the MySQL database:

cd <installdir>/mysql/bin

./mysql --user=< MySQL user> -p<MySQL password> --socket=/tmp/dragon-
mysql.sock -- 
host=localhost --port=9117

2. Enter the following commands at the MySQL prompt:
use dem; 

update user SET password="" where username="<username>";

Where user is the username whose password is being deleted. 
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3. Launch the IPS GUI, with user “user”, and no password. You can then use the IPS GUI to set a 
new password for that user.

Managing Reporting Proxy Authentication
Some of the information used to set up the EMS server during installation, such as IP address, port 
number, and the default username and password, is silently used to populate the Reporting Proxy 
Properties file. Each Reporting server in an Extreme Networks IPS deployment contains a proxy 
agent used by the reporting System Dashboard. Additionally, each Reporting server contains a 
Reporting Proxy Properties file that contains information about the primary and secondary EMS 
servers. A Reporting server's proxy agent uses the parameters stored in the Reporting Proxy 
Properties file to authenticate with the primary and secondary EMS servers.

The Reporting Proxy Properties file must contain a valid username and password or the Reporting 
server will fail to authenticate. Changes made to the EMS server’s default login credentials using 
the EMS client do not affect the Reporting Proxy Properties file. If you plan to modify the default 
login credentials as recommended by Enterasys Networks, you must make the change to the EMS 
server using the EMS client and then manually edit the Reporting Proxy Properties file with the 
same change for every Extreme Networks IPS Reporting server in your environment. 

Reporting Authentication Best Practices
If you are going to change the default login credentials, create a user with the DragonViewAdmin 
role (as described in “Adding a GUI User” on page 10-3) that will be used only for authentication 
between Reporting servers and the EMS server. If you are using an alternative authentication 
method (RADIUS, or LDAP user) see the Enterasys Intrusion Prevention System Installation Guide. 
Once you create this user account, edit the login credentials in the Reporting Proxy Properties files 
for every Extreme Networks IPS Reporting server in your environment. For more information 
about the Reporting Proxy Properties file, see Configuring Reporting Proxy Authentication on 
page 10-7.

Configuring Reporting Proxy Authentication
You must edit the EMSproxy.xml file before starting the Reporting server(s). To ensure consistent 
proxy authentication, edit the EMSproxy.xml files of each Reporting server in your deployment, 
that includes standalone, EMS/reporting and reporting-only Extreme Networks IPS installations. 

To do this for each Report server:

1. Open the EMSproxy.xml file for editing. The file is located in the following directory:

<installdir>/conf

2. Under the <Primary> element, set the values for the <host>, <port>, <username>, and 
<password> elements.

3. Save the file.
4. Enable authentication with the secondary EMS by changing <Secondary enabled="false"> to 

<Secondary enabled="true">.
5. Under the <Secondary> element, set the values for the <host>, <port>, <username>, and 

<password> elements.
6. Save and close the file. 
7. Navigate to <installdir>/scripts.
8. Stop the jboss process by running the following command:
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./dragon-jboss stop

9. Restart the jboss process by running the following command:
./dragon-jboss start
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Extreme Networks IPS Agent Configuration

This chapter describes how to add Extreme Networks IPS agents to a device node and how to 
configure the following Extreme Networks IPS agents: Alarmtool, Export Log, and 
Dragon2MySQL (reporting agent). Configuration of the Alarm Tool agent policies is discussed in 
Chapter 14, ”Alarmtool Policy Configuration”.

Overview

Deployment Considerations
This section briefly discusses issues that you should consider as you determine where to add 
Extreme Networks IPS agents in the Extreme Networks IPS managed environment. 

Platform Requirements
All Extreme Networks IPS agents must be associated with device nodes running the Linux 
operating system.

For information about... Refer to page...

Overview 11-1

Adding Agents to a Node 11-3

Configuring the Alarmtool Agent Policy 11-3

Configuring the Export Log Agent 11-4

Configuring the Dragon2MySQL Agent 11-6

Starting and Stopping Agents 11-7

Note: You cannot configure the DragonDB agent.
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Overview
Agents in Reporting Deployments
The Dragon DB and MySQL Reporting agents are used by the Extreme Networks IPS reporting 
tools and reporting interface. These agents should be configured and running on any device node 
that is expected to provide reporting features. For example, the Dragon DB and MySQL Reporting 
agents should be installed on a Reporting server, but they are not required on a non-reporting 
node. 

Dragon DB and MySQL Reporting agents are often installed on the EMS server device node 
because that node is often the final aggregation point of events in the entire Extreme Networks IPS 
managed environment and the EMS server is also often a Reporting server.

You can also install these agents on sensor device nodes in order to provide reporting on 
information specific to that sensor. Note that the sensor device node must be a Linux machine.

Because Dragon DB and Export Log write events out to the file system, you may choose to run 
either or both of these agents on any aggregation point to provide an archival record of those 
events. (Dragon DB records the packet(s) associated with an event, if there are any, while the 
Export Log records only the event itself.)

Alarm Tool Deployments
The Alarm Tool agent sends notifications when the sensors detects an anomaly. The type of 
notification and conditions for notification are configurable. The basic notification types include 
email, flat file logs, the UNIX syslog facility, OPSEC SAM responses, SNMP traps (both versions 1 
and 3), and the execution of external binaries/scripts.

Since Alarm Tool is dependent on seeing events so that it can take the configured actions, it is 
typically installed on event aggregation points, in locations similar to where a Reporting server 
would be installed. 

Note that Alarm Tool configuration is discussed in Chapter 14, ”Alarmtool Policy 
Configuration”.

Logging Considerations
When you associate any Extreme Networks IPS agents to a device node, the agents write log files 
to the local file system of the device. These log files take up space and will require manual 
administration over time. 

• The Dragon DB agent creates a log file named DragonDB.log in <installdir>/logs. The Dragon 
DB agent records the packets associated with events in the dragon.db file located in 
<installdir>/DB/yyyymmmdd. A new directory is created per day. These files will require 
manual administration over time. 

• The Export Log agent creates a log file named ExportLog.log in <installdir>/logs. The Export 
Log agent records events to dragon.log.xxx files in <installdir>/DB. The turnover of these files 
is configured as part of the Export Log agent. See “Configuring the Export Log Agent” on 
page 11-4.

• The Alarm Tool agent creates a log file named Alarmtool.log in <installdir>/logs.

Note: Legacy reporting utilities such as Export Log are included with Extreme Networks IPS 7.3.2 
and higher for existing environments that need to install and use them. 
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Adding Agents to a Node
Refer to “Deployment Considerations” on page 11-1 for information that will help you determine 
where Extreme Networks IPS agents should be installed in the Extreme Networks IPS managed 
environment.

To add an agent:

1. In the Dashboard view, click the Systems tab. 

2. Right-click on the device node to which you want to add an agent and, from the Add Agent 
sub-menu, select the agent you want to add.

If you select Alarmtool, the Select Policy window opens. 

Select the appropriate policy from the drop down menu and click OK. 

Each instance of the Dragon DB and Export Log agents on each device node can be configured 
separately, as described in the following sections.

Configuring the Alarmtool Agent Policy
You can create custom Alarmtool policies, as described in Chapter 14, ”Alarmtool Policy 
Configuration”, and apply them to individual Alarmtool agents. 

To change the Alarmtool policy applied to the Alarmtool agent:

1. In the Dashboard view, click the EMS/Reporting tab.

2. Expand the Agents section of the tab by clicking the + button.
3. Right click Alarmtool and select Select Policy from the menu.

Note: The Alarmtool policy named Default, which is applied to the Alarmtool agent if you do not 
select another Alarmtool policy, is not configurable.
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The Select Policy window opens.

4. From the drop down list, select the desired custom policy and click Ok.

Configuring the Export Log Agent
The Export Log agent will create a series of export log files containing each event generated. The 
files are named dragon.log.xxx in <installdir>/DB. Recording of events to the log files is influenced 
by the rotation attribute. The rotation attribute indicates how often (in days) to rotate to a new log 
file. These log files are typically used as an integration point with third party software. You can 
configure which fields from an Extreme Networks IPS event should be included in the export log 
file by specifying tokens in the Export Log Format field.

The Export Log agent is needed for Daily Event Rate and Event Growth reports to function.

To configure the Export Log agent:

1. In the Dashboard view, click the EMS/Reporting tab. 

2. Expand the Agents section of the tab by clicking the + button.
3. Right click ExportLog and select Configure from the menu. 

The Export Log Configuration window opens. 

4. Set the parameters.
a. Log File Rotation — Indicates how often (in days) to rotate to a new log file. Initially, log 

files names are appended with the sequence number 001. As each rotation in days is 
reached, a new file is created with the extension incremented by one (for example, .002). 
By specifying a large value (for example, 2000000), the export log can be forced to never 
rotate to a new log file.

b. Filler Value — Used to pad export log records with filler fields with a specific filler value. 
This can be useful when dealing with constructing import files for relational databases. 
The intent is that a record format can be shaped which aligns with a database table. This 
export log can then be easily used to import directly into a database table using SQL.

c. Field Separator — Indicates a character to be used as a field separator between data fields 
in the export log.

d. Log Format — Specifies which of the available event fields should be included in each 
export log record written to the log file. It may also be used to indicate the ordering of 
those fields. Fields are identified by listing one or more tokens to represent the available 
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data fields. Table 11-1 lists the available data fields.

e. Path — If desired, change the default location where Export Log agent records events. The 
default location for the dragon.log.xxx files is in <installdir>/DB.

f. Ignore Events —Any events you want to be ignored by the agent.

5. Click Save to save the changes.
6. Right-click on Export Log and, from the Operations sub-menu, select Deploy to push out the 

changes to the node containing this agent. 
You can view the status of the deployment in the Operations panel, located at the bottom of 
the window. 

Table 11-1 Export Log Formats  

Format Description

%T Event Date/Time (YYYY-MM-DD HH:MM:SS)

%t Event Date (YYYY-MM-DD)

%h Event Time (HH:MM:SS)

%N Sensor Name

%E Event Name

%S Source IP Address (dotted quad representation)

%s Source IP Address (numeric representation)

%D Destination IP Address (dotted quad representation)

%d Destination IP Address (numeric representation)

%G Source Port

%H Destination Port

%A Event Header

%B Event Direction

%P Event Protocol

%C Event Flags Field

%F Filler Field (using filler-value)

%X Event Data
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Configuring the Dragon2MySQL Agent 
The Dragon2MySQL agent provides the event data used by Extreme Networks IPS Reporting. The 
Dragon2MySQL reporting agent was designed to efficiently read events and store them in the 
MySQL reporting database. The Dragon2MySQL agent reads events directly from the ring buffer 
and then inserts them in batches into the Extreme Networks IPS MySQL event database when one 
of the following conditions is met:

• The interval between the previous batch insert and the current time is greater than the value of 
Insert Interval (by default, this value is 60 seconds)

OR

• The number of events queued in a batch ready for insertion exceeds the value of Max. Queued 
Events (by default, this value is 100 events)

To configure this agent:

1. In the Dashboard view of the IPS GUI, click the EMS/Reporting tab. 

2. Expand the Agents section of the tab by clicking the + button.
3. Right click the Dragon2MySQL Agent and select Configure from the menu. 

The MySQL Reporting Agent Configuration window opens. 

4. Set the parameters as appropriate. See Table 11-2.

Table 11-2 MySQL Reporting Agent Configuration Parameters 

Parameter Description

Max. Queued Events (days) Specifies the maximum number of events to place in the queue. Once 
this number of events is reached, each new event will overwrite the 
oldest event in the queue. By default this is set to 100 events.

Insert Interval (seconds) Indicates the maximum insert interval in seconds. By default this is set 
to 60 seconds.

Event Retention (days) Indicates the number of days a MySQL reporting agent partition is kept 
in the Extreme Networks IPS MySQL event database. Partitions older 
than the number of days specified in this field are dropped. By default 
this is set to 30 days. 
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5. Click Save to save the changes.
6. Right-click the agent and, from the Operations sub-menu, select Deploy to push out the 

changes to the node containing this agent.
You can view the status of the deployment in the Operations panel, located at the bottom of 
the window. Click on the operation to view the details of the deployment.

Starting and Stopping Agents
You can start, stop, or restart agents.

To start, stop, or restart an agent:

1. In the Dashboard view, click the EMS/Reporting tab. 

2. Expand the Agents section of the tab by clicking the + button. 
3. Right-click on the agent and, from the Operations sub-menu, select Start, Stop, or Restart 

from the context menu.

Archived Event Retention (days) Indicates the number of days a MySQL reporting agent partition is kept 
in the Extreme Networks IPS MySQL eventarchive table, which is 
compressed. The default is 30 days. Partitions older than the number 
of days specified in this field are dropped. IPS reports queries that 
include the From Archive parameter search for events stored in the 
eventarchive table. 

Because the eventarchive table does not include index files, data 
retrieval from the database may be slow. 

The approximate number of archived events is included in the EMS/
Reporting tab.

Sensor Status Retention (days) The number of days that sensor status, which is reported in the Sensor 
Uptime report, is retained. The default is 7 days. 

Packet Data Insertion Enabling this option causes the MySQL Reporting Agent to insert 
associated packet data into the Reporting database along with events. 
Packet data insertion can consume a great deal of disk space and we 
recommend that you not enable this option. The default setting is 
disabled.

Ignore Events Configure any events you want to be ignored by the agent.

Table 11-2 MySQL Reporting Agent Configuration Parameters  (continued)

Parameter Description
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The appropriate action is taken.
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Tools

Live Update
You can update your Master Policies and Signature libraries using live updates downloaded from 
the Extreme Networks IPS website. Extreme Networks IPS signatures and policies are frequently 
updated. The Live Update feature allows you to stay current with the most recent signatures and 
policies to address the most recent threats. You can launch the Live Update process manually, or 
schedule automatic updates.

A deploy is required to update the sensors after a live update. 

Process Overview
The following steps describe the Live Update process after it has been launched, either manually 
or as a regularly scheduled daily action. If you selected the Live Update From Local Files, the 
process starts at step 5.

1. The EMS server connects to the Dragon website, at the URL specified in the Live Update 
window. Unless you are told otherwise, do not change the default URL. 

2. If the connection is successful, a file named dragon.md5 is downloaded to the liveUpdate 
directory on the server. The liveUpdate directory is located at <installdir>/liveUpdate.

For information about... Refer to page...

Live Update 12-1

High Availability 12-5

Database Backup/Restore 12-5

Export Signatures, Policies, and IP Variables 12-7

Import Signatures, Policies, Snort Rules, and IP Variables 12-8

Binary Upgrade 12-9

Log/Data Policy Editor 12-9

EMS Monitor 12-14

EMS Log Viewer 12-16

Note: You cannot issue a second live update until the first update has completed. 
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The dragon.md5 file contains a list of all the update files that are available for download, 
along with the MD5 hash sum values for each file.

3. All the MD5 hash sum values listed in dragon.md5 are compared with the MD5 hash sums of 
the previously downloaded update files located in the liveUpdate directory.

4. If the sums of any files are different, or if a file listed in dragon.md5 does not exist in the 
liveUpdate directory, those files are downloaded from the Dragon website to the liveUpdate 
directory on the EMS server.

5. Once the files have been downloaded to the liveUpdate directory, the MD5 sums of the 
downloaded files are checked against the MD5 sums of the same files in the Extreme 
Networks IPS configuration database. If the MD5 sum for any downloaded file matches the 
MD5 sum of the same file in the configuration database, then that downloaded file is not 
imported because the files are the same. If the MD5 sums don’t match, then the downloaded 
file is imported into the configuration database. The files that can be imported include:
– The DragonSensor_NIDS.xml file, which updates the default network sensor zone and 

signatures in the database.

– The default host sensor policies from the HostSensor_<OS><config-info>.xml files in the 
liveUpdate directory. Note that there are a number of default host sensor policies, for 
different operating systems and different configurations on an operating system. 

6. Network sensor master signature libraries are then updated to reflect any signatures that were 
added, modified, or copied out.

7. If the Automatically Update Custom Libraries option was selected in the Live Update 
window, then custom signatures derived from master signatures are updated if:
– The master signature was changed, and

– The custom signature was not modified from the master signature.

8. All sensors that include an updated master or custom library are updated to point to the 
updated library. These changes are reflected only in the configuration database until the 
modified host or network sensor is redeployed. The status panel identifies what sensors have 
been updated.

9. The dragon.conf file, located in the <installdir>/tools directory, is updated from the 
dragon.conf file in the liveUpdate directory. The dragon.conf file contains a list of all the event 
categories and event names and is used by some of the legacy reporting tools. After each Live 
Update, the local.conf file is merged back into the dragon.conf file.

10. Two or three log files are created in the <installdir>/logs directory. One log file lists the names 
of the new signatures imported into the EMS database. The second log file lists the signatures 
that were updated by the live update. If any signatures were obsoleted/deleted by the live 
update process, a third log file is created that lists the names of the deleted signatures.

11. When the Live Update process is complete, each EMS client receives a signal to update its 
local cache to reflect the updated signatures, signature libraries, and host sensor policies. 

12. If the Automatically Deploy Sensors After Liveupdate Completes option was selected in the 
Live Update window, Extreme Networks IPS automatically deploys all changes to the 
appropriate sensors following a Liveupdate.
If the Automatically Deploy Sensors After Liveupdate Completes option was not selected, 
you can manually deploy changes to the sensors after Liveupdate completes.

13. If the Live Update Binary Upgrade Files option was selected in the Live Update window, 
Enterasys IPS automatically downloads the binary upgrade file, dragonbup.md5, to the 
appropriate EMS directory.
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The dragonbup.md5 file contains a list of all the update files that are available for download, 
along with the MD5 hash sum values for each file.

All the MD5 hash sum values listed in dragonbup.md5 are compared with the MD5 hash 
sums of the previously downloaded update files located in the liveUpdate directory.

If the sums of any files are different, or if a file listed in dragonbup.md5 does not exist in the 
liveUpdate directory, those files are downloaded from the Dragon website to the liveUpdate 
directory on the EMS server.

The figure below shows the message that opens in the Operations window when the Live 
Update process is complete.

Configuring Live Update Options
To configure the Live Update:

1. From the Options menu, select Live Update under Preferences. 

The Live Update pane opens.

Note: Custom host sensor policies are not automatically updated by the Live Update process. If you 
want to implement an updated Master Policy in a custom policy, you must do it manually.
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2. Set the Live Update parameters. See Table 12-1.

Table 12-1 Live Update Parameters 

Parameter Description

Update URL Do not change the default unless specifically instructed to do so. The 
default URL is the correct location to get updates for your currently running 
software version.

Schedule Select this option and a time to schedule a daily update. 

To start a live update immediately, click Execute Now.

Automatically update custom 
libraries after successful Live 
Update

Select if you want the Live Update process to update custom signatures 
derived from changed master signatures. 

Automatically deploy sensors 
after Live Update

Select if you want Extreme Networks IPS to automatically deploy any 
changes to the appropriate sensors following a Liveupdate.

This option is useful if you want to ensure that sensors are automatically 
updated with the latest changes following a live update. If you prefer to 
manually review changes from Live Update prior to deploying them to 
sensors, do not check this option. If you do not check this option, you can 
deploy changes to the sensors manually after Live Update completes.

Live Update from local files Select if you want the update to just import the files in the 
<installdir>/liveUpdate directory, and not attempt to download from the 
Enterasys Extranet.

This option is useful for updating an EMS that is not on the Internet. You 
can download the tar file on the Live Update site and then manually place 
the live update files in the liveUpdate directory. Then select this option and 
click OK.

Download Binary Upgrade 
packages 

Select if you want Enterasys IPS to automatically download the binary 
upgrade file, dragonbup.md5, to the appropriate EMS directory.

Server Authentication Info Enter the username and password you use to access the Enterasys 
Extranet.

Use HTTP Proxy Select to use an HTTP proxy server. 
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3. Click Save to save your configuration changes.

High Availability
High availability allows you to configure a secondary EMS server for redundancy. 

For details about configuring high availability, see Appendix A, Configuring EMS High 
Availability.

Database Backup/Restore
The Database Backup/Restore tool allows you to manually back up the database for the EMS to 
which you are currently connected or to schedule automatic daily backups. 

The database backup functionality is available from the Options menu. Under Preferences, select 
Database Backup/Restore. 

Proxy Info Proxy server IP address

Use Proxy Authentication Select if applicable to your network connection to the Internet. Enter the 
username and password.

Table 12-1 Live Update Parameters  (continued)

Parameter Description
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Backing Up the Database Manually
To backup the current database manually, click Execute Now at the top of the Database 
Backup/Restore tool.

The backup file created will be listed under Backup Files after the backup completes.

Scheduling Automatic Daily Backups
To schedule automatic daily backups: 

1. Click Schedule. 

2. Select the time when the daily backups will occur from the drop down list. 
The default time for generating a daily backup is 1:00 AM. 

3. (Optional) Select the number of daily backups that you want to retain.
The days retained field specifies the number of daily backups that will be saved. Older daily 
backups are aged out and dropped. 

4. (Optional) Select the number of monthly backups that you want to retain. 
The months retained field specifies the number of daily backups generated on the first of the 
month that will be saved. Older monthly backups are aged out and dropped. 

5. Click Save to accept your configured values.

Restoring the Configuration from a Backup File
To restore the configuration from a backup file:

1. Under Backup Files, select the backup file that you want to use to restore the configuration.

2. Click Restore Database.
3. In the Restore Database window, click Yes.

During the restoration process, the EMS web server restarts. 

4. Log in to the IPS GUI.

Note: If you schedule automatic daily backups, any backups that you generate manually will also 
age out and be dropped. 
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5. On the Dashboard, select the Systems tab. 
6. Right click a system. 
7. From the right click menu, select Operations > Full Deploy (all configs). 
8. Repeat steps 6 and 7 for each system listed in the Systems tab. 

Deleting a Backup File
To remove a backup file: 

1. Under Backup Files, select the backup file that you want to delete.

2. Click Delete File. 
3. In the Remove Files window, click Yes.

Export Signatures, Policies, and IP Variables
You can export existing custom signature libraries, custom host sensor policies, custom Alarmtool 
policies, and IP variables to the <installdir>/exportFiles directory on the EMS to which you are 
currently connected. You can also download the exported files to your client machine. 

IP variables are output as a CSV file that you can open in Excel. The CSV file lists the IP entries 
first and then the Not IP entries, which are indicated by a leading exclamation mark. 

To export signatures, policies, and IP variables:

1. In the IPS GUI, select Tools > Export from the menu bar.

The Export Configurtrions window opens.

2. From the Configuration type drop down list, select the type of file to export.
3. From the Name list, select the file to export.
4. To download the file to the client machine, select Export to browsing client’s file system. 

If you select this option, the file will be downloaded to your client machine and to the 
<installdir>/exportFiles directory on the EMS.

5. Click Export.
You can view operation status information about the export from the Operations panel.
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Import Signatures, Policies, Snort Rules, and IP Variables
You can import Extreme Networks IPS host sensor policies, Alarmtool policies, and signatures 
created in Extreme Networks IPS v7.5 or later. You can also import Snort rule signature set (a 
.rules file) and IP variables (a .csv file). 

When you import a Snort signature set, Extreme Networks IPS runs the selected Snort file through 
the IPS signature conversion utility.

You can import IP variables for IPv4 and IPv6 addresses. In the .csv file, separate the IP variable 
entries by either a comma or white space. For example:

1.2.3.41/32,!80.4.5.6/12,6.6.6.6,200.4.5.6/32,4.4.5.6/12,

!80.50.30.4/32

1.1.1.1/1

To indicate that an IP address will be a NotIP entry, add a leading exclamation mark to the IP 
address. For example: 

!80.4.5.6/12

Any IP addresses in the .csv file that do not include a CIDR mask are given a mask of 32 when 
they are imported. Entries in the .csv file that are invalid IP addresses or masks are ignored, 
though they are reported as audit and log messages. 

To import signatures, policies, Snort rules, and IP variables: 

1. Copy the files that you want to import to the <installdir>/importFiles directory.

You can also upload the file from your client machine.

2. In the <installdir>/install directory, run the fixperms.pl command to update the access rights 
on the files that you want to import.

3. In the IPS GUI, select Tools > Import from the menu bar.
The Import Configurations window opens.

4. If you want to upload the file from your client machine, select Upload from browsing client. 
5. From the Configuration type drop down list, select the type of file to import.
6. Select the XML file to import. If you selected Upload from browsing client, click the Select 

file to navigate to the file that you want to upload.
7. If you are importing a host policy, select the OS family.
8. Assign a new name to the signature or policy.
9. Click Import.
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You can view operation status information about the import from the Operations panel.

Binary Upgrade
The Binary Upgrade tool allows you to upgrade remote sensors from the EMS. Use this tool after 
you have upgraded your EMS. The procedures for upgrading the EMS and then using Binary 
Upgrade are described in the Extreme Networks Intrusion Prevention System Installation Guide.

Log/Data Policy Editor
Extreme Networks IPS log policies and the Log/Data Policy Editor let you configure the rotation 
and archiving of Extreme Networks IPS log files and data files. When a log file rotation occurs, the 
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current log file is closed, the file is archived, and a new log file is opened. Log file rotation in 
Extreme Networks IPS occurs when a log file reaches a specified size (25 MB by default).

Default Log Policy

Extreme Networks IPS provides a mechanism that sets a default log policy for IPS sensors and 
agents that create log and data files. This default log policy globally determines the following:

• IPS log file rollover settings

• IPS event data file retention settings

Log File Rollover Settings

The default log policy specifies the following treatment of Extreme Networks IPS log files:

• In MB, the size a log or data file can reach before that file will be rotated. By default this is 25 
MB. This can be set to a maximum value of 4096 MB.

• How many file rotation cycles to perform before deleting the oldest previously rotated file. By 
default this is 4 rotations.

This log file size threshold (25MB by default) is user configurable as described in “Changing the 
Default Log Policy for all Nodes” on page 12-11. However, the polling interval used to check the 
size of log files is not user configurable. This polling interval is 10 seconds. Because of this 10 
second interval, it is possible for log file size to exceed the default logging file size threshold before 
the log file is rotated out. In some cases, when logging a great deal of data in a short period, the log 
file threshold can be exceeded by several MB before the log file is polled for size and rotated out.

The default settings for the default log policy are 25 MB and four file rotations. This specifies that 
when a given log file reaches 25 MB in size, it will be closed and rotated out. The closed log file, for 
example, Dragon2MySQL.log, will also be renamed (if a .log file already exists). The rotated file is 
renamed by appending the rotation number to the filename, such as Dragon2MySQL.log.1, 
Dragon2MySQL.log.2, and so on. 

In this example, the fifth rotation triggers the deletion of the Dragon2MySQL.log.4 file, and the .3 
file becomes .4, .2 becomes .3, and so on, until .log becomes .log.1 and a new file is opened. This 
new file is named .log and the process repeats. 

An example of the /<installdir>/logs directory showing a complete cycle of the log file rotation 
process for the Dragon2MySQL log follows.

-rw-rw----    1 dragon   dragon    5018849 Dec 16 15:20 Dragon2MySQL.log
-rw-rw----    1 dragon   dragon   25913343 Dec 16 10:39 Dragon2MySQL.log.1
-rw-rw----    1 dragon   dragon   25414352 Dec 11 15:56 Dragon2MySQL.log.2
-rw-rw----    1 dragon   dragon   25390680 Dec 11 15:55 Dragon2MySQL.log.3
-rw-rw----    1 dragon   dragon   25824999 Dec 11 15:54 Dragon2MySQL.log.4

Event Data File Settings

The default log policy determines the following for Extreme Networks IPS Event Data files:

• In days, the length of time archived Event Data files will be retained.

• The action to take when a data file is rotated. The default action is to compress the data file.
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Managing Log Policies with the Log Policy Editor

You can use the Default Log Policy Editor to change the default log policy for all newly created 
nodes. You can use the similar Log Policy Editor to over-ride the default log policy in the context 
of an existing node.

Changing the Default Log Policy for all Nodes
Using the Default Log Policy Editor, you can change the values for the default log policy. The 
default log policy is applied to all newly created log policies. For example, when a new Extreme 
Networks IPS node is created, it inherits these log policy settings. Changing log policy settings 
using the Default Log Policy Editor affects the default log policy settings used by newly created 
log policies.

To change the default log policy:

1. In the IPS GUI, select Option from the menu bar.

2. Under Preferences, select Log/Data Policy. 
The Default Log/Data Policy Editor appears.

3. On the Log File Rollover Settings tab, configure the default settings:
– Default Rollover Size (MBs) — The file size in MB that active log files can grow to before 

they will be closed and rotated out. By default this is 25 MB. This value can range from 0 
to 4096. Setting this to 0 will prevent log files from being rolled over.

Note: Log policies for existing nodes can be configured in the context of the individual node. See 
“Managing Cache Files” on page 12-13 for more information.
Extreme Networks Intrusion Prevention System Configuration Guide 12-11



Log/Data Policy Editor
Modifying the rollover size of the active log files will create new log files with the new 
rollover size For example, if you have two 25MB and one 15MB active file and you change 
the rollover size from 25MB to 10MB, the following happens:

- The two 25MB log files remain unchanged.

- The 15MB log file is rolled.

- A new log file is created. This log file rolls once it reaches the new rollover size, 10MB.

– Default Rotation(s) — The number of file rotation cycles to perform before deleting the 
oldest previously rotated file. By default this is 4 rotations. This value can range from 0 to 
50. Setting this to 0 will prevent log files from being rotated out.

4. Click Save. 
5. You can override the log file rollover settings for individual Enterasys IPS components for all 

new created policies in the Override Default Settings table. 
To override the default log file rollover settings for a log policy component:

a. For the log policy component that you want to override, click the value in the Rollover 
Size (MB) column or Rotation(s) column. 

b. Change the value. 

c. Click Save. 

A checkmark displays in the Overriden column for the log policy component with the 
overridden values. 

6. On the Data Retention tab, configure the default settings:

– Default Retention (Days) — The number of days for which an Extreme Networks IPS 
data file will be kept. By default this is 30 days. 

– Default Action — The action Extreme Networks IPS will perform on archived data files. 
Possible actions are No Action or Delete. The default action is No Action, which means the 
data files will be compressed. 

7. Click Save to confirm your default log policy configuration.

8. You can override the log file rollover settings for individual Enterasys IPS components in the 
Override Default Settings table. 
To override the default data retention settings:

a. For the log component that you want to override, click the value in the Retention (Days) 
column or Action column. 
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b. Change the value. 

c. Click Save. 

A checkmark displays in the Overriden column for the component with the overridden 
values. 

9. Deploy your changes. These log policy settings will be used for all newly created log policies.

Managing Cache Files
On a Windows sensor, you can change the size of the cache files. By default the size of the cache 
files is set to unlimited. On a UNIX sensor, you change the size of the cache files and the number of 
cache files. 

Table 12-2 lists the cache file growth rate for the supported platforms if a standard policy is 
deployed to a sensor.

Changing the Cache File Size on a Windows Sensor

To change the cache file size of a Windows sensor:

1. In the IPS GUI, select Configuration > Channel Profiles. 

2. Select the event channel profile that is assigned to the Windows sensor. 
3. Expand the Cache Manager Agent Settings section. 
4. In the Maximum Cache File Size field, enter the new cache file size in bytes. 
5. In the Dashboard view, right click the Windows sensor.
6. In the right click context menu, select Deploy. 

When the sensor is deployed, the old cache file is deleted and a new cache file with the new 
size is created. 

Changing the Cache File Size and Number of Files on a UNIX Sensor
To change the cache file size and the number of cache files of a UNIX sensor:

1. In the IPS GUI, select Configuration > Channel Profiles. 

2. Select the event channel profile that is assigned to the Windows sensor. 
3. Expand the Cache Manager Agent Settings section. 
4. Configure the cache file settings as desired:

– Number of Cache Files

Table 12-2 Cache File Growth Rate

Platform Growth Rate

Windows 20MB/day

Solaris 20MB/day

Red Hat 2–3MB/day, or 10MB in 3 days

AIX 2–3MB/day, or 10MB in 3 days

HP-UX 2–3MB/day, or 10MB in 3 days
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– Maximum Cache File Size 

The cache file size is in bytes.

5. Remove the existing cache files. 
a. Log in to the sensor as root. 

b. Remove the cache files.

rm .cache/*

6. In the Dashboard view, right click the sensor.
7. In the right click context menu, select Deploy. 

The UNIX sensor is deployed with the new cache file size and number of cache files. 

EMS Monitor
The EMS Monitor tool allows you to monitor disk space and, if the disk space exceeds the critical 
threshold, shut down the sensors and agents on the EMS system. 

The EMS Monitor tool has two disk space thresholds.

Table 12-3 EMS Monitor Thresholds

Field Description

Disk Full Warning Threshold If the percentage of disk space filled surpasses this threshold, the 
Dashboard status bar displays a warning message. You should take this 
opportunity to free up some disk space. 

The default value is 90%.

Note: The value of this threshold must be lower than the value of the 
critical threshold. 
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Disk Full Critical Threshold If the percentage of disk space filled surpasses this threshold, the sensors 
and agents on the EMS system are shut down. The Dashboard status bar 
displays a message indicating that the sensors and agents have been 
shut down and the Operations panel reports the corresponding 
operations. 

The default value is 95%.

You must restart the sensors and agents on the EMS system manually. 

Note: Ensure that you free up ample disk space before restarting the 
agents and sensors. If you restart the agents and sensors without freeing 
up disk space, Extreme Networks IPS will allow the disk to continue to run 
above the critical threshold. Extreme Networks IPS will not shut down the 
agents and sensors again. 

Table 12-3 EMS Monitor Thresholds

Field Description
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EMS Log Viewer
You can view the following logs in the EMS Log Viewer:

• Boot.log—Timestamp values for start, stop, and shut down scripts. Dragon JBoss startup with 
host IP address

• Dpmmwctl.log—Middleware control process log file. Operations, such as deploy, start, stop, 
binary upgrade, that are initiated by the EMS use the dpmmwctl interface to execute the 
operations. This log file contains informational and error messages related to these operations.

• Dragonctl.log—Main sensor and agent process control and monitoring. This log file contains 
information and errors related to starting, stopping, and monitoring the status of Dragon 
processes.

• Jboss.log—The EMS run within the JBoss J2EE application container. This log file will contain 
information and errors related to the EMS process as well as other functions of the J2EE 
container.

The jboss.log file contains entries regarding every change made in the EMS database, every 
operation executed (such as deploy/start/stop), information about Live Updates, database 
backups, client logon histories, and error conditions that may arise on the EMS server. The 
jboss.log file is a Java log4j file that is configured by default in Extreme Networks IPS to 
rollover each evening at midnight. The log file for the current day is named “jboss.log.”

• Myslqd.log—The DEM and dragonevents databases use the MySQL database engine. This 
log file will contain information related to the mysql process and databases.

• Netcfgclient.log—This net-cfg-client process maintains the client-side configuration channel 
connection; this is required even on the EMS to perform operations, such as deploys. This log 
file contains information and errors related to the configuration channel.

To view the EMS log files:

1. From the Tools menu, select EMS Log Files. 

You can also launch the EMS Log Viewer by clicking the View EMS Log Files icon on the 
EMS/Reporting tab of the Dashboard.

2. In the EMS Log Viewer, select the log file type that you want to view from the Type drop 
down list. 

Note: Dragon2MySql and the sensor logs are available elsewhere through the Web UI. 
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3. From the Log File drop down list, select the log file that you want to view. 

The log file displays in the EMS Log Viewer. 
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13
Host Sensor Policy Configuration

This chapter describes the Hosts Sensor framework and provides a high-level look at how to 
create Host Sensor policies using the Host Policy editor.

Host Sensor Policies
A host sensor policy is a container for the processing modules. Each module provides a logical 
grouping of sensor tasks. 

Extreme Networks provides a number of master policies created for the operating systems 
supported for Host Sensor. Each master policy contains a number of predefined modules. 

You can apply master policies to a host sensor directly. Custom policies can be derived or copied 
from a master or other existing custom policy, or they can be created from scratch.

Creating a New Policy

To create a new policy:

1. From the Configuration menu, select Host Policies. 

2. In the Host Policies view, click the Create button.

For information about... Refer to page...

Host Sensor Policies 13-1

Host Sensor Policy Modules 13-2

References 13-27

Adding Signatures to a Resource Definition 13-27

Record Format Tokens 13-31

Using the %i Token 13-32

Named Fields 13-33

HostSensor_Linux_DSM Master Policy 13-2

Note: You can edit and delete master policies. Live Update will recreate deleted master policies.
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The Create Host Policy window opens.

3. Enter the name of the policy.

You can enter any alphanumeric name at least three characters long. Each policy name must 
be unique.

4. Select the OS Family from the drop-down menu, then select the operating system from the 
OS drop down menu. All Host Sensor policies are specific to an operating system.

5. In the Derive From drop-down menu, select the master or custom policy from which you 
want to derive the new policy. 

To create the modules from scratch, select Do Not Derive Policy.

6. Click Create.

The policy is added to the list of policies under the appropriate OS family.

7. To add or remove modules from the new policy, right-click the new policy’s name and select 
Add/Remove Modules.

The Add/Remove Modules window displays. If you derived the new policy from an existing 
policy, modules from the existing policy will be selected. If you did not derive the new policy, 
the modules you can add are the ones that are not grayed out. 

8. Select the modules that you want to include in the policy.

9. Click Save.

10. Configure the modules. For more information, see Host Sensor Policy Modules on page 13-2.

Adding Modules to a Policy

To add modules to a host sensor policy:

1. From the Configuration menu, select Host Policies. 

2. In the Host Policies view, right-click the appropriate policy and select Add/Remove Modules.

The Add/Remove Modules window opens. 

3. Select the modules that you want to include in the policy.

4. Click Save.

For each module that you selected, a tab is added in the Policy panel.

5. Configure the modules. For more information, see Host Sensor Policy Modules on page 13-2.

Host Sensor Policy Modules
• “Event Log Detection Module” on page 13-3
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• “Service Detection Module” on page 13-7

• “Extended File Detection” on page 13-8

• “Registry Detection Module” on page 13-17

• “SNMP Detection Module” on page 13-19

• “Sysinfo Module” on page 13-23

• “Filter Events Module” on page 13-25

Table 13-1 lists host sensor policy module attributes.

Event Log Detection Module

This module monitors the Windows Event Logs (for example, Application, System, or Security) 
for attack signature matching. You can create signatures to match activity written to any of the 
available Windows Event Logs. For each monitored event log to be monitored, an Event Log 
Resource is configured with one or more associated signatures. 

For example, if auditing is enabled for the Administrator account, an entry is added to the Security 
Event Log each time the Administrator successfully or unsuccessfully logs on/off of the system 
(based on the audit settings). The Host Sensor can be configured to look for this activity by 
defining the Security event log and writing a signature to look for the specific Administrator 
logon/logoff event in the event log. 

This module is available on the Windows platform only.

Configuring Event Log Detection Module Parameters

To configure the module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Event Log Detection module, see “Adding Modules to a 
Policy” on page 13-2 to add the module to the policy.

Table 13-1 Host Sensor Policy Module Attributes

Module Platform Contains 
Resources

Has 
Signature

Linux Windows HP AIX Solaris

Event Log Detection x event x

Service Detection x

Extended File Detection x x x x x file x (Log)

Registry Detection x reg

SNMP Detection x x x x x snmp x

Sysinfo x

Filter Events x x x x x
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2. Click on Event Log tab. 

3. Under Settings, set the parameters as appropriate. See Table 13-2.

4. Click Save.

5. Configure the resources that are used to identify which Windows Event Log is targeted for 
analysis, described in “Adding Resources” on page 13-4.

Adding Resources

You must associate one or more resources with the Event Log Detection module. These resources 
identify which Windows Event Log is targeted for analysis (for example, the standard Windows 
Application, System, and Security event logs). Each resource can then be configured with one or 

Table 13-2 Event Log Detection Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Sleep Value (seconds) The number of seconds between scanning the “proc” file system for notifications of network starts 
and terminations.

Event Auditing Double click the event row to edit the setting. 

• Select Audit on Success to enable Host Sensor reporting on “success” log entries.

• Select Audit on Failure to enable Host Sensor reporting on “failure” log entries.

Click Update to save changes. 
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more signatures, which describe patterns that, when they appear in the event log, generate an 
event.

To add a resource:

1. On the Event Log tab under Resources, click Create. 

The Create Event Log File Resource window opens.

2. Set the parameters as appropriate. See Table 13-3.

3. Click Create. 

The resource is added to the Resources section. 

Note: Live Update will not update an edited master policy resource.

Table 13-3 Event Log File Resource Properties 

Field Description

File Resource Name Each resource must have a unique name. For example, if the event log file you want to monitor is 
the Security log, you might give the resource a name like “EvtLog-Security.”
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Log File Name Specify the actual name of the Windows Event Log on the host. The three typical event logs in use in 
Windows are: System, Security or Application. Alternatively, you can enter a custom log file name 
as text in this field.

The name specified is used by the Host Sensor to open the event log and examine its contents for 
changes.

Record Format Enter a series of tokens which describe how data fields are to be parsed from records in the log file. 
Signatures are then capable of referencing the implied field numbers for pattern matching analysis. 
Valid tokens are described in “Record Format Tokens” on page 13-31.

Data Fields Specify the field numbers (implied based on the Record Format) that should be included in the event 
data portion of events generated from this resource. 

Field numbers are specified with a preceding percent sign. For example, %1 indicates that the first 
field should be included in the event. Multiple fields can be specified by listing one after the other. 
For example, fields 4, 5, 6 and 8 can be specified as %4%5%6%8. 

As events are generated, the fields specified as data fields will be included in the event. If Data 
Fields are specified, the Record Format must be specified for the file and support the parsing of 
fields listed in the data field. If no data field is specified, Host Sensor will default to the first field (that 
is, %1).

SIP Field/DIP Field Specify the field number where the source IP address (SIP) and/or destination IP address (DIP) 
reside. The field number can be specified in one of three different formats:

• If the field number is preceded by a percent sign (for example, %2), the field number is relative to 
the Record Format defined. For example, %2 indicates that the record should be parsed based 
on the defined record format and that the second field represents the SIP (or DIP). 

• If the field number is preceded by a pound sign (for example, #2), the Host Sensor will 
intelligently parse the record looking for IP addresses in a dotted quad (for example, 
123.123.123.123) format. For example, #2 indicates that the second occurrence of an IP address 
in the record should be used as the SIP (or DIP).

• If a field number is listed without any preceding character (for example, 2), the Host Sensor is 
forced to parse the record, treating space characters as field separators. For example, 2 indicates 
that the second space separated field should be used for the SIP (or DIP).

There are advantages and disadvantages associated with each of the supported SIP/DIP formats. 
Utilizing the record format (%2) will be the most efficient option at the expense of complexity to 
configure. The record is already parsed based on the format, and no extra overhead is required to 
utilize one of these parsed fields as a SIP/DIP. Parsing based on spaces (2), and intelligently parsing 
for IP addresses (#2), are increasingly less efficient with the benefit of being increasingly easier to 
configure. 

If a source or destination IP address is specified, it will be included in any generated events. By 
default, Host Sensor assumes a source IP address of 0.0.0.0, and uses the local host IP address as 
the destination IP address.

Table 13-3 Event Log File Resource Properties  (continued)

Field Description
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4. Click Save to add your changes to the policy being configured.

Service Detection Module

This module monitors the networking subsystem on a Linux system to determine if new TCP or 
UDP services are started, or if existing services have stopped. The “proc” file system is monitored 
for notification of network service starts and terminations. An event is generated for each service 
that is started or stopped. New services started on a machine can be indicative of a backdoor 
activation on the host. 

This module is available on the Linux platform only.

To configure the module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Service Detection module, see “Adding Modules to a Policy” 
on page 13-2 to add the module to the policy.

2. Click the Service tab.

3. Set the parameters as appropriate. See Table 13-4.

4. Click Save. 

Enable Web Convert Indicates that anti-IDS stripping should occur on each record. This is useful when dealing with web 
log files that may contain anti-IDS techniques such as embedded hex values (for example, %20). 
The conversion occurs as follows:

• URL Encoding will be decoded. Hexadecimal values will be converted to their ASCII 
counterparts. For example GET%20%2fcgi-bin will convert to GET /cgi-bin.

• Any /./ path name insertions will be flattened. For example, GET /etc/././././passwd will be 
converted to GET /etc/passwd. 

• Any /../ path name insertions will be resolved. For example, GET /etc/abc/def/../../passwd will be 
converted to GET /etc/passwd.

To eliminate unnecessary overhead, this option should only be turned on for web log files. The 
conversion is unnecessary for regular log files.

Host Signatures For information on adding host signatures, see Adding Signatures to a Resource Definition on 
page 13-27.

Table 13-3 Event Log File Resource Properties  (continued)

Field Description
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Extended File Detection

The Extended File Detection module comprises the File, MD5, and Log modules, as described in 
Table 13-5. The modules are available on all UNIX and Windows platforms. 

Table 13-4 Service Detection Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Sleep Value (seconds) The number of seconds between scanning the “proc” file system for notifications of network starts 
and terminations.

Enable TCP Service 
Detection

Select to monitor TCP service starts and terminations.

Enable UDP Service 
Detection

Select to monitor UDP service starts and terminations.

Table 13-5 Extended File Detection Modules 

Module Description

File Monitors files and directories to determine if attributes such as permissions, file size, and ownership have been 
altered. If the attributes of a file have changed, an event is generated to indicate that the file has been altered. 
This module is configured to monitor one or more File Resources. Each resource lists either a file or a directory 
to be monitored. 

File attribute monitoring allows you to choose to monitor a single file, or to specify a directory and monitor all 
sub-directories and files in that directory. You can configure the depth of monitoring in directories. You can also 
specify files or sub-directories that you want to exclude from monitoring Files that you want to include can be 
refined through the use of regular expression filters. 

MD5 Monitors files to determine if the file contents have been altered. This determination is done by comparing MD5 
hash values of the file at configurable intervals. If the unique MD5 hash/fingerprint of the file has changed, an 
event is generated to indicate that the file has been altered. This module is configured to monitor one or more 
MD5 File Resources. Each resource lists either a file or a directory to monitor. 

For example, assume that detecting changes in the contents of a security relevant file (for example, /etc/
passwd) is something to be tracked. Changes in binary files such as /bin/ls or /bin/id could indicate that a 
system had been “backdoored.” This means that a hacker has installed software on a compromised system that 
has extra functionality allowing the hacker continued access to the system. 

By default, the Host Sensor encrypts and archives MD5 checksums locally on the deployed host. However, the 
Host Sensor can be configured to periodically send the MD5 checksum information to an Event Flow Processor 
for offline storage. In this mode, an agent on the Event Flow Processor scans the MD5 checksums as they are 
transmitted and compares the values against the values stored on the EFP. If a discrepancy is detected, the 
EFP generates an event indicating that the MD5 has changed. This added feature allows for a more secure 
environment by storing the MD5 checksums on a machine other than the one that is being attacked.
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Configuring File Detection Module Parameters

To configure the module parameters:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Extended File Detection module, see “Adding Modules to a 
Policy” on page 13-2 to add the module to the policy.

Log Monitors the log files for attacks by means of signature matching. Signatures can be written to match activity 
written to any of the available log files. For each log to be monitored, a Log File Resource is configured with one 
or more signatures associated with it. 

The contents of log files can be scanned to alarm if specified signature patterns occur. This is configured by 
specifying a record format describing the record layout for a defined file and then defining signatures that 
pattern match within the record format. 

Each file defined can have signatures that are used to examine the file content for known attacks. This allows 
the contents of a file to be scanned for specific events. For example:

• Scan the /var/log/messages file for root logins.

• Scan the /var/log/httpd/access_log for successful PHF requests.

• Scan the web logs for anyone requesting the /etc/passwd file.

The Apache access log can be reviewed for attempts to download /etc/passwd by defining a record format for 
accesslog and then building the appropriate signature. 

Table 13-5 Extended File Detection Modules  (continued)

Module Description
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2. Click on File tab. 

3. Configure the modules as desired.

– For File module, see Table 13-6.

– For MD5 module, see Table 13-7.

– For Log module, see Table 13-8.

4. Click Save. 

5. Configure the file resources to monitor, as described in “Adding Resources” on page 13-11.

Table 13-6 File Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Scan Rate (seconds) The number of seconds between scans of configured directories for new matches to the configured 
regular expression filters. This setting affects each File Resource that is configured to monitor a 
directory via Regular Expression filters. For those resources, new file matches are rescanned every 
Scan Rate second.
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Adding Resources

You must configure one or more resources for the module. 

Sleep Value Specifies the number of seconds to delay between checking for activity. This allows performance to 
be tuned to either favor saving CPU cycles or increasing the responsiveness of detection.

Max Number 
Unchanged

Indicates the number of cycles of inactivity to permit on a given File Resource prior to refreshing the 
file. This setting prevents files from being moved/rotated and making the Host Sensor blind to further 
changes. If the module experiences the specified seconds of inactivity for a given resource, the 
module becomes suspicious and reopens the file.

Table 13-6 File Module Properties

Field Description

Table 13-7 MD5 Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Rate (seconds) The default number of seconds to delay between performing MD5 analysis of a configured MD5 File 
Resource (a file or a directory to monitor). This value may be overridden on each individual MD5 File 
Resource. 

Scan Rate (seconds) The number of seconds between scans of configured directories for new matches to the configured 
regular expression filters. This setting affects each MD5 File Resource that is configured to monitor 
a directory by means of a regular expression filter. For those resources, new file matches are 
rescanned as set in Scan Rate.

Table 13-8 Log Module Parameters

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Sleep Value (seconds) Specifies the number of seconds to delay between scanning the file. This allows performance to be 
tuned to either favor saving CPU cycles or increasing the responsiveness of detection.

Max Number 
Unchanged

Indicates the number of cycles of inactivity to permit on a given File Resource prior to refreshing the 
file. This setting prevents files from being moved/rotated and making the Host Sensor blind to further 
changes. If the module experiences the specified seconds of inactivity for a given resource, the 
module becomes suspicious and reopens the file.

Enable SSN Detection Generates an event if a social security number is detected. 

Credit Card Detection Generates an event if the selected credit card types are detected. 

• Validate—Generates an event if a credit card number is detected.

• Validate Card Only—Generates an event only if a valid credit card number is detected.
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• File resources—These resources list each file or directory to be monitored. You can specify 
directories by naming a directory as the Resource Path and including a regular expression 
filter which names the files in that directory to include in the monitoring.

• Log resources—These resources are used to identify which log files are being targeted for 
analysis (for example, Web Logs). Each resource can then be configured with one or more 
Host Signatures. These signatures describe patterns that when they appear in the log, should 
generate an event.

• MD5 resources—These resources list each file or directory to be monitored. Directories may 
be specified by naming a directory as the resource path and including a regular expression 
filter which names the files in that directory to be included in the monitoring.

To add a resource:

1. Under the Resources section of the File module, click Create.

The Create Extended File Resource window opens. 

2. In the Name field, enter a unique name for the resource.

3. In the Path field, enter the path to a particular file or directory. 

A directory name can be specified when combined with Exclude File and Regular Expression 
Filter attributes. On Windows platforms, the path name may include environment variables to 
be resolved locally on the Host (for example, %SYSTEMDRIVE%).

4. Select the modules that you want to include in the resource. 

Tabs for the selected the modules are added to the Create Extended File Resource window 
below the Name field. A Filters tab is added is you selected File or MD5.

5. On each module’s tab, set the resources for the module. 

– For File module resources, see Table 13-9.

– For MD5 module resources, see Table 13-10.

– For Log module resources, see Table 13-11.

6. If your resource includes File or MD5, set the filters. See Adding Filters on page 13-16.

7. Click Create. 

Note: Live Update will not update an edited master policy resource.
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8. Under the Resources section of the File module, click Add.

The Add Existing Extended File Resources window opens.

9. Select the extended file resource. 

10. Click Add. 

The extended file resource is added under Resources.

Table 13-9 File Module Resource Parameters 

Field Description

File Permission 
Changes

Generates an event if permissions associated with the file are altered. Under UNIX, Host Sensor will 
monitor the setuid, setgid, sticky-bit, owner-read, owner-write, owner-execute, group-read, group-
write, group-execute, other-read, other-write and other-execute permissions. If the permissions 
change, a FILE:PERMS-CHANGED event is generated.

User Ownership 
Changes

Generates an event if the owner of the file has changed. If the owner changes, a FILE:UID-
CHANGED event is generated. Under Windows, this setting may result in additional CPU overhead. 

Group Ownership 
Changes

Generates an event if the group of the file has changed. If the group changes, a FILE:GID-
CHANGED event is generated. Under Windows, this setting may result in additional CPU overhead. 

Inode Values Generates an event if the inode number for a file has changed. This is useful to determine if a file 
has been moved/deleted and replaced or if a log has been rotated. If the inode changes, a 
FILE:INODE-CHANGED event is generated.

Truncated Files Generates an event if the size of the file has become smaller. If the file shrinks in size, a 
FILE:TRUNCATED event is generated. Log files may be altered by an attacker to remove entries 
that log their activity. A log file should not normally reduce in size.

File Size Increase Generates an event if the size of the file has become larger. If the file grows in size, a 
FILE:INCREASED event is generated.
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Modification Time 
Changes

Generates an event if the modification time changes on a file without a change in the file’s size. If the 
modification time changes, a FILE:MTIME-CHANGED event is generated.

File Created If this option is selected, a FILE:CREATED event will be generated if the specified file is present on 
the file system. No file detection events will be generated until the file appears on the file system. 

The intention of this feature is to allow a file resource to be defined for a file that usually isn't on the 
machine being protected. For example, imagine a root kit that places a file in the root filesystem 
called bad-news-bears.bin. Hopefully this file is never present on the filesystem but if it is, this 
should be considered a security breach. You can create a file resource for the file /bad-news-
bears.bin and use the File Created option. No events will occur until the file is detected on the 
system. When the file is written to the file system a FILE:CREATED event will be generated.

Dynamic Directory Tells the Host Sensor to re-scan the resource directory for the addition of new files, in addition to 
checking files that already existed when Host Sensor started running. If new files are detected, a 
FILE:CREATED event will be generated and the new files will inherit the protections defined for the 
resource directory.

Table 13-9 File Module Resource Parameters  (continued)

Field Description

Table 13-10 MD5 Module Resource Parameters 

Field Description

Rate Specifies an override to the global rate configured at the Module level. Rate is the number of 
seconds to delay between performing MD5 analysis of the configured MD5 File Resource. Each 
resource can specify a different rate setting. 
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Table 13-11 Log Module Resource Properties 

Field Description

Modifier If you are creating a policy for Windows, select a modifier when scanning IIS log files. It determines 
the naming convention of the file used by IIS. The modifier must be set in an IIS Log Detection 
policy. The modifier tells Host Sensor what kind of logging IIS is configured to use. This is important 
because each style of logging configured in inetmgr.exe produces a unique file name. The modifier 
dictates the format of the log file's name. 

The path to the log file for a given site/service is determined by the Resource Path and Prefix. The 
results of the modifier setting allows the full path to the log file to be determined by the Log Detection 
Module. All log files end with the .log file extension. 

The name of an actual log file is determined by: 

• Active Log Formats—IIS 5 and IIS 6 allow for 3 configurable kinds of logging formats:

– W3C Extended Log File Format (default): Log file is prefixed with ex 

– NCSA Common Log File Format: Log file is prefixed with nc 

– Microsoft IIS Log File Format: Log file is prefixed with in 

• Rotation Schedule —IIS Logs can be configured to be rotated on the following conditions: 

– Hourly 

– Daily 

– Weekly 

– Monthly 

– When file is N MB in size 

IIS Logs can also be configured to not rotate which is the same as an unlimited file size. 

Record Format Describes how data fields are to be parsed from records in the log file. Signatures are then capable 
of referencing the implied field numbers for pattern matching analysis. Valid tokens are described in 
“Record Format Tokens” on page 13-31. 

You can also use named fields, as described in “Named Fields” on page 13-33.

Data Fields Specifies the field numbers (implied based on the Record Format) that should be included in the 
event data portion of events generated from this resource. 

Field numbers are specified with a preceding percent sign. For example, %1 indicates that the first 
field should be included in the event. Multiple fields can be specified by listing one after the other. 
For example, fields 4, 5, 6 and 8 can be specified as %4%5%6%8. 

If you used named field in the Record Format, use the same named fields here. Names should be 
enclosed in brackets. See “Named Fields” on page 13-33 for more information. 
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11. Click Save to add your changes to the policy being configured.

Adding Filters

To add filters to the File or MD5 resources:

1. Click the Filters tab.

SIP Field / DIP Field Specifies the field number where the source IP address (SIP) and/or destination IP address (DIP) 
reside. The field number can be specified in one of four different formats:

• If the field number is preceded by a percent sign (for example, %2), the field number is relative to 
the Record Format defined. For example, %2 indicates that the record should be parsed based 
on the defined record format and that the second field represents the SIP (or DIP). 

• If the field number is preceded by a pound sign (for example, #2), the Host Sensor will 
intelligently parse the record looking for IP addresses in a dotted quad (for example, 
123.123.123.123) format. For example, #2 indicates that the second occurrence of an IP address 
in the record should be used as the SIP (or DIP).

• If a field number is listed without any preceding character (for example, 2), the Host Sensor is 
forced to parse the record, treating space characters as field separators. For example, 2 indicates 
that the second space separated field should be used for the SIP (or DIP).

• If using named fields, use the field name for source or destination IP. See “Named Fields” on 
page 13-33 for more information. 

Enable Web Convert Indicates that anti-IDS stripping should occur on each record. This is useful when dealing with web 
log files that may contain anti-IDS techniques such as embedded hex values (for example, %20). 
The conversion occurs as follows:

• URL Encoding will be decoded. Hexadecimal values will be converted to their ASCII 
counterparts. For example GET%20%2fcgi-bin will convert to GET /cgi-bin.

• Any /./ path name insertions will be flattened. For example, GET /etc/././././passwd will be 
converted to GET /etc/passwd. 

• Any /../ path name insertions will be resolved. For example, GET /etc/abc/def/../../passwd will be 
converted to GET /etc/passwd.

To eliminate unnecessary overhead, this option should only be turned on for web log files. The 
conversion is unnecessary for regular log files.

Host Signatures For information on adding host signatures, see Adding Signatures to a Resource Definition on 
page 13-27.

Table 13-11 Log Module Resource Properties  (continued)

Field Description
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2. Click Add. 

3. Specify the values for the filter. See Table 13-12.

4. Click Update.

Registry Detection Module

The Registry Detection module monitor the Windows Registry for additions, deletions, and 
changes to monitored hives/keys.

The Registry Detection module is a light-weight mode that operates entirely in user-space and can 
tell you only that a key has changed.

Registry Detection will also report the value of a key before and after the change has taken place. 
This can be an extremely powerful tool. The process that made changes to a monitored Registry 

Table 13-12 Filter Parameters 

Field Description

Directory Depth Limit the depth of how many directories should be examined when using the regular expression 
filters. A directory depth left blank, or set to 0, means to fully recurse the directory for all files.

Note: If you do not limit the depth of a regular expression, it will collect more files to be scanned. 
This action could possibly affect the performance of host sensor, or the free CPU time of the 
machine itself. It is recommended that directories have depth limits. 

Apply To • File Settings

• MD5 Settings

• File and MD5 Settings

Filter Type • Exclude

• Include

Value The regular expression filter, which can be used when specifying directories as a Resource Path. 
This setting allows Regular Expression Filter patterns to be specified to indicate which files to 
include in analysis of the specified directory.

Note: Include escape backslashes in the filter. For example, to include all log files in a directory, 
specify the following:

.*\.log

If you have entered a value in the Directory Depth field and you want to search the directory 
recursively, add \.* to the regular expression filter.
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key is also reported by the Registry Detection module. Registry changes that occur at boot time 
can be detected by Registry Detection.

This module is configured to monitor one or more Registry Resources. Each resource will list a 
Registry Hive and Key to be monitored. 

The Registry Detection Module is available on Windows platforms. 

Configuring Registry Detection Module Parameters

To configure module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Registry Detection module, see “Adding Modules to a 
Policy” on page 13-2 to add the module to the policy.

Click the Registry tab.

2. Set the parameters as appropriate. See Table 13-13.

3. Click Save. 

Table 13-13 Registry Detection Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.
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4. Click Save. 

5. Configure the resources to monitor, as described in “Adding Resources” on page 13-19.

Adding Resources

One or more Registry resources must be configured for the module. These resources list each hive/
key to be monitored. The Registry resource settings allow registry monitoring to be fine tuned. 

To add resources:

1. Under the Resources section of the Registry module, click Create.

The Create Registry Resource window opens. 

2. Set the parameters as appropriate. See Table 13-14.

3. Click Create.

SNMP Detection Module

This module monitors inbound SNMP traps for attack signature matching. It allows third party 
software/hardware that is capable of generating traps, to integrate with the Host Sensor. For each 
trap source to be monitored, an SNMP Resource is configured with one or more signatures 

Sleep Value (seconds) The number of seconds between scanning the registry. If a new registry event occurs, Registry 
Detection Ex wakes up and acts immediately. It doesn't wait for the timeout to start processing 
events. As soon as the event is processed, it is cleared out of the Driver Memory.

Table 13-13 Registry Detection Module Properties

Field Description

Note: Live Update will not update an edited master policy resource.

Table 13-14 Registry Resource Properties 

Field Description

Resource Name If desired, change the resource name. Each registry resource should have a unique name within the 
policy being configured. The name specified is used in event reporting.

Hive Name Select the Windows Hive being monitored. The Windows registry is partitioned into groupings called 
hives. Choose the hive in the registry that contains the registry entry being defined.

Key Name The key name being monitored within the Hive. Key names and all the subkeys are monitored. The 
key name entered here is used in conjunction with the selected Key Name Pattern Matching Type. 
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associated with it. Any received traps can optionally be forwarded to a configured destination. 
This allows clients that are only capable of trapping to one location, to continue to send traps to 
their original destination and still allow the Host Sensor to receive the trap. 

This module is available on the UNIX and Windows platforms.

Configuring SNMP Detection Module Parameters

To configure module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the SNMP Detection module, see “Adding Modules to a Policy” 
on page 13-2 to add the module to the policy.

Click the SNMP tab.

2. Set the parameters as appropriate. See Table 13-15.

3. Click Save. 
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4. Click Save. 

5. Configure the trap resources to monitor, as described in “Adding Resources” on page 13-21.

Adding Resources

You must configure one or more resources for this module. These resources are used to identify 
which SNMP Trap sources are being targeted for analysis. SNMP Trap sources are identified by 
some combination of OID values and source IP addresses. Each resource can then be configured 
with one or more signatures. These signatures describe patterns that, when they appear in the 
SNMP Trap, should generate an event.

To add a resource:

1. Under the Resources section of the SNMP

2. module, click Create.

The Create SNMP Resource window opens. 

Table 13-15 SNMP Detection Module Properties

Field Description

SNMP Relay Target The IP address of the SNMP relay target. Select the IP version. The SNMP Detection module will 
forward every trap received to the specified address.

Enable Module Enables the module. 

Enable Module 
Debugging

It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Note: Live Update will not update an edited master policy resource.
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3. Set the parameters as appropriate. See Table 13-16.

4. Click Save. 

Table 13-16 SNMP File Resource Properties 

Field Description

SNMP Resource 
Name

The resource name. Each resource needs a unique name.

SNMP OID Identifies the trap source to be monitored. OID allows SNMP traps to be filtered such that only traps 
matching the SNMP OID value configured are analyzed during signature comparison. Alternatively, 
the OID value may be omitted to allow all traps regardless of OID value to be processed. 

SNMP SIP (CIDR) Source IP address for the trap source to be monitored. IP address values can be in IPv4, IPv6 or a 
CIDR block, but you must enter a mask. SNMP Version 1 includes a source IP address within its 
SNMP information. This may or may not match the actual source address as reported by the UDP 
level. 

SNMP Type SNMP type to apply to the SNMP SIP value. The information supplied in the SNMP SIP field can be 
specified as either UDP or SNMP. Typically, the UDP address is specified. This type must always be 
set to UDP when dealing with SNMPv2 traps.

Record Format A series of tokens that describe how data fields are to be parsed. Signatures are then capable of 
referencing the implied field numbers for pattern matching analysis. Valid tokens are described in 
“Record Format Tokens” on page 13-31.
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5. Click Commit to add your changes to the policy being configured.

Sysinfo Module 

This module monitors the local host to generate events as system resources exceed configured 
thresholds. The module supports monitoring the following:

• Percentage of CPU in use

• Percentage of disk space in use

• Dropped packets on network interfaces

• Percentage of swap space in use

Data Fields Indicate which field numbers (implied based on the Record Format) should be included in the Event 
Data portion of events generated from this resource. 

Field numbers are specified with a preceding percent sign. For example, %1 indicates that the first 
field should be included in the event. Multiple fields can be specified by listing one after the other. 
For example, fields 4, 5, 6 and 8 can be specified as %4%5%6%8. 

As events are generated, the fields specified as data fields will be included in the event. If Data 
Fields are specified, the Record Format must be specified for the file and support the parsing of 
fields listed in the data field. If no data field is specified, Host Sensor will default to the first field (that 
is, %1).

SIP Field / DIP Field Specify the field number where the source IP address (SIP) and/or destination IP address (DIP) 
reside. The field number can be specified in one of three different formats:

• If the field number is preceded by a percent sign (for example, %2), the field number is relative to 
the Record Format defined. For example, %2 indicates that the record should be parsed based 
on the defined record format and that the second field represents the SIP (or DIP). 

• If the field number is preceded by a pound sign (for example, #2), the Host Sensor will 
intelligently parse the record looking for IP addresses in a dotted quad (for example, 
123.123.123.123) format. For example, #2 indicates that the second occurrence of an IP address 
in the record should be used as the SIP (or DIP).

• If a field number is listed without any preceding character (for example, 2), the Host Sensor is 
forced to parse the record, treating space characters as field separators. For example, 2 indicates 
that the second space separated field should be used for the SIP (or DIP).

Enable Web Convert Indicates that anti-IDS stripping should occur on each record. This is useful when dealing with web 
log files that may contain anti-IDS techniques such as embedded hex values (for example, %20). 
The conversion occurs as follows:

• URL Encoding will be decoded. Hexadecimal values will be converted to their ASCII 
counterparts. For example GET%20%2fcgi-bin will convert to GET /cgi-bin.

• Any /./ path name insertions will be flattened. For example, GET /etc/././././passwd will be 
converted to GET /etc/passwd. 

• Any /../ path name insertions will be resolved. For example, GET /etc/abc/def/../../passwd will be 
converted to GET /etc/passwd.

To eliminate unnecessary overhead, this option should only be turned on for web log files. The 
conversion is unnecessary for regular log files.

Host Signatures For information on adding host signatures, see Adding Signatures to a Resource Definition on 
page 13-27.

Table 13-16 SNMP File Resource Properties  (continued)

Field Description
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Host Sensor Policy Modules
• Percentage of memory in use

This module is available on Linux/UNIX platforms only.

To configure module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Sysinfo module, see “Adding Modules to a Policy” on 
page 13-2 to add the module to the policy.

2. Click on the Sysinfo tab. 

3. Set the parameters as appropriate. See Table 13-17.

4. Click Save to accept your changes.

Table 13-17 SysInfo Detection Module Properties

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the Host Sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.

Sysinfo Interval The interval (in seconds) over which statistics are averaged to determine if an event should be 
generated. Events are limited such that not more than one event is generated per interval.

Sysinfo Rate The sample rate (in seconds) that system statistics are collected. This value must be less than or 
equal to the Sysinfo Interval value. 

Monitor CPU Usage Monitors CPU usage. An event is generated at the threshold. 

Monitor Disk Usage Monitors disk usage. An event is generated at the threshold. 

Monitor Swap Space 
Usage

Monitors swap space usage. An event is generated at the threshold. 

Monitor Network 
Interface Usage

Monitors network interface usage. An event is generated at the threshold. 

Monitor Memory 
Usage

Monitors memory usage. An event is generated at the threshold. 
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Host Sensor Policy Modules
Filter Events Module

This module allows events to be filtered based on one or more regular expression filters. Any 
events filtered by this module are discarded and are no longer available. This module is useful to 
filter events generated by a specific IP address or events that are identified as false positives and 
that cannot be explicitly disabled directly with the appropriate detection module.

This module is available on all platforms.

To configure module parameter settings:

1. In the Host Policies view, select the appropriate host sensor policy in the list.

If the policy does not include the Filter Events module, see “Adding Modules to a Policy” on 
page 13-2 to add the module to the policy.

2. Click the Filter Events tab.

3. Set the parameters as appropriate. See Table 13-18.

4. Click Add to add a filter. See Table 13-18.

5. Click Save. 

Table 13-18 Filter Events Module Properties 

Field Description

Enable Enables the module. 

Enable Debugging It is recommended that you do not select this. Debugging mode causes debug output for the specific 
module to be written to the host sensor log file. The debug output can cause the log file to grow 
significantly in a short amount of time. The debug setting should not be left active for long durations.
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Host Sensor Policy Modules
Field • SensorName—The Name of the Sensor

• EventName—The Event Name

• SIP—The Source IP Address of the event (dotted quad)

• DIP—The Destination IP Address of the event (dotted quad)

• Sport—The Source Port for the Event

• Dport—The Destination Port for the Event

• EventHeader—The Event Header Information

• EventDetail—The Event Detail Information

• Direction—The Direction Indicator for the Event

The field name causes the comparison to be limited to the event field specified in the name. 
Otherwise, the comparison matches if a match exists on the Event Name, Event Header, or Event 
Detail. 

Value The regular expression specifying the pattern that, when matched, causes the event to be discarded 
and to be no longer available to any of the modules.

Table 13-18 Filter Events Module Properties  (continued)

Field Description
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References
References 
The References tab, for policies, module resources, and signatures, lists which host sensor uses 
the policy, which policy uses the resource, or which resource uses signature. 

Adding Signatures to a Resource Definition
Signatures are used to expand the detection abilities of Host Sensor. By default, all resources 
defined within a Host Sensor policy are monitored for the activity you specify (for example, 
permission changes, and MD5 hash changes). This monitoring can be greatly enhanced by 
defining signatures to scan a specified file for a specific signature pattern. If the pattern is found, 
an event is generated.

Creating signatures that accurately identify the various attacks, probes, misuse, and other sought 
data located on the host without false positives and negatives can be complicated. Extreme 
Networks IPS administrators who want to produce their own signatures should have a firm 
understanding of the information that can be discerned and the conclusions that can be reached 
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Adding Signatures to a Resource Definition
from observing file access and content. One or more signatures are associated with each Resource. 
These signatures indicate attack pattern matches used to determine if events should be generated. 

To configure signature settings:

1. Under Resources, choose the appropriate resource.

2. In the Host Signatures section, click Create to create a new signature or Add to add an 
existing signature. 

If you click Create, the Create New Host Signature window opens. 

If you click Add, the Add Existing Host Signatures window opens. Select a signature and 
click Add. The signature is added to the Host Signatures list. 

3. Set the parameters on the Basic tab as appropriate. See Table 13-19.

For an existing signatures, you can set the parameters on the Basic tab in the Host Signatures 
section. 

Note: Live Update will not update an edited master policy signature. 
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Adding Signatures to a Resource Definition
4. On the Search Clauses tab, click Add. 

If you specify more than one search clause, they are treated as AND clauses, meaning that all 
of them must match for the signature to be generated.

Table 13-19 Host Signature Properties General Settings Tab Parameters 

Field Description

Signature Name Signature names can be up to 255 characters long. A signature name can contain any combination 
of alphanumeric characters, dashes, and colons. The convention used for signature names is to 
specify at least two fields, with the first two fields separated by a colon (:). The first field indicates the 
highest-layer protocol affected by the exploit/vulnerability. The second field indicates the specific 
application that is affected. All following fields are separated by a dash (-).

SIP Field Override 
Value / DIP Field 
Override Value

If desired, enter a record field number in the SIP and/or DIP Field Override Value fields. These 
values are used to override the default Source and Destination IP Address fields. This is a 
convenient way of dealing with records where the Source or Destination IP information is not located 
at a fixed position within the record. To compensate for this, a SIP or DIP location can be tied to a 
signature such that if the signature matches, the IP address is parsed based on the location 
specified in the Override SIP or DIP. 

The field number can be specified in one of three different formats:

• If the field number is preceded by a percent sign (for example, %2), the field number is relative to 
the Record Format defined. For example, %2 indicates that the record should be parsed based 
on the defined record format and that the second field represents the SIP (or DIP). 

• If the field number is preceded by a pound sign (for example, #2), the Host Sensor will 
intelligently parse the record looking for IP addresses in a dotted quad (for example, 
123.123.123.123) format. For example, #2 indicates that the second occurrence of an IP address 
in the record should be used as the SIP( or DIP).

• If a field number is listed without any preceding character (for example, 2), the Host Sensor is 
forced to parse the record, treating space characters as field separators. For example, 2 indicates 
that the second space separated field should be used for the SIP (or DIP).

Event Name Override 
Value

Enter a record field number if you want overwrite the event name generated by the signature with 
the contents of that field. This is used to rapidly integrate with third party security vendors without 
having to update signature libraries.

Record Format 
Override Value 

Provides the ability to override on a per signature basis the default record format specified as part of 
the resource definition. This is a convenient way of dealing with records where the record formats 
are not consistent for each record within the resource. To compensate for this, a record format can 
be tied to a signature such that prior to analyzing the signature, the record is parsed based on the 
override format specified. The values for this override field are the same as the Record Format entry 
values described “Record Format Tokens” on page 13-31.
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Adding Signatures to a Resource Definition
5. Select the desired case sensitivity setting. Search strings can be case insensitive for the 
printable character range. For example, most web servers will respond to ‘GET’ requests as 
well as ‘get’ requests. Host sensor could use two different rules to search for this, but there is a 
better way. By selecting Case Insensitive, the host sensor will search for all cases of the string 
regardless of upper or lower case characters.

To use binary comparison, select Case Sensitive. This will search for an exact match of the 
search string.

6. Set the parameters as appropriate. See Table 13-20.

Table 13-20 Search Clause Editor Parameters

Field Description

Field Location Indicates, relative to the Record Format, the field number in which the pattern matching analysis should 
occur. If the Field Number is omitted, the Search String is assumed to be in the first field within the log 
record.

Field Type Indicates the type of data contained in the field — String, Number, or Regular Expression.

Operator Choose an operator from the drop-down list. The comparison operator is used to indicate the type of pattern 
matching that should occur for the Field Type specified. If the Comparison Operator is omitted, the Host 
Sensor defaults to performing a string comparison (Contains value). The available comparison operators by 
type are:

• String—Contains value (positive match)

• String—Does not contain value (negative match)

• Regular Expression—Matches all 

• Regular Expression—Matches anywhere 

• Number—Equals 

• Number—Not equal to 

• Number—Greater than 

• Number—Less than 
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Record Format Tokens
7. Click Create to add the search clause to the signature.

Record Format Tokens
A record format can be specified to parse each record in the specified file into distinct fields. This 
is useful when building signatures that need to search the record for a pattern that is likely to be 
duplicated. For example, searching for an error code of “404” in the Apache access_log may 
incorrectly match other data within the record. The record can be parsed into fields to specifically 
search the error code field for “404”. If no record format is given, the entire record is treated as one 
large field (for example, defaults to %E).

A number can also be specified preceding the string token (%s) to specify a field width. The 
number of bytes specified will be parsed unless a new line or end of string is encountered prior to 
reaching the number of bytes. Trailing space characters remain unparsed unless they occur within 
the specified field width.

Table 13-21 defines the tokens that can be used in record formats.

Search Strings Enter one or more search strings (pattern) elements by typing in the “Add” row, then clicking the Add button. 

If more than one search string element is added to a matching rule, it is treated as an OR condition when 
processing the Search Clause. A match occurs if the string is encountered.

Strings are constructed using the / (slash) character as an escape character to specify two alphanumeric 
values which represent a hex number. Strings may also include wildcard characters. The hex ASCII code 
for - (dash) is 0x2d. To search for a / character, use the hex value for / which is 0x2f. 

For quick reference, wild card hex values and meanings are as follows:

• ? — 0x3f — matches any byte

• * — 0x2a — matches any printable character

• $ — 0x24 — matches non-printable character

• # — 0x23 — matches any number

Table 13-20 Search Clause Editor Parameters

Field Description

Table 13-21 Record Format Tokens 

Description Token

Variable length string terminated by space (‘ABC’). Trailing space (and any subsequent spaces) is discarded. %s

Variable length string terminated by a colon (‘ABC DEF:’). Trailing colon (and any subsequent spaces) is discarded. %C

Variable length string terminated by new line (‘ABC DEF\n’). Trailing new line is discarded. This token can be useful 
to describe an entire record as one large field when individual field parsing is not necessary.

%E

Variable length string enclosed with quotes (‘“ABC DEF”’). Leading and trailing quote (and any subsequent spaces) 
is discarded. Please note that previously the leading quote was included in the parsed field.

%Q

Variable length string enclosed with brackets (‘[ABC DEF]’). Leading left bracket is omitted from the parsed field. 
Trailing right bracket (and any subsequent spaces) are discarded.

%B

Variable length string enclosed with parenthesis ('(ABC DEF)'). Leading and trailing right parenthesis (and any 
subsequent spaces) are discarded.

%P

Variable length numeric value (terminated by space or first nonnumeric character). %n
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Using the %i Token
Using the %i Token
When using the %i token within a Record Format field of a File resource, you will need to define a 
separate field for the character or characters that immediately follow the IP address in order to 
ensure that the record format is parsed correctly.

For example, assume that the following line represents the format of lines within a file that is 
being monitored:

172.26.53.144, -, 11/27/2007, 0:00:42, W3SVC1, IntWeb1, 172.26.53.141, 500, 365, 
567, 302, 0, GET, /DesktopDefault.aspx, tabid=2,

The commas that immediately follow the two IP address fields must be defined as separate fields 
or the field count will be off by two, causing the event field matching to be off, and therefore, the 
signature will not be generated.

For the above example, if you wanted a signature to trigger on the “DesktopDefault” string, you 
would configure the following Resource values:

Record Format: %i%s%s%s%s%s%s%i%E

Data Fields: %1%2%3%4%5%6%7%8%9

SIP: %1

DIP: %8

Sig Search String: field = 9
type = string
string = DesktopDefault

This is how the Record Format would be parsed by the Host Sensor:

%i: 172.26.53.144

%s: ,

%s: -,

%s: 11/27/2007,

%s: 0:00:42,

%s: -W3SVC1,

%s: IntWeb1,

%i: 172.26.53.141

IP address in dotted quad format (for example, 127.0.0.1). Any space or non-numeric character immediately 
following the IP address must be defined as a separate field. See “Using the %i Token” below for more information.

%i

Military Time (HH:MM:SS). %T

Military Date/Time (Mon DD %T) (May 7 12:12:53). %t

Fixed length string (for example, 40 bytes). %40s

1 byte (similar to %1s). %c

Table 13-21 Record Format Tokens  (continued)

Description Token
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Named Fields
%E: , 500, 365, 567, 302, 0, GET, /DesktopDefault.aspx, tabid=2,

Note that the example uses %E to indicate “rest of the line” for simplicity.

Named Fields
You can use named fields when configuring Log File resource Record Formats and Data Fields 
and resource signature Override fields. By using named fields, specified in brackets in the Record 
Format, the fields in Record Formats can move around and the Host Sensor will still know which 
field to parse in the appropriate manner. Therefore, signatures will not have to be rewritten or 
modified each time the log file format changes. In addition, signatures will become more human-
readable.

For example, without named fields, to describe this log file string:

Oct 24 12:57:00 windsor 134.141.133.161 1.2.3.4 app2[8989]: Log message goes 
here

this Record Format would be constructed:

%t%s%i%i%C%E

and the corresponding Data Field might be:

%1%2%3%4%5%6

Signatures would be written specifying these field numbers where:

If the application starts logging additional information, such as ports, the Record Format, Data 
Fields, and signatures would have to be rewritten.

If you use named fields, the Record Format for the same log file string becomes this:

%t[time]%s[host]%i[srcIP]%i[dstIP]%C[appname]%E[message]

Data Fields can then use brackets to separate the field names, much as the percent sign (%) has 
been used as a delimiter. Using the above named fields in the Record Format, the Data Field could 
be configured as:

[host][srcIP][dstIP][appname][message]

The following data fields are formed:

Record Data Field Signature Data

%t %1 Oct 24 12:57:00

%s %2 windsor

%i %3 134.141.133.161

%i %4 1.2.3.4

%C %5 app2[8989]

%E %6 Log message goes here

Record Data Field Signature Data

%t time Oct 24 12:57:00
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HostSensor_Linux_DSM Master Policy
Signatures can be written using the named data fields in the Override Value fields and as the field 
location in the search clause.

When log file formats change, only the Record Format needs to be updated to take into account 
new fields. Old signatures will continue to work without modification because the named fields 
still exist.

HostSensor_Linux_DSM Master Policy
The HostSensor_Linux_DSM master policy contains signatures to track changes to the jboss.log 
file and netcfgserver.log file on the EMS. 

• The jboss.log file contains entries regarding every change made in the EMS database, every 
operation executed (such as deploy/start/stop), information about Live Updates, database 
backups, client logon histories, and error conditions that may arise on the EMS server. 

• The netcfgserver.log file contains log messages from the Configuration Channel. The 
Configuration Channel provides communication between the EMS and managed devices such 
as sensors and EFPs. The Configuration Channel is used to push policies configured on the 
EMS to managed devices.

In addition to providing the HostSensor_Linux_DSM master policy, Extreme Networks IPS also 
ships with an Alarmtool policy, Alarmtool_DSM, that can be used to send alarm notifications 
when the events identified by the HostSensor_Linux_DSM occur.

Alarmtool_DSM contains pre-defined event resource croups for each type of signature defined in 
the HostSensor_Linux_DSM Log Detection Module, pre-defined notification rules for the Event 
Channel and Live Update event groups, and predefined alarms using the pre-defined notification 
rules.

%s host windsor

%i srcIP 134.141.133.161

%i dstIP 1.2.3.4

%C appname app2[8989]

%E message Log message goes here

Note: The %i Record Format supports both IPv4 and IPv6.

Record Data Field Signature Data
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14
Alarmtool Policy Configuration

This chapter describes how to configure Alarmtool custom policies and modify master policies. 

For information on configuring syslog-ng to send alarm notifications to a SIEM, refer to Achieving 
a Higher Rate of Alarmtool Notifications Using Syslog-ng, available from
www.extremenetworks.com/support/enterasys-support/.

Alarmtool Overview
Alarmtool runs on the Linux platform only. 

Alarmtool sends a notification (that is, an alarm) when the sensor detects an anomaly. The type of 
notification and conditions for notification are configurable by means of Alarmtool policies. The 
basic notification types include email, flat file logs, the UNIX syslog facility, OPSEC SAM 
responses, SNMP traps (both versions 1 and 3), and the execution of external binaries/scripts. 

You can make an alarm more specific by creating and assigning time periods for the notification 
rules, filters, event resource groups, and thresholds. 

When you associate an Alarmtool agent to a device node, the Alarmtool’s default policy is 
automatically associated with that instance of the agent. 

Alarmtool policies provide a quick and easy method to configure alarms. Special configurations of 
interest, such as configuring the Alarmtool to work with NetSight ASM, are provided in the 
Default master policy. 

For information about... Refer to page...
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Alarmtool Overview
You can create custom Alarmtool policies, as described in this chapter, and apply them to 
individual Alarmtool agents as described in “Configuring the Alarmtool Agent Policy” on 
page 11-3.

Distributed IPS Configuration
You can configure Alarmtool to use NetSight Automated Security Manager (ASM) for Distributed 
IPS. Extreme Networks IPS can detect the occurrence of specific user-defined events, and 
automatically send a trap to NetSight ASM using an encrypted communication channel. NetSight 
ASM can then be configured to take an action such as disabling the offending user’s port or 
assigning the user to the quarantine policy role. This allows enterprises to dramatically shorten 
the time it takes to respond to and contain the latest Internet security threats. 

Refer to Chapter 15, ”Using Alarmtool with NetSight ASM” for Alarmtool and NetSight ASM 
configuration. 

Events Retrieved
Each event retrieved from the ring buffer is tested against each alarm definition. Events are 
matched based on event name, time period, and other criteria. The event matches if the event 
name is listed in the event group associated with the alarm, or if there is no event group defined 
for the alarm. The events are also compared with the alarm’s filter expressions and thresholds. 
Once an event is determined to match an alarm, the notification methods defined for the alarm are 
executed. 

Alarm Types
Alarms can be real-time, summary, or dynamic. 

• Real-time—Alarm notification methods are executed immediately when an alarm is triggered. 

• Summary—Alarm methods are only executed at a defined interval. 

• Dynamic—Alarm switches between real-time and summary, based on alarm frequency. 
Dynamic alarms use the following logic to switch between real-time and summary modes: 

– All dynamic alarms are initially real-time alarms. Upon the first event match, a real-time 
notification is performed and the alarm is set to summary mode. An alarm continues in 
summary mode until there are no matching events within a single summary interval, at 
which time it converts back to real-time mode.

– Summary information is always accumulated for summary and dynamic alarms. For 
summary alarms, a copy of each event is stored in memory until it can be processed at the 
next summary interval. This can be memory intensive, but is released each time a 
summary report is generated. All notification methods may be configured to issue 
summary alarms, except for user-defined methods. 

Notification Methods
You can associate multiple notification methods with an alarm. 

• Mail (page 14-8) 

• User (page 14-9) 

• Log (page 14-9)
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Creating an Alarmtool Policy
• Syslog (page 14-10)

• SNMP Version 1 (page 14-11)

• SNMP Version 3 (page 14-12)

• NetSight ASM (page 14-13)

• OPSEC SAM (page 14-13)

Each notification method may have an optional time period specified with it. If a time period is 
included in the notification definition then different notifications methods can be used depending 
on the time and day of the week. 

Alarm Components
Each alarm is a selection of event resource groups, filters, thresholds, and notification rules. You 
can create the alarm components first or create them as you create the alarm.

• Notification rules—See Configuring Notification Rules (page 14-7).

• Time periods—See Configuring Time Periods (page 14-18).

• Event resource groups—See Configuring Event Resource Groups (page 14-20).

• Alarm filters—See Configuring Filters (page 14-21).

• Thresholds—See Configuring Thresholds (page 14-24).

Master Alarmtool Policies
Extreme IPS includes the following master Alarmtool policies:

• Alarmtool_DSM—This master policy, which includes pre-defined notification rules for the 
event channel and live update event groups and pre-defined alarms using the pre-defined 
notification rules, is designed for use with the HostSensor_Linux_DSM host sensor policy, 
which monitors the jboss.log file and the netcfgserver.log file and events occurring on the 
EMS.

Refer to Chapter 13, ”Host Sensor Policy Configuration” for more information about 
HostSensor_Linux_DSM.

• Default—This master policy contains samples and examples of Alarmtool components. 

Creating an Alarmtool Policy
An Alarmtool policy comprises alarms and associated components: notification rules, filters, 
thresholds, and event resources. 

At the very least, you must create and assign a notification rule to an alarm to make the alarm 
functional.

To create an Alarmtool policy:

1. From the Configuration menu, select Alarmtool Policies.

2. In the Alarmtool Policies view, click the Create button and select Create Policy. 
The Create Policy window opens. 
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Creating an Alarmtool Policy
3. In the Policy Name field, enter a unique name for the Alarmtool policy.
4. In the Alarm Name field, enter a unique name for the alarm.
5. In the Type field, choose the type for the Alarmtool policy.
6. (Optional) Set the value for the summary interval.
7. (Optional) In the Event Resource field, select an event resource group from the drop down 

menu. 
To create an event resource, click the ellipsis button to the right of drop down menu. For 
information on creating an event resource, see Configuring Event Resource Groups on 
page 14-20.

8. (Optional) In the Filter field, select a filter from the drop down menu.
To create a filter, click the ellipsis button to the right of drop down menu. For information on 
creating a filter, see Configuring Filters on page 14-21.

9. (Optional) In the Threshold field, select a threshold from the drop down menu.
To create a threshold, click the ellipsis button to the right of drop down menu. For information 
on creating a threshold, see Configuring Thresholds on page 14-24.

10. Create or add a notification rule. 
For information on creating a notification rule, see “Creating Notification Rules” on page 14-7.

To add a notification rule:

a. Click Add Notification.

b. In the Notifications Available window, select the appropriate notification rule. 

c. Click Add. 

11. Click Create. 
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Creating Alarms
The Alarmtool policy and the alarm are added to the list of policies and alarms on the left side 
of the view.

Creating Alarms
You can add alarms to master and custom alarm policies. 

At the very least, you must create and assign a notification rule to an alarm to make the alarm 
functional. You can also create event group resources, filters, and thresholds to assign to the alarm. 
You can create these components from the Create Alarm window or you can create them 
separately.

1. Select a master policy or custom policy.

2. Right-click the policy and select Create Alarm. 

The Create Alarm window opens.
Extreme Networks Intrusion Prevention System Configuration Guide 14-5



Creating Alarms
3. Set the parameters, as described in the Table 14-1.

4. Click OK. 

Table 14-1 Alarm Parameters 

Fields Description

Alarm Name The name of the alarm.

Type The alarm type:

• dynamic—Alarms intelligently switch between real time and summary, 
based on alarm frequency. Refer to “Alarm Types” on page 14-2 for 
information about dynamic alarms.

• summary—Alarms are only executed at the Summary Interval. 

• realtime—Alarms are executed immediately when an alarm is triggered.

Summary Interval The period, in seconds, in which events are collected and summarized 
before the cache is reset. For use with summary and dynamic alarms.

Event Resource Select or create an event resource. If None is selected, Alarmtool will use 
all events. See “Configuring Event Resource Groups” on page 14-20 for 
more information.

Filter (Optional) Select or create a filter for this alarm. See “Configuring Filters” on 
page 14-21 for more information.

Threshold (Optional) Select or create a threshold for this alarm. See “Configuring 
Thresholds” on page 14-24 for more information. 

Notification Rules Create or add at least one notification rule. See “Configuring Notification 
Rules” on page 14-7 for more information. 
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Configuring Notification Rules
The new alarm is added to the Alarmtool policy.

Configuring Notification Rules
Notification rules define how an alarm is sent (email, page, SNMP). You also select the time period 
that defines the times when a notification rule is active. A typical example is an email notification 
rule that is active after hours, and a pager notification rule that is active during work hours.

Creating Notification Rules
To create a notification rule: 

1. Click on the Notification Rules tab.

2. Click Create.

3. In the Notification Rule Editor, enter a name for the notification rule. 

4. Optionally, select the time period for which the rule applies. For information on creating a 
time period, see “Configuring Time Periods” on page 14-18.

5. Click OK. 
The new notification rule is added to the Notification Rules list.

6. Add a notification method to the notification rule. 
a. Select the notification rule in the Notification Rules list. 

b. Select the heading of the appropriate notification method. 

For more information about notification methods, see “Notification Methods” on 
page 14-8.

c. Click Create [Method] Rule.

d. In the [method] Editor window, set the parameters. 
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For information about notification message variables, see “Notification Message 
Variables” on page 14-14.

e. Click OK. 

Deleting Notification Rules
To delete a notification rule:

1. Select the notification rule that you want to delete.

2. Click Delete.
3. In the confirmation dialog box, click Yes.

Notification Methods
For every notification rule, you can configure one or more notification methods: 

• Mail (page 14-8) 

• User (page 14-9) 

• Log (page 14-9)

• Syslog (page 14-10)

• SNMP Version 1 (page 14-11)

• SNMP Version 3 (page 14-12)

• NetSight ASM (page 14-13)

• OPSEC SAM (page 14-13)

Mail
The Mail notification method allows you to define an email that will be sent by an alarm. Table 14-
2 describes the Mail notification method parameters.

For more information about configuring an Extreme Networks IPS appliance to send email 
alarms, refer to Setting Up an Extreme Networks IPS Appliance to Send Email, available from 
www.extremenetworks.com/support/enterasys-support/.

Table 14-2 Mail Notification Method Parameters 

Field Description

Summary Type Defines how much information to send. There are three types:

• short outputs only a count of the events. This is suitable for pagers.

• long shows every event.

• basic shows each unique event, along with a count for the number of 
times it occurred.

To Defines the email address to whom the Alarm is to be sent.

Subject (Optional) Defines the email subject line. You can use message variables in 
conjunction with plain text.

See Table 14-8 on page 14-14 and Table 14-9 on page 14-15.
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User
The User notification method allows you to configure a user defined action (for example, execute a 
script or run an application) that will be executed by an Alarm. Table 14-3 describes the User 
notification method parameters.

Example
This command string would launch the aclch.pl perl script, passing the six variables SIP, DIP, 
SPORT, DPORT, PROTO, and SENSOR.

/usr/dragon/aclch.pl %SIP% %DIP% %SPORT% %DPORT% %PROTO% %SENSOR%

Log
The Log notification method specifies a flat file to which alarm information should be written by 
an Alarm. Table 14-4 describes the Log notification method parameters.

Type (Optional) Defines the message type:

• Dragon Event — Legacy default message type

• LEEF — For sending syslog-ng to SIEM. 

• CEF — For use with ArcSight devices. 

• Custom — Format that you can customize with Dragon Event, LEEF, or 
CEF variables.

See Notification Message Variables on page 14-14 and “Default Message 
Formats and Examples” on page 14-17.

Format (Optional) Defines the email body. 

If you select a Type value, the Format field is populated with the applicable 
variables for the selected Type value. For variable descriptions, click the 
Legend button. 

For each message format, you must include the appropriate format 
identifier (i.e., Dragon Event:, LEEF:, CEF:) and delimiters (i.e., double 
commas (,,), vertical line (|), or a space).

The Custom format is read/write. You can use message variables in 
conjunction with plain text.

Also, see Notification Message Variables on page 14-14.

If you do not select a Type value and you enter any text in this field, 
Extreme Networks IPS will use the default message format (see “Default 
Message Formats and Examples” on page 14-17).

Table 14-2 Mail Notification Method Parameters  (continued)

Field Description

Table 14-3 User Notification Method Parameters

Field Description

Exec Enter a string defining an action to be taken and any variables to be passed 
to the application or script. See the example below.

Wait Time Defines how long in seconds to wait on the process to complete before 
returning an error.
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Syslog
The Syslog notification method writes alarm information to a syslog on your Linux/UNIX server. 
For example, if you configured Alarmtool to write alarms to the cron syslog, Extreme Networks 
IPS would append alarms to the /var/log/cron syslog file. 

Table 14-5 describes the Syslog parameters.

Table 14-4 Log Notification Method Parameters 

Field Description

Filename Defines the path and filename for Extreme Networks IPS to write alarm 
information to. If the file does not exist, Extreme Networks IPS will create it. 

Example: /home/dragon/suspicious_alarms

Type (Optional) Defines the message type:

• Dragon Event—Legacy default message type

• LEEF—For sending syslog-ng to SIEM. 

• CEF—For use with ArcSight devices. 

• Custom—Format that you can customize with Dragon Event, LEEF, or 
CEF variables.

See Notification Message Variables on page 14-14 and “Default Message 
Formats and Examples” on page 14-17.

Format (Optional) Defines the email body. 

If you select a Type value, the Format field is populated with the applicable 
variables for the selected Type value. For variable descriptions, click the 
Legend button. 

For each message format, you must include the appropriate format 
identifier (i.e., Dragon Event:, LEEF:, CEF:) and delimiters (i.e., double 
commas (,,), vertical line (|), or a space).

The Custom format is read/write. You can use message variables in 
conjunction with plain text. 

Also, see Notification Message Variables on page 14-14.

If you do not select a Type value and you enter any text in this field, 
Extreme Networks IPS will use the default message format (see “Default 
Message Formats and Examples” on page 14-17).

Table 14-5 Syslog Notification Method Parameters 

Field Description

Facility Defines which syslog Extreme Networks IPS will write alerts to. Options are 
auth, cron, daemon, kern, local[0-7], lpr, mail, news, syslog, user, and uucp.

Level The severity level. Options are emerg, alert, crit, err, warning, notice, info, 
and debug
14-10 Alarmtool Policy Configuration



Configuring Notification Rules
SNMP Version 1
The SNMP V1 notification method allows you to configure Alarmtool to send alarms using SNMP 
Version 1 traps. Table 14-6 describes the SNMPv1 parameters. 

Type (Optional) Defines the message type:

• Dragon Event—Legacy default message type

• LEEF—For sending syslog-ng to SIEM. 

• CEF—For use with ArcSight devices. 

• Custom—Format that you can customize with Dragon Event, LEEF, or 
CEF variables.

See Notification Message Variables on page 14-14 and “Default Message 
Formats and Examples” on page 14-17.

Format (Optional) Defines the email body. 

If you select a Type value, the Format field is populated with the applicable 
variables for the selected Type value. For variable descriptions, click the 
Legend button. 

For each message format, you must include the appropriate format 
identifier (i.e., Dragon Event:, LEEF:, CEF:) and delimiters (i.e., double 
commas (,,), vertical line (|), or a space).

The Custom format is read/write. You can use message variables in 
conjunction with plain text. 

Also, see Notification Message Variables on page 14-14.

If you do not select a Type value and you enter any text in this field, 
Extreme Networks IPS will use the default message format (see “Default 
Message Formats and Examples” on page 14-17).

Table 14-5 Syslog Notification Method Parameters  (continued)

Field Description

Table 14-6 SNMPv1 Notification Method Parameters 

Field Description

Transport Switch between UDP and TCP communication. Default is UDP.

Server IP address of a listening SNMP management station. An example would be 
a PC running NetSight ASM Server.

Port Listening port of destination device, typically port 162.

OID OID of the trap to be sent.

Agent IP address of sending interface.

Trap Type Use 6 for enterprise trap.

Specific Type Specific type of OID for trap

Community Community name of SNMP device.
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SNMP Version 3 
The SNMP V3 notification method allows you to configure Alarmtool to send alarms using SNMP 
Version 3 traps. Table 14-7 describes the SNMPv3 parameters. 

Type (Optional) Defines the message type:

• Dragon Event—Legacy default message type

• LEEF—For sending syslog-ng to SIEM. 

• CEF—For use with ArcSight devices. 

• Custom—Format that you can customize with Dragon Event, LEEF, or 
CEF variables.

See Notification Message Variables on page 14-14 and “Default Message 
Formats and Examples” on page 14-17.

Format (Optional) Defines the email body. 

If you select a Type value, the Format field is populated with the applicable 
variables for the selected Type value. For variable descriptions, click the 
Legend button. 

For each message format, you must include the appropriate format 
identifier (i.e., Dragon Event:, LEEF:, CEF:) and delimiters (i.e., double 
commas (,,), vertical line (|), or a space).

The Custom format is read/write. You can use message variables in 
conjunction with plain text. 

Also, see Notification Message Variables on page 14-14.

If you do not select a Type value and you enter any text in this field, 
Extreme Networks IPS will use the default message format (see “Default 
Message Formats and Examples” on page 14-17).

Table 14-6 SNMPv1 Notification Method Parameters  (continued)

Field Description

Table 14-7 SNMPv3 Notification Method Parameters 

Field Description

Transport Switch between UDP and TCP communication. Default is UDP.

Server IP address of a listening SNMP device. An example would be a PC running 
NetSight ASM Server. 

Port Listening port of destination device, typically port 162. 

OID OID of the trap to be sent. 

Inform If selected, the Extreme Networks IPS middleware automatically generates 
the Security Engine, Context Name, and the Context Engine.

Security Name User ID used for authentication. 

Security Engine

(See the Inform keyword)

Value associated with security-name in SNMP configuration. 

Minimum: 1

Maximum: 0x7FFFFFFFFFFFFFFF 
14-12 Alarmtool Policy Configuration



Configuring Notification Rules
NetSight ASM
Also known as Distributed IPS. This notification method configures Alarmtool to send alarms to 
NetSight ASM for dynamic response to attacks. To configure Alarmtool to use NetSight 
Automated Security Manager, refer to Chapter 15, ”Using Alarmtool with NetSight ASM”.

OPSEC SAM
Defines Alarmtool’s interaction with Checkpoint Firewall SAM facilities for dynamic response to 
attacks. To configure Alarmtool to use OPSEC, refer to Chapter 16, ”Using Alarmtool with Check 
Point Firewalls”.

Context Name

(See the Inform keyword)

No limit.

Context Engine

(See the Inform keyword)

Minimum: 1

Maximum: 0x7FFFFFFFFFFFFFFF 

Auth Protocol Authentication protocol: MD5 or SHA

Auth Password Password for security-name

Priv Protocol Encryption protocol: DES

Priv Password Hash key for DES

Type (Optional) Defines the message type:

• Dragon Event—Legacy default message type

• LEEF—For sending syslog-ng to SIEM. 

• CEF—For use with ArcSight devices. 

• Custom—Format that you can customize with Dragon Event, LEEF, or 
CEF variables.

See Notification Message Variables on page 14-14 and “Default Message 
Formats and Examples” on page 14-17.

Format (Optional) Defines the email body. 

If you select a Type value, the Format field is populated with the applicable 
variables for the selected Type value. For variable descriptions, click the 
Legend button. 

For each message format, you must include the appropriate format 
identifier (i.e., Dragon Event:, LEEF:, CEF:) and delimiters (i.e., double 
commas (,,), vertical line (|), or a space).

The Custom format is read/write. You can use message variables in 
conjunction with plain text. 

Also, see Notification Message Variables on page 14-14.

If you do not select a Type value and you enter any text in this field, 
Extreme Networks IPS will use the default message format (see “Default 
Message Formats and Examples” on page 14-17).

Table 14-7 SNMPv3 Notification Method Parameters  (continued)

Field Description
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Notification Message Variables
When you configure a notification method that contains a “Subject” or “Message” field, you can 
use message variables in place of, or in conjunction with, plain text. 

Message variables are strings that are replaced by information about the event (or summary) 
when a notification is sent. The replacement strings (variables) are different for real-time alarms 
and summary alarms because the information known at notification time is different. 

You can display all the possible message variables by clicking the Legend button in the upper 
right corner of the Notification Rules tab. The Message Format Legend window displays the real-
time alarm variables, summary alarm variables, LEEF variables, and CEF variables on separate 
tabs. 

Table 14-8 lists the variables for real-time alarms. 

Table 14-9 lists the summary alarm variables. 

Table 14-8 Real-Time Alarm Variables 

Real-Time Variable Description

%ALERT% Name of the alarm defined in Alarmtool.

%BINDATA% Binary event data with no ASCII substitution

%DATA% Event specific data such as a file name for a HIDS event. 

%DATE% The date recorded with the event (format YYYY-MM-DD). 

%DIP% Destination IP address recorded with the event. 

%DIR% Direction indicator recorded with the event. 

• I = Internal. Both the source and destination IPs are in the Protected 
Network(s)

• E = External. Neither the source nor destination IPs are in the Protected 
Network(s)

• T = To. The packet is destined to an IP in a Protected Network

• F = From. The packet is sent from an IP in a Protected Network

%GUID% Globally unique ID for the event type.

%DPORT% Destination port number recorded with the event. 

%NAME% Event name(s) that caused the event (multiple names concatenated with 
“+”). 

%PDATA% Event data from an Extreme Networks IPS event with non printable 
characters replace with dots “.”.

%PROTO% Protocol number recorded with the event. 

%SENSOR% Name of the sensor that generated the event. 

%SIP% Source IP address recorded with the event. 

%SPORT% Source port number recorded with the event. 

%TIME% The time recorded with the event (format HH:MM:SS). 
14-14 Alarmtool Policy Configuration



Configuring Notification Rules
Table 14-10 lists the LEEF variables. 

Table 14-9 Summary Alarm Variables

Summary Variable Description

%ALERT% Name of the alarm defined in Alarmtool.

%COUNT% The number of times the Alarm occurred in the summary interval.

%DATE% Current date (format YYYY-MM-DD).

%DURATION% Length in seconds for the summary interval.

%ENDDATE% Ending date for the summary interval (format YYYY-MM-DD).

%ENDTIME% Ending time for the summary interval (format HH:MM:SS).

%STARTDATE% Beginning date for the summary interval (format YYYY-MM-DD).

%STARTTIME% Beginning time for the summary interval (format HH:MM:SS).

%TIME% Current time (format HH:MM:SS).

Table 14-10 LEEF Variables 

LEEF Variable Description

LEEF:Version=<int> Mandatory. Identifies format as Log Event Extended Format. You must 
specify the LEEF version number. 

Product Mandatory. String identifying the product sending the event log. The 
Vendor/Product pair must be unique. 

ProductVersion Mandatory. String identifying the version of the device or application in the 
format <Extreme Networks IPS release number>.<build number>

Vendor Mandatory. String identifying the vendor of the device or application 
sending the event log. 

Version Mandatory. Integer identifying the version of LEEF used for the log 
message. 

devTime Time the device or application emitted the event.

direction Direction indicator recorded with the event. 

• I — Internal

• X — External

• T — To protected net

• F — From protected net

dst IPv4 or IPv6 destination address

dstPort Integer port value of destination port. Valid port numbers are 0–65535.

eventData Event-specific data such as a file name for a HIDS event or packet length in 
NIDS event.

eventID Mandatory. Unique ID that identifies the event. In Dragon alert, the event 
name is used as eventID. 

proto Integer representation of the transport protocol.
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Table 14-11 lists the CEF variables.

sensor Qualified name of an Extreme Networks IPS virtual sensor. 

src IPv4 or IPv6 source address

srcPort Integer port value of source port. Valid port numbers are 0–65535.

Table 14-11 CEF Variables 

CEF Variable Description

CEF:Version=<int> Mandatory. Identifies format as Common Event Format. You must specify 
the CEF version number. 

Device Product Mandatory. String identifying the product sending the event log. The 
Vendor/Product pair must be unique. 

Device Vendor Mandatory. String identifying the vendor of the device or application 
sending the event log. 

Device Version Mandatory. String identifying the version of the device or application in the 
format <Extreme Networks IPS release number>.<build number>

Name Mandatory. Unique name that identifies the event. In Dragon alert, the 
event name is used as eventID.

Severity A number from 0–10 used to reflect the importance of the event.

SignatureId Unique integer value identifying the event from all other events. Dragon 
does not have a numerical ID. 

cs1 The Cs1-supplied unique ID string used in reporting HTTP-based 
singleEvent API, in the following format:

?uuid=<uuid string>

cs1Label Cs1-supplied string used in reporting HTTP-based singleEvent API. 

deviceDirection Direction indicator recorded with the event. 

• I—Internal

• X—External

• T—To protected net

• F—From protected net

dpt Integer port value of destination port. Valid port numbers are 0–65535.

dst IPv4 or IPv6 destination address

dvchost Qualified name of an Extreme Networks IPS virtual sensor. 

end Time the event-specific activity ended. Typically end-of-session time is 
expected. 

proto Integer representation of the IP protocol (UDP, TCP, ICMP, etc.)

rt Time the device or application emitted the event.

sensor Qualified name of an Extreme Networks IPS virtual sensor. 

Table 14-10 LEEF Variables  (continued)

LEEF Variable Description
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Default Message Formats and Examples

Dragon Event

Format
Dragon Event: %DATE%,,%TIME%,,%NAME%,,%SENSOR%,,%PROTO%,,%SIP%,, 
%DIP%,,%SPORT%,,%DPORT%,,%DIR%,,%DATA%,,%PDATA%

Example
2011-05-09,,14:43:24,,FRAG-LARGE,,Ether0,,1,,10.20.117.80,,10.20.117.14,,0,,0,,I,,protocol = icmp, id 
= 38230, off = 740, IF = eth0

LEEF

Format
LEEF:Version=1.0|Vendor|Product|ProductVersion|eventID|devTime|proto|src|sensor|dst|src
Port|dstPort|direction|eventData

Example
LEEF:1.0|Enterasys Networks|Dragon|7.4.2.154|FRAG-LARGE|devTime=May 09 2011 
10:44:52|proto=1|src=10.20.117.80|sensor=Ether0|dst=10.20.117.14|srcPort=0|dstPort=0|direction
=I|eventData=protocol = icmp, id = 52787, off = 740, IF = eth0

CEF

Format
CEF:Version|Device Vendor|Device Product|Device Version|Signature 
ID|Name|Severity|start|rt|proto|src|dst|dvchost|spt|dpt|deviceDirection|cs1|cs1Label

Example
CEF:0|Enterasys Networks|Dragon|7.4.2.162|FRAG-LARGE|FRAG-LARGE|2|rt=May 17 2011 
12:22:42 proto=1 src=10.20.117.14 dst=134.141.90.182 dvchost=VS-1 deviceDirection=0 
cs1=?uuid\=93a7cf20-f44e-11e0-8ff7-0019b9f999ec cs1Label=singleevent web interface parameter

Summary Alarm Format
%DATE% %TIME% Alert %ALERT% occurred %COUNT% times in the past %DURATION% 
seconds.

spt Integer port value of source port. Valid port numbers are 0–65535.

src IPv4 or IPv6 source address

start Time the event-specific activity started. Typically start-of-session time is 
expected. 

Table 14-11 CEF Variables  (continued)

CEF Variable Description
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Real-Time Alarm Format
%DATE% %TIME% %SENSOR% %NAME% 

Configuring Time Periods
You can configure different time periods based on time and day of the week. The Alarmtool time 
period works in conjunction with the notification rules. A typical example is that, during work 
hours, alarm notifications come in the form of being paged, but after hours and on weekends 
alarm notifications come in the form of email.

The Default Alarmtool policy has two pre-configured time periods named “off-hours” and 
“working-hours.” 

Creating Time Periods
To create time periods:

1. Select a policy or an alarm.

2. On the Notification Rules tab, click Create.

3. In the Notification Rule Editor window, click the ellipsis button to the right of the Time 
Period field. 

4. In the Time Periods window, click Create. 

Note: If you leave the Message field blank for the notification methods that contain Message fields, 
Extreme Networks IPS will use a default message format when sending the notification message.
14-18 Alarmtool Policy Configuration



Configuring Time Periods
5. In the Time Period Name Editor, enter the name of the time period. 

6. Click OK. 
7. Select the time period.
8. Under Time Period Specification, click Create Specification.

9. In the Time Period Editor, select one or more days of the week, the start time, and the end 
time. 

10. Click OK. 

You can now assign the time period to one or more notification rules in the Alarmtool policy. 

Editing Time Periods
You can edit a time period by adding, editing, or removing time period specifications. 

To edit a time period:

1. On the Notification Rules tab, select a notification rule and click Edit. 

Note: You can configure multiple time periods for each day.
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2. In the Edit Notification Rule window, click the ellipsis button to the right of the Time Period 
field.

3. In the Time Periods window, select the time period that you want to edit. 
4. Add, edit, or remove a time period specification. 

Deleting Time Periods
To delete a time period:

1. On the Notification Rules tab, select a notification rule and click Edit. 

2. In the Edit Notification Rule window, click the ellipsis button to the right of the Time Period 
field.

3. In the Time Periods window, select the time period that you want to delete. 
4. Click Delete.
5. In the Confirm Delete dialog box, click Yes.

Configuring Event Resource Groups
Event resource groups allow you to group events into a collection that you can use when 
configuring alarms and alarm threshold settings. Event resource groups limit the need for 
repeating a long list of events in several places when configuring Alarmtool policies.

Creating Event Resource Groups
To create a new event resource group:

1. Select an alarm.

2. Click on the Event Resources tab. 

3. Click Create Group. 
4. In the Group Name field, enter a name for the event resource group.
5. Select an existing event resource group, an entire signature library, or specific signatures to 

add to the event resource group. 
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You can view event descriptions by right-clicking an event and choosing Signature Details. In 
the Event Details window, click the Description tab. 

6. Click Create. The new event resource group displays on the Event Resources tab list.

Editing Event Resources
To edit a an event resource group:

1. Right click an event resource group and choose Edit Group.

2. In the Edit Event Resource Group window, select the signatures or signature libraries that 
you want to include in the event resource group. 

3. Click OK. 
To remove a resource from an event resource group, right click the resource that you want to 
remove from the event resource group and choose Remove.

Deleting Event Resources
To delete an event resource group, right click the event resource group and choose Delete Group.

Configuring Filters
Filters can be used to further define or reduce the number of events that result in an alarm being 
executed. The rules are based on Boolean expressions.

A filter is available to the alarms in a specific Alarmtool policy.

Creating Alarm Filters
To create an alarm filter:

1. Right click an alarm and select Edit Alarm. 

You can also create an alarm filter by creating an Alarmtool policy or an alarm. Click the 
ellipsis button to the right of the Filter field.

2. In the Edit window, click the ellipsis button to the right of the Filter field. 
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3. In the Alarm Filters window, click Create. 

4. In the Alarm Filter Editor window, enter a name for the filter and click OK. 

The new alarm filter is listed under Filter Name. 

5. Click on the new filter to highlight it.
6. Under Filter Specifications, click Add Specification.

7. In the Alarm Filter Specification Editor window, configure the filter. See Table 14-12 for 
descriptions of the parameters. 
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8. Click OK. 
The filter specification is added under Filter Specifications. You can create multiple filter 
specifications for the filter. 

9. In the Alarm Filters window, click OK.

Table 14-12 Alarm Filter Specification Editor Parameters

Parameter Description

Rule Type • IncludesAll—This is a logical AND. An event must match all filter 
expressions defined here.

• IncludesAny—This is a logical OR. An event needs only match one filter 
expression defined here.

Filter Type The filter expression:

• After

• Before

• Dir

• Events

• FreeForm

• IP src/dst

• Protocol

• Sensor

Filter Expressions

After The time after which an event must occur. 

Before The time before which an event must occur. 

Direction Dir is Direction with respect to the protected network(s):

• I = Internal, both the source and destination IPs are in the Protected 
Network(s)

• X = Exterior, neither the source nor destination IPs are in the Protected 
Network(s)

• T = To, the packet is sent to an IP in a Protected Network

• F = From the packet is sent from an IP in a Protected Network

Free Form Defines a filter the same way as in older versions of Extreme Networks IPS. 
Example:

ip dst 10.0.0.0/8 and proto 14 and event DYNAMIC and event DYNAMIC-TCP 
and event DYNAMIC-UDP and event SUCCESS:WEB-OK

IP src/dst The event is from or destined to a specific IP address or network/subnet.

Protocol The event matches a specific protocol, either TCP, UDP, ICMP, AH, or ESP.

Sensor A specific sensor that the event needs to be detected on for an alarm to trigger. 
For example: VirtualSensor1.

Not Indicates that the filter expression is negative. Example: if you have the 
expression IP src 172.16.2.0/24 and checked the Not box, Extreme Networks 
IPS will create an alarm unless the packet was sent from someone in the 
172.16.2.0/24 subnet. 
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You can now assign the filter to the alarm.

Editing Filters
You can edit a filter by adding, editing, or removing filter specifications. 

To edit a filter:

1. Right click an alarm in the Alarmtool policy in which the filter exists and choose Edit Alarm.

2. Click the ellipsis button to the right of the Filter field.
3. In the Alarm Filters window, select the filter that you want to edit. 
4. Add, edit, or remove a filter specification. 

Deleting Filters
To delete a filter:

1. Right click an alarm in the Alarmtool policy in which the filter exists and choose Edit Alarm.

2. Click the ellipsis button to the right of the Filter field.
3. In the Alarm Filters window, select the filter that you want to delete. 
4. Click Delete.
5. In the Confirm Delete dialog box, click Yes.

Configuring Thresholds
Alarmtool thresholds provide another scope-limiting definition to prevent a likely event from 
generating an overwhelming number of alarms. It contains an event resource by name, or 
definition, and then the number of occurrences within an interval that must happen for an alarm 
to be generated.

Creating Thresholds
To create an Alarmtool threshold:

1. Right click an alarm and select Edit Alarm. 

2. In the Edit window, click the ellipsis button to the right of the Threshold field. 
14-24 Alarmtool Policy Configuration



Configuring Thresholds
3. In the Thresholds window, click Add Threshold. 

4. In the Alarm Threshold Editor, enter the parameters and click OK.
Threshold parameters are described in Table 14-13.

Table 14-13 Alarm Threshold Parameters

Parameter Description

Name Name of the threshold.

Event Resource Select a pre-defined event resource group or None. Refer to “Configuring 
Event Resource Groups” on page 14-20 for information on defining event 
resource groups.

Occurrences The number of times Alarmtool has to see an event within a specific 
amount to time (Interval) before triggering a notification.

Interval Specifies the number of seconds within which the number of occurrences of 
the event must occur.

Note: The interval does not reset if the number of event occurrences 
triggers a notification. The interval continues to its end before resetting.

IP Threshold Specifies whether the event occurrence has to be from the same IP 
address (samesrc), destined to the same IP address (samedst), or does not 
matter (None).
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Editing Thresholds
To edit a threshold:

1. Right click an alarm in the Alarmtool policy in which the threshold exists and choose Edit 
Alarm.

2. Click the ellipsis button to the right of the Threshold field.
3. In the Thresholds window, select the threshold that you want to edit. 
4. Click Edit Threshold.
5. In the Alarm Threshold Editor window, edit the threshold as desired. 
6. Click OK.
7. In the Thresholds windows, click OK.

Deleting Thresholds
To delete a threshold:

1. Right click an alarm in the Alarmtool policy in which the threshold exists and choose Edit 
Alarm.

2. Click the ellipsis button to the right of the Threshold field.
3. In the Thresholds window, select the threshold that you want to delete. 
4. Click Delete.
5. In the Confirm Delete dialog box, click Yes.s

Associating Alarmtool Policies with Alarmtool Agents
You can associate a master or custom Alarmtool policy with an Alarmtool agent. For information 
about adding the Alarmtool agent to a device node, see “Adding Agents to a Node” on page 11-3.

To associate an Alarmtool policy:

1. On the Dashboard EMS/Reporting tab, right-click the Alarmtool agent for the appropriate 
system and choose Select Policy.

2. In the Select Policy window, select the policy from the drop down list.
3. Click OK.
4. Right-click the Alarmtool agent, and select Operations > Deploy.

Note: If you make any changes to the Alarmtool policy after you have associated it with an 
Alarmtool agent, you must redeploy the policy to the agent for your changes to take effect. 
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Exporting and Importing Alarmtool Policies
You can export master and custom Alarmtool policies to an XML file for modification. You can 
also import an Alarmtool XML file. 

To export a policy: 

1. Right-click on the policy and select Export > to EMS or Export > to Browsing Client. 

– to EMS—Exports the policy to the system on which the EMS is running.

– to Browsing Client—Exports the policy to both the system on which you are running the 
IPS GUI and the system on which the EMS is running.

2. Choose a destination folder, or create a new folder, to export the policy. 
3. Click OK.
4. Go to the directory where you exported the policy.
5. Click on the policy, and open it with the appropriate editing program.
To import a custom policy back into Alarmtool, see “Import Signatures, Policies, Snort Rules, and 
IP Variables” on page 12-8.

Editing Alarmtool Policy Configuration

The Alarmtool Policy Configuration settings are rarely changed after initial configuration for your 
environment. 

The Policy Configuration window allows you to configure operations, such as where the tool 
should dump events it does not understand, from where the agent gets events, and how to send 
mail on the system. Typically, these settings do not need to be changed if Extreme Networks IPS 
was installed in the default /opt/dragon/ directory.

The SNMP section allows you to set the interface that the agent uses as the source IP for SNMP 
Traps. You can enter additional directories to search for SNMP MIBs, as well as which files to 
include from the directories. You can specify MIB directories and MIB names.

Caution: If you edit a configuration file, ensure that you did not break syntax rules. Extreme 
Networks recommends using an XML editor, which will perform syntax checking for syntax errors. 

Note: In previous versions of Extreme IPS, Policy Configuration was known as global options.
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Table 14-14 describes the configuration options.

Table 14-14 Alarmtool Policy Global Options

Field Description

Directory The directory where Extreme Networks IPS is installed. The default points 
to /opt/dragon.

Dump File When the Alarmtool encounters an error parsing events, it writes the error 
to the dumpfile. This defines the file name and directory of the dumpfile.

Export Directory Determines the location where Export Log files are written.

Send Mail Indicates the operating system command to use when sending email 
messages. The default value is /usr/sbin/sendmail -t, which may need to be 
changed if your sendmail binary is installed in another location.

Max Summary Events Limits the number of events shown in the summary message. The default 
value is set to 100.

Concatenate Events Selecting this value, will put all events logged by Alarmtool into a single 
notification file.

If not selected, separate events logged by Alarmtool are put into a separate 
notification file. 

SNMP (Interface) The IP address used as the source IP when an SNMP trap is generated. 
This value should be set to the local IP address of your Extreme Networks 
IPS system.
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SNMP (MIB Directory, MIB 
Name)

Defines the location and the specific MIB files that should be used by the 
SNMP notification method for sending traps. You can configure any number 
of mibdir and mib parameters to define these additional files. 

Table 14-14 Alarmtool Policy Global Options (continued)

Field Description
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Using Alarmtool with NetSight ASM

Distributed IPS is the ability of Extreme Networks IPS and NetSight Automated Security Manager 
(ASM) to dynamically block, limit, or take some action, against someone who is a threat or 
potential threat to your network. This chapter describes how to configure an Alarmtool 
notification rule that uses the NetSight ASM notification method. Refer to Chapter 14, ”Alarmtool 
Policy Configuration’ for Alarmtool configuration information.

This chapter also describes a basic configuration of NetSight ASM to work with Extreme 
Networks IPS Alarmtool to provide Distributed IPS. Refer to the NetSight Automated Security 
Manager online help for more information.

Overview 
The following is a brief view of how Extreme Networks IPS and ASM defend your network 
against security threats.

1. Extreme Networks IPS detects a security event and notifies ASM of end stations that are the 
source of threats on the network. 

Security events containing information about the threat (such as event category) and the end 
station IP addresses are sent via an SNMPv3 trap (inform) with AuthPriv enabled. 

The use of SNMPv3 with AuthPriv enabled provides a measure of security to minimize the 
chances of a malicious user sending traps to the Automated Security Manager and disabling 
the network.

2. ASM's search capability determines the switch and port.
3. ASM then determines what action should be taken and applies the action on the port (no 

action, disable port, or apply a quarantine policy).
4. Finally, ASM notifies Extreme Networks IPS of the actions taken via a SNMPv3 trap (inform).

Event Categories
ASM event categories are used by ASM to match events reported by Extreme Networks IPS. To be 
recognized by ASM, the text string in the event message sent by Extreme Networks IPS must 
match exactly the ASM event category names.

For information about... Refer to page...

Overview 15-1

Configuring an Alarmtool NetSight ASM Notification Rule 15-2

Configuring NetSight ASM for Distributed IPS 15-3
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Extreme Networks IPS has four default ASM notification rules: 

• netsight-asm-attacks

• netsight-asm-compromise

• netsight-asm-informational

• netsight-asm-misuse. 

Each of Extreme Networks IPS's notification rules has a corresponding event category in ASM: 

• ASM_ATTACKS (precedence 1)

• ASM_COMPROMISE (precedence 2)

• ASM_MISUSE (precedence 3)

• ASM_INFORMATIONAL (precedence 4)

Precedence determines the order that ASM responds to certain Event Categories. A lower number 
yields a higher precedence, which means that when multiple events are recognized, ASM will 
respond to the highest precedence first. If all of the numbers are the same, then the events are 
processed in the order they are received. 

ASM uses Rules to compare incoming trap messages with specific event categories, then 
determines where and what action to apply as a response.

Configuring an Alarmtool NetSight ASM Notification Rule
This section describes how to create a notification rule that uses a NetSight ASM notification 
method. For information about how to use this type of rule when configuring an Alarmtool 
Alarm, see Chapter 14, ”Alarmtool Policy Configuration’.

To create a new NetSight ASM notification rule: 

1. From the Configuration menu, select Alarmtool Polices.

2. Select the appropriate Alarmtool policy from the policies list.
3. Click the Notification Rules tab.

4. Click Create under the Notification Rules list. The Notification Rule Editor window opens.
5. Give the notification rule a name, select a time period if desired, and click OK.

The new notification rule is now listed under Notification Rules.

6. Click on the new notification rule to highlight it.
7. Click on the NetSight ASM tab in the right pane.
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8. Click Create in the NetSight ASM section to open the NetSight ASM Editor. 

9. In the Server field, enter the IP address of the NetSight ASM Server. 

10. In the Security Name field, enter an SNMPv3 User (Security) Name. This can be any name, 
but will need to match the Security Name configured on ASM in the snmptrapd.conf file.

11. In the Auth Password field, define a password for Authentication. This password will need to 
match the password configured on ASM in the snmptrapd.conf file.

12. In the Priv Password field, define an encryption password. This password will need to match 
the password configured on ASM in the snmptrapd.conf file.

13. Select an ASM Category from the drop-down list. By default, the list includes the pre-defined 
NetSight ASM event categories: ASM_ATTACKS, ASM_MISUSE, 
ASM_INFORMATIONAL, and ASM_COMPROMISE.
You can add additional ASM event categories to the list by clicking the Edit button and 
entering a new ASM event category in the ASM Category Editor. Note that ASM event 
category names are case sensitive. If you add a new event category to the list, make sure the 
category name exactly matches the event category configured in NetSight ASM.

14. Click OK.
The new Netsight ASM notification method has been configured and is added to the new 
notification rule.

To use this notification rule in an Alarmtool Alarm, see “Creating Alarms” on page 14-5.

When using a Netsight ASM notification method, be sure to configure SNMP parameters on the 
Global Options tab (see “Configuring Event Resource Groups” on page 14-20).

Configuring NetSight ASM for Distributed IPS
This section describes a basic procedure to configure NetSight ASM to work with Extreme 
Networks IPS for Distributed IPS.

1. Start NetSight ASM. 

Caution: Do not use the IP address of a NetSight ASM client-only PC. 

Note: Refer to the online help shipped with NetSight ASM for detailed configuration information.
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2. From the Tools menu, select Modify snmptrapd.conf.
3. Add a line to create a sending user with the SNMPv3 information that you entered in the 

Extreme Networks IPS Alarmtool Netsight ASM Notification Rule.
For example, if you configured an Extreme Networks IPS Alarmtool ASM Notification Rule 
with the following values:

• Security Name: DragonUser

• Auth Password: AuthPW555

• Priv Password: PrivPW555

You would add the following line to the snmptrapd.conf file, as shown below.

createUser DragonUser MD5 AuthPW555 DES PrivPW555
15-4 Using Alarmtool with NetSight ASM



Configuring NetSight ASM for Distributed IPS
4. Be sure to save the snmptrapd.conf file before closing. 
5. Restart the SNMPTrap daemon for your changes to take effect (On Windows this can be done 

from the NetSight Taskbar Icon). Refer to the NetSight ASM online help for more information.
6. On the ASM application click Tools, and select ASM Configuration to launch the Automated 

Security Manager Configuration wizard.
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7. Click on the Edit radio button, located in the top left section of the window. 
8. Click on the Include button, located under Groups & Devices, to add all devices. Deselect any 

devices that you do not want Location Services performed on.
ASM Location Services searches various MIBs on the selected devices for a specific MAC or IP 
address. A typical use of Location Services is if Alarmtool finds someone hacking at your 
network, ASM will search the Network for the port that the hacker is on so that ASM can then 
disable that port.

9. Click on Continue.
10. The Exclude Port Types view displays.
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11. In the right pane of the window, select any check box for a class of ports that are not going to 
be searched with Location Services.
If someone attacks your network, many switches in the network may have seen the attacking 
IP address. Because of this, ASM tries to ignore the IP if it is discovered on an Inter Switch 
Link. This screen lets you configure ASM to know what links are used as Inter Switch Links.

12. Click Continue to advance to the Exclude Specific Ports window.
The Exclude Specific Ports view allows you to further define what ports ASM is not to use 
Location Services on. In addition to all Inter Switch Links, it is recommended that you exclude 
server ports and the NetSight management station itself.
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13. To exclude ports, select a switch, and then click on Get Port Info. 
14. Select a port, and click on the Exclude Selected Ports button.
15. Repeat step 13 and step 14 for all switches and ports that you want to exclude
16. Click Continue when done to advance to the Rule Definitions window.
17. Click Create to invoke the Create Rule window as shown below.
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18. Enter a rule name.
19. Click on the Sender Identifier tab in the right pane of the window. 
20. Select Edit List, and add dragon to the Sender Identifier Name. Click Add to List.
21. Click on OK.
22. In the Sender Identifier tab, click on the Match Selected radio button, and make sure that the 

user dragon is checked.
23. Click on the Event Categories tab.
24. Click on the Match Selected radio button, and select the check box for ASM Attacks. This 

should match the ASM Category as configured in the Extreme Networks IPS Alarmtool 
Netsight ASM Notification method.

25. Expand the Device tree in the left pane, and highlight the All Devices for this ASM rule, or 
select the particular switch necessary for this search.

26. From the Action drop-down list, select Disable Port.
27. Click on Apply, and then click on Close to end the Wizard.
28. Verify in the Automated Security Manager Configuration window that the rule is enabled
29. Click on Save, and then Close.
30. Leave the Netsight Automated Security Manager open to verify that the Search and 

Respond radio button is selected, and that the green light is on.
Extreme Networks Intrusion Prevention System Configuration Guide 15-9



Configuring NetSight ASM for Distributed IPS
Distributed IPS is now configured.

Testing the Configuration
To test the Distributed IPS configuration, a user with the IP 192.168.0.10 FTPs to a server and tries 
to login as root. The Extreme Networks IPS Network Sensor sees the login attempt, and creates an 
Alarm. It then sends an SNMPv3 Trap to NetSight ASM. NetSight ASM evaluates the trap, uses 
Location Services to find where the user is, and then disables the user’s port. An entry is made in 
NetSight ASM as shown in the figure below..

To re-enable the port, click Undo Action.
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Using Alarmtool with Check Point Firewalls

Using the Open Platform for Security (OPSEC) framework and the Suspicious Activity Monitoring 
(SAM) API, Extreme Networks IPS can communicate threats to a Check Point FireWall-1/VPN-1 
management server. The management server, in turn, directs the VPN-1/FireWall-1 modules to 
terminate sessions or deny access to those specific hosts. 

Configuring an Alarmtool OPSEC SAM Notification Rule
This section describes how to create a notification rule that uses the OPSEC SAM notification 
method. For information about how to use this type of rule when configuring an Alarmtool 
Alarm, refer to Chapter 14, ”Alarmtool Policy Configuration”.

To create a new OPSEC SAM notification rule:

1. From the Configuration menu, select Alarmtool Polices.

2. Select the appropriate Alarmtool policy from the policies list.
3. Click the Notification Rules tab.

4. Click Create under the Notification Rules list. The Notification Rule Editor window opens.
5. Give the notification rule a name, select a time period if desired, and click OK. 

The notification rule is now listed under Notification Rules.

For information about... Refer to page...
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Canceling SAM Actions to Allow Traffic 16-3

Configuring the Check Point Firewall-1 Next Generation (NG) and Extreme 
Networks IPS

16-3
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6. Click on the new notification rule to highlight it.
7. Click on the OPSEC SAM tab in the right pane. 
8. Click Create in the OPSEC SAM section to open the OPSEC SAM Editor. 

9. Enter the parameters described in the following table.

Field Description

Action Specifies the action the firewall should take. There are five options:

Inhibit, Inhibit & Close, Drop, Drop & Close, or Notify.

Auth. Type Select the authentication type from the drop-down list.

“sslca” is the default method for Check Point communication in NG version 
firewalls. If you are using 4.1, then you can use “auth_opsec” or 
“ssl_opsec”. “none” can be used to test a connection to the firewall but the 
firewall will have to be configured to accept connections in the clear and a 
different port will have to be specified. Other options are available if you are 
using any of the other new NG authorization methods.

Log Level Select from the drop-down list. Choices include: SAM_NOLOG, 
SAM_LONG_NOALERT, SAM_LONG_ALERT.

Request Type This setting determines the filter on which connections will be blocked. 
They can be blocked based on source IP address, destination address, an 
address and protocol, or a service at an address using the following 
settings:

SAM_SRC_IP                     SAM_DST_IP                         SAM_ANY_IP

SAM_SERV                         SAM_DST_SERV

SAM_SRC_IP_PROTO     SAM_DST_IP_PROTO

Entity The default value is sam_server. This value should not change unless 
Check Point changes the API in a future version.

Expiration Specifies the time interval that connections should be inhibited from the 
target IP. Values can range from 0 to 1,000,000 seconds.

Firewall Host Specifies which Firewall-1 objects the command should be executed on. 
You can specify “All”, “Gateways”, or any Firewall-1 object or group.
16-2 Using Alarmtool with Check Point Firewalls



Canceling SAM Actions to Allow Traffic
Canceling SAM Actions to Allow Traffic
To cancel any actions taken by the Alarmtool, run Alarmtool from the command line using the 
following options:

• -O notification-rule-name

and either

• -A [which deletes all SAM actions regardless of how they were created]

Or, some combination of the following parameters (the logfile from the Alarmtool will specify 
which were used to create the temporary firewall rule):

• -S src_ip [the source IP that is to be allowed to connect]

• -D dest_ip [the destination IP that connections are to be allowed to]

• -P port [the server port to allow connections on]

• -I protocol [the protocol to allow through the firewall]

For example:

root@dragon:/opt/dragon/bin# ./alarmtool -i Alarmtool -O CheckPointFW -S 10.20.111.56

Configuring the Check Point Firewall-1 Next Generation (NG) and 
Extreme Networks IPS

To configure the Check Point Firewall-1 Next Generation and Extreme Networks IPS to use 
OPSEC, perform the following steps:

1. From the Check Point Firewall-1 SmartDashboard:

a. Ensure that the Network Objects tab is selected.

b. From Network Objects->Nodes right-click and select New Nodes->Host….

The Host Node configuration window displays. 

Port Specifies the port that the firewall will listen on for connections. Typically, 
18183. 

Server Set this field to the IP address of the Check Point Firewall-1 Management 
Server listening for OPSEC connections, unless Extreme Networks IPS is 
running on that server (not a recommended configuration).

SIC Name This is the communication configuration for the Check Point OPSEC 
application defined in the Firewall-1 interface for NG. This does not apply 
for 4.1 Check Point Firewall-1 installations. NG communication will not work 
without this setting.

Field Description
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c. Enter the Name and IP Address, and click OK.

d. Click on the OPSEC Applications tab.

e. From OPSEC Applications->OPSEC Application, right-click and select 
New OPSEC Application…..

The OPSEC Applications Properties window displays.

f. Enter a name in the name field, and select the Host you created in the previous steps.

g. Under Client Entities, select the SAM option.

h. Click on the Communication button, located at the bottom of the screen. 

The Communication configuration screen displays.
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i. Enter an Activation Key in the Activation Key field and in the Confirm Activation Key 
field, and click Initialize. 

The Trust state should now be “Initialized but trust not established”.

j. Click Close, and then OK.

k. Install the Policy on your Gateways.

2. From the bin directory on your Extreme Networks IPS host where Alarmtool will be running, 
run the opsec_pull cert binary as shown below:

LD_LIBRARY_PATH=/<installdir>/lib /<installdir>/lib/ld-linux.so.2 ./
opsec_pull_cert –h IP_address_of_fw1_mgmt_server –n opsec_app_name 
-p password

Where:

– IP_address_of_fw1_mgmt_server is the IP Address of the primary server that hosts the 
certificate authority entered in the Host Node screen

– opsec_app_name is the name entered in the OPSEC Application Properties screen

– password is the Activation Key entered in the Communication screen

This command pulls an opsec.p12 file down from the built-in CA of Firewall-1. 

3. Copy this file to the root Extreme Networks IPS directory.
In the SmartDashboard, the OPSEC application you created should show that Trust is 
established.
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4. Configure an Extreme Networks IPS notification method to make the call by performing the 
following steps:
a. Enter the expiration time for each blocked IP.

b. Enter the IP address of the server that is listening for OPSEC requests.

c. Enter the sic_name of your OPSEC application. This is in the field next to the 
communication button on the OPSEC application edit form, shown below.

d. Other options can be left at their defaults unless a non-standard installation of Firewall-1 
is used or Firewall-1 4.1 is used.
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Configuring EMS High Availability

This appendix provides information about configuring EMS High Availability.

Overview
The components of a Highly Available Extreme Networks IPS EMS environment include a 
primary EMS server and client, a secondary EMS server, and network sensor(s) and/or host 
sensor(s).

EMS High Availability
By default, highly available EMS and Reporting environments require that the primary and 
secondary EMS as well as the primary and secondary Reporting servers should each be on 
separate physical machines. Note that Enterasys does not by default support configuring high 
availability environments where both an EMS server and an Extreme Networks IPS Reporting 
server reside on the same physical system. That is, an environment that uses one system for both 
the primary EMS and the primary Reporting server and a second system for the secondary EMS 
and the secondary Reporting server. If you require a high availability environment where an EMS 
server and an Extreme Networks IPS Reporting server reside on the same physical system, 
consider scheduling an Enterasys Professional Services engagement for help configuring it.

For help configuring a second, highly available Reporting server, whether on the same host as the 
secondary EMS or elsewhere, contact Enterasys Support (see “Getting Help”  on page iii).

For information about... Refer to page...
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Requirements
The following components are required for a high availability Extreme Networks IPS EMS 
environment:

• Two Extreme Networks IPS EMS servers

– One EMS to serve as the primary EMS

– One EMS to serve as the secondary EMS

• One or more EMS Network sensor(s) and/or Host Sensors

Configuring EMS High Availability
Follow these steps to install and configure a highly available Extreme Networks IPS EMS 
environment.

1. Installing and Configuring Extreme Networks IPS Components

2. Configuring Additional Extreme Networks IPS High Availability Users and Keys
3. Configuring and Enabling High Availability on a Reporting Server
4. Enabling High Availability on the Primary EMS Server

Installing and Configuring Extreme Networks IPS Components
1. Install the primary Extreme Networks IPS EMS server following the instructions in the 

Extreme Networks Intrusion Prevention System Installation Guide.

2. Configure the primary EMS server following the instructions in this guide. 
3. Create and configure any desired Network Sensor(s) and/or Host Sensor(s) as described in 

this guide.
4. Install the secondary EMS server as you would any EMS server, following the instructions in 

the Extreme Networks Intrusion Prevention System Installation Guide.
5. After installation, perform the following steps on the secondary EMS:

a. Following the secondary EMS server installation, do not configure the secondary EMS. 

b. Ensure that the Extreme Networks IPS EMS software installed on this system is NOT yet 
running. The Extreme Networks IPS administrator must manually start the secondary 
EMS on this machine in the event of a failure of the primary EMS, as described in 
“Running the Start Secondary Script” on page A-8.

c. Ensure that the machine on which the secondary EMS server has been installed is running 
and available.

d. Ensure that there is a network connection between this system (the secondary EMS) and 
the primary EMS system. This is needed to enable the primary EMS to automatically 
backup its database to the database copy on the secondary EMS. This is done periodically 
(at an interval you specify) as described in “Enabling High Availability on the Primary 
EMS Server” on page A-5.

This secondary system will operate in standby mode until needed in the event of a failure of 
the primary EMS.
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Configuring Additional Extreme Networks IPS High Availability Users 
and Keys

Create and configure the dragonkey user (generate a public/private DSA key for this user and share 
the generated public DSA key between the primary and secondary EMS systems), by following 
these steps:

1. Run the following command to ensure permissions on the dragon user directory:

chown dragon:dragon /home/dragon

2. On the primary EMS, login as root.
3. Switch to the dragon user using the following command:

root@primary-ems:~# su - dragon

dragon@primary-ems:~$

4. Generate a DSA key for the dragon user by running the following command:
dragon@primary-ems:~$ ssh-keygen –t dsa
Do not provide a password when prompted; simply press enter at the prompt.

5. On the secondary EMS, login as root.
6. Add a new user named dragonkey using one of the following commands as appropriate:

– root@secondary-ems:~# useradd dragonkey -g dragon -d /opt/
dragonkey -m

– root@secondary-ems:~# useradd dragonkey -g dragon -d /usr/
dragonkey -m

7. Provide (and make note of) a password for the user dragonkey using this command:
root@secondary-ems:~# passwd dragonkey

8. Set up a reference to the primary EMS from the secondary EMS by creating a configuration file 
named primary.cfg:
root@secondary-ems:~# cd /opt/dragon/conf 
root@secondary-ems:~# ../scripts/set-primary.sh <Primary-EMS-Hostname> 
<Primary-EMS-IP> 

9. On the primary EMS, login as root.
10. Switch to the dragon user using the following command:

root@primary-ems:~# su - dragon

dragon@primary-ems:~$

11. Execute the following command (all on one line):
dragon@primary-ems:~$ ssh dragonkey@IPaddress "mkdir ~/.ssh && chmod 
0700 ~/.ssh && cat >> ~/.ssh/authorized_keys2" < ~/.ssh/id_dsa.pub

When prompted, enter the password assigned to the user dragonkey in Step 6.

Configuring and Enabling High Availability on a Reporting Server
Each Reporting server in an Extreme Networks IPS deployment contains a proxy agent used by 
the reporting System Dashboard. Additionally, each Reporting server contains a Reporting Proxy 
Properties file that contains information about the primary and secondary EMS servers. An 
Extreme Networks IPS Reporting server's proxy agent uses the parameters stored in the Reporting 

Note: Substitute the IP address of your secondary EMS server for IPaddress here. If the host name 
of the secondary EMS server is resolvable, it can be used in place of an IP address here.
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Proxy Properties file to authenticate with the primary and secondary EMS servers. By default each 
Reporting Proxy Properties file is populated with information about the primary EMS during 
primary EMS installation. Information about the secondary EMS must be manually added to each 
Reporting Proxy Properties file in your Extreme Networks IPS deployment. 

Prior to starting the Reporting server, you must add the both the primary and secondary EMS 
authentication information into the EMSproxy.xml files and enable the secondary EMS for each 
Reporting server present, that includes standalone, EMS/reporting and reporting-only Extreme 
Networks IPS installations.

To do this:

1. Open the EMSproxy.xml file for editing. The file is located in the following directory:

<installdir>/conf
2. Under the <Primary> element, set the values for the <host>, <port>, <username>, and 

<password> elements.
3. Enable authentication with the secondary EMS by changing <Secondary enabled="false"> to 

<Secondary enabled="true">.
4. Under the <Secondary> element, set the values for the <host>, <port>, <username>, and 

<password> elements.
For information about reporting authentication and a brief discussion of reporting 
authentication best practices, see “Managing Reporting Proxy Authentication” on page 10-7. 

5. Save and close the file. 
6. Navigate to <installdir>/scripts.
7. Stop the jboss process by running the following command:

./dragon-jboss stop

8. Restart the jboss process by running the following command:
./dragon-jboss start

Repeat for each Reporting server in your deployment.

Updating login-config.xml on the Reporting Server for High Availability
You must update the login-config.xml file, located in /opt/dragon/enterprise-manager/server/
default/conf, to add the secondary EMS login module to the dragon-security rule. 

The secondary EMS login module allows the reporting server to direct login requests to the 
secondary EMS when the primary EMS is down. Without the secondary EMS login module, the 
IPS GUI will not be able to login to the secondary EMS when the primary EMS is down.

To add the secondary EMS login module to login-config.xml:

1. Open the login-config.xml file for editing. The file is located in the following directory:

/opt/dragon/enterprise-manager/server/default/conf

2. Add the secondary EMS login module after the </login-module> line for the default EMS 
database login module.

3. Set the IP address of the secondary EMS.
In the following example, the IP address of the secondary EMS is 10.20.30.50.

<module-option name="java.naming.provider.url">jnp://10.20.30.50</module-
option>

4. In the default EMS database login module and the secondary EMS database login module, 
change the value of the flag attribute from required to sufficient.
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<login-module code="com.enterasys.dragon.security.auth.module.EMSLoginModule" 
flag="sufficient">

Your updated login-config.xml file should look like the following:

5. Save and close the file. 

Enabling High Availability on the Primary EMS Server
After you have configured the primary and secondary EMS servers as described above, you must 
complete the configuration of and enable EMS high availability on the primary EMS server. 

Enabling and configuring the high availability update will cause the primary EMS to periodically 
backup the EMS database (at an interval you specify) on the secondary EMS (at the IP address you 
designate here). 

To enable and configure EMS high availability:

1. Add the secondary EMS server host name and IP address to the high availability settings.

a. Click the Options menu. 

b. Under Preferences, select High Availability. 

c. In the Secondary EMS Hostname field, enter the host name of the secondary EMS server. 

d. In the Secondary EMS Address fields, enter the IP address of the secondary EMS server. 
The database will be backed up to the secondary EMS you specify here. 

<!-- Default EMS database login module Dragon 8.0.0.691 -->
<application-policy name="dragon-security">
   <authentication>
      <login-module code="com.enterasys.dragon.security.auth.module.EMSLoginModule" 
flag="sufficient">
         <module-option name="java.naming.provider.url">jnp://10.20.30.40</module-option>
         <module-option name="group">true</module-option>
         <module-option name="debug">true</module-option>
      </login-module>
 <!-- Secondary EMS database login module -->
       <login-module code="com.enterasys.dragon.security.auth.module.EMSLoginModule" 
flag="sufficient">
          <module-option name="java.naming.provider.url">jnp://10.20.30.50</module-option>
          <module-option name="group">true</module-option>
          <module-option name="debug">true</module-option>
      </login-module>
   </authentication>
</application-policy>
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e. (Optional) Select the Enable Automatic High Availability checkbox to enable EMS high 
availability scheduled backup. 

f. In the High Availability Interval field, which is enabled if you select the Enable 
Automatic High Availability checkbox, enter the number of hours between database 
backups. By default this is 1 hour. Note that once configured and enabled, the high 
availability update backup occurs on the hour.

g. Click Save.

h. Click Execute Now to start a database backup immediately.

2. Add a system in the IPS GUI for the secondary EMS host. 
a. In the Dashboard view, go to the Systems tab. 

b. Click the Create System icon.

The Create System window displays. 

c. Enter the hostname, IP address and OS family of the secondary EMS server.

d. Click Create. 

The secondary EMS host appears in the Systems tab.

e. Right click the EMS host system entry in the Systems tab. 

f. From the Add Agent menu option, add the DragonDB and the Dragon2MySQL agents to 
the EMS host system. 

3. Configure the secondary EMS server update interval
a. Select Configuration > Channel Profiles. 

b. On the Config Channel tab, select the config channel profile on which you want to deploy 
the high availability configuration. 

c. Select the Secondary checkbox. 

Note: The High Availability EMS Address must be manually added to each Reporting server in your 
Extreme Networks IPS deployment. For more information, see “Configuring and Enabling High 
Availability on a Reporting Server” on page A-3.
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d. From the Host Name drop down menu, select host name of the secondary EMS server. 

The IP field automatically populates with the IP address of the secondary EMS server. 

e. Click Save. 

The configuration deploys automatically. 

After you enable and configure the high availability update, the EMS management database is 
automatically backed up at the interval period specified and that backup is copied to and 
maintained in the /tmp directory of the secondary EMS server. 

Manual Failover to the Secondary EMS
In the event that the primary EMS server is determined to be down, you must manually start 
Extreme Networks IPS on the secondary EMS server by running the start-secondary script on the 
designated secondary EMS server machine (see “Running the Start Secondary Script” on 
page A-8). 

Running the startup script on the secondary EMS will:

1. Install the most recent Extreme Networks IPS backup database received from the primary 
EMS

2. Start the secondary EMS
In an Extreme Networks IPS high availability environment, all Extreme Networks IPS sensors are 
deployed with both the primary EMS and secondary EMS addresses. Each sensor will attempt to 
connect to the primary EMS. If that fails, they will attempt to connect to the secondary EMS. If the 
primary EMS fails, the sensors connected to it will drop their connections and attempt to 
reconnect to the primary EMS. If this fails, the sensors will attempt to connect to the secondary 
EMS.

If the primary EMS is determined to be down, you can still use Live Update to update sensors 
with new signatures and so on. You can also make configuration changes while running on the 
secondary EMS. However, be aware that any changes you make while running on the secondary 
EMS (other than those made by a Live Update) must be manually propagated from the secondary 
EMS to the primary EMS after the primary is brought back online. This can be done by restoring 
the database on the primary EMS from that of the secondary EMS, as described in Bringing the 
Primary EMS Back Online, below.
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Running the Start Secondary Script
To start the secondary EMS server in the event of a failure of the primary EMS:

1. On the secondary EMS machine, change directories to the Extreme Networks IPS install 
directory (by default, /opt/dragon).

cd  /opt/dragon 

2. Run the start-secondary from the scripts directory using the following command:
./scripts/dragon start-secondary

The secondary EMS is now running and active.

Bringing the Primary EMS Back Online
After you have resolved any operational issues on the primary EMS, you can bring back online 
and return control to the primary EMS.

1. Start the primary EMS.

2. Perform a Live Update if required to ensure you have the latest version of the signature set.
3. Stop the Extreme Networks IPS software on the secondary EMS.

All the Extreme Networks IPS sensor connections to the secondary EMS will be dropped and 
the sensors will attempt to reconnect to the primary EMS.

4. If you made any significant configuration changes to sensors while the secondary EMS was 
active, you can restore the primary EMS database from the secondary EMS database. To do 
this, use the standard backup and restore facility in Extreme Networks IPS, as described in 
“Database Backup/Restore” on page 12-5.
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Creating signatures that accurately identify the various attacks, probes, misuse, and other sought 
data from network traffic without false positives and negatives can sometimes be deceivingly 
complicated. Extreme IPS administrators who want to produce their own signatures should have 
a firm understanding of the information that can be discerned and the conclusions that can be 
reached from observing network traffic. Some of the common styles of signatures and how they 
are used are described in this appendix.

Resource-Based Signatures
The resource usage signature is effective because it assumes that any attack or probe that attempts 
to exploit a particular network resource uses that resource at some time. With these signatures, 
there is a database of specific “bad things.” When these bad things are seen, alerts can be sent and 
a good understanding of the attack or probe is achieved.

An example of this is the PHF attack. Normally, an attack against older web servers could be 
accomplished by sending specially formatted argument strings to the /cgi-bin/phf program which, 
at one point, shipped with many common web servers. There are hundreds of permutations 
which may all be based on the /cgi-bin/phf program and each of these attacks or probes reference 
that URL. Programming the Network Sensor to look for /cgi-bin/phf in all port 80 server traffic 
detects a wide variety of web probes and attacks. 

Suspicious Traffic
Unlike the usage signatures, the suspicious signatures focus on data that should not be present in 
various network sessions. This data is much more generic and there is no direct correlation to a 
specific attack. Several very good examples of these signatures exist. 

First, consider almost any CGI-BIN attack program. They inevitably run commands on target 
machines. Often they make use of programs such as /bin/cat, /bin/id, and /bin/mail. As these 
programs do not occur in normal web traffic, merely searching for these occurrences may indicate 
a web attack of some kind.

Second, consider protocols such as FTP and SMTP. Typically, these protocols are entirely ASCII 
based. All file transfer is with the 7-bit printable character set. Almost all buffer overflows to these 
services can be detected by looking for long strings of binary data. 

Server Messages
Many times attacks are known, but it is easier to look for them in the return traffic from a server. 
Consider some unknown protocol that after 10 failed login attempts, issues the message, Login 
Unsuccessful - Account Closed. Instead of searching for all 10 login failure attempts, correlating 
them to a unique period of time, this single message could be searched for. Also, the responses to 
Extreme Networks Intrusion Prevention System Configuration Guide B-1



Indirect Signatures
network attacks can be analyzed in real time. If a buffer overflow drops a network session to a 
BASH shell prompt, signatures can be written to look for that occurrence. 

Indirect Signatures
Indirect signatures search for network patterns that may indirectly indicate some form of network 
misuse or system compromise.

An example of this was the Attrition mirror of defaced web sites. (They no longer mirror defaced 
web sites.) They maintained a custom web crawler that attempted to retain the original copy of a 
hacked web site. While downloading the web site, the web crawler passed several web client 
parameters to the web server. Many of these parameters included messages such as If you see 
this, your site may have been compromised. You could conclude indirectly from this statement 
that the only reason the Attrition web crawler has visited your site was because at least one site 
has been defaced.

Tips for Creating Signatures
Limit the number of signatures needed to accomplish your goals and consider your platform. For 
example, on a UNIX platform, there is no need for signatures that look for IIS. Write generic 
signatures that look for references to /cgi-bin/ and keywords such as /etc/passwd, /etc/group, /bin/
mail and xterm-display. Other configurations could search for combinations of /cgi-bin/ and hex 
escape characters, such as %20 and %0a. Keeping this frame of mind when developing signatures 
can help optimize performance. Additional signature suggestions are described below.

Look for CGI Probes

• Look for Smart CGI Probes—Many web-based attacks target UNIX servers with CGI-BIN 
programs. Almost all of these attacks cause a script to execute some sort of commands. This is 
usually accomplished by passing unanticipated arguments and parameters containing shell 
escape characters, target programs, and target files to a CGI-BIN script. In short, write generic 
signatures that look for references to /cgi-bin/ and keywords such as /etc/passwd, /etc/group, 
/bin/mail, and xterm-display. Other configurations could search for combinations of /cgi-bin/ 
and hex escape characters, such as %20 and %0a.

• Look for Failed CGI Probes—Any 404 failed web requests that also contain a reference to /cgi-
bin/ may indicate a broken CGI-BIN program, or a probe to a non-existing CGI script.

• Honey-pot CGI and SCRIPTS Directories—For UNIX and IIS web servers, it may be useful to 
rename the CGI-BIN or SCRIPTS directory to something else. A savvy hacker will quickly 
determine the new name from analyzing a live web server, but automated tools will fail. Any 
request to either original directory will be quickly determined.

Look for Administrator Access

Every network has a variety of administrator access that is performed from authorized locations. 
Monitoring for deviations from this “normal” activity or security policy can be very interesting. 
Here are some examples.

• Consider SNMP, which is a UDP protocol that is used to monitor large numbers of network 
devices. Typically, SNMP packets are sent within a protected network. For Network Sensors 
on the perimeter of such a network, it may be worthwhile to ignore SNMP traffic from valid 
SNMP servers and only log what is left behind. If a Network Sensor is placed on the inside of 
a network, modifying the Extreme IPS signatures to look for packets that are inbound may 
also be worthwhile.
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• TFTP is another type of protocol used in the management of routers and phone switches. 
Using Extreme IPS to watch for any traffic to these devices that is not from a known or trusted 
source may turn up a variety of interesting traffic.

• Many network servers have become web enabled and have corresponding “administrator” 
pages. Detecting these features on your network is a matter of inventory, but once they are 
identified, signatures can be constructed to help detect remote and possibly unauthorized 
access.

Default Installs

It can be very useful to look for default installations of a variety of network services such as web 
servers. Any default “It worked” web pages originating from your network may be worth 
investigating. The Extreme IPS signature library should include some examples of these 
signatures, but various commercial web servers may not have been incorporated. 

Look for Backdoors

Backdoors indicate that a break-in has occurred and is in use. Here are some suggestions that can 
be used to discover backdoor activity in addition to the backdoor signatures.

• High-Port Detection—Looking for any suspicious TCP sessions that occur on high ports can 
be used to identify compromised servers. It is very common for hackers to install network 
software that allows them to connect to the remote box at a later time. This is accomplished by 
looking at TCP traffic for Syn-Ack packets that only occur when a server responds to a client. 
Watching for these “new” services on your network can indicate a possible break-in. 
Additionally, logging these Syn-Acks to your network can be used to identify someone inside 
your network connecting to a high port someplace else.

• Long SSH Sessions—SSH can be used as a temporary VPN. Looking for START and STOP 
messages on port 22 can indicate the length of an SSH session. If the session occurred over a 
long period of time, or if it transferred a lot of data, this can indicate a hacker who is using 
SSH to maintain remote access to a network. It can also indicate an administrator abusing a 
security policy. Determining the amount of data transferred in a TCP session can be 
accomplished by analyzing the initial and final sequence numbers.

• Off-Port Servers—Extreme IPS signatures can be written to look for almost any service on the 
wrong port. A common hacker (or malicious administrator) technique is to run services such 
as HTTP, FTP, and SSH on ports other than their standard port number. For example, many 
WAREZ FTP servers run on TCP port 69. Simple signatures can be deployed to discover these 
off-port services that should be considered backdoors.

• Suspicious Command Execution—When an attacker has successfully exploited a software 
vulnerability, and has achieved an elevated privilege, it is commonly the case that the attacker 
makes use of various system tools to verify that the desired level of access has actually been 
achieved or can be used. Good examples of Extreme IPS signatures designed to detect such 
activity include the COMP:WIN-2K3 signature that detects command shell execution on a 
Windows 2003 server, and the COMP:ROOT-TCP signature that detects the output of the 
UNIX “id” command indicating that the current user ID is root. 

Additional steps an attacker may take are to compile new binaries and/or change permissions 
on certain system files to be favorable to re-entry. Examples of signatures designed to detect 
such activity include the GENERIC:SHELL-SETUID-UDP, GENERIC:SHELL-SETUID-TCP, 
and GCC:COMPILE-WARNING signatures. The Extreme IPS signature set has many 
signatures that are designed to detect not only specific attacks, but also the likely follow-on 
effects of such attacks.
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• Work with Firewalls—Extreme IPS can be used to verify firewall policy. For example, most 
firewalls filter some basic protocols in general, such as ICMP. Extreme IPS can be configured 
to detect inbound ICMP traffic and alert on it. This may reflect that an incorrect firewall policy 
was loaded, or that a new route has been added defeating the firewall. Some customers have 
gone so far as to TCP PING sweep their network with tools like NMAP once a day from a 
static IP address. Their Network Sensors are designed to alert on any traffic from the static IP 
address which in theory would indicate a firewall breach or configuration problem.

• Use Virtual Honeypots—Extreme IPS can be used to look for traffic destined for particular IP 
addresses or network services that do not exist. For example, with ICMP, Extreme IPS can be 
configured to look for external network PING attempts to some hosts that do not exist. This is 
a good way to find external probes and slow scans. Extreme IPS can be configured to ignore 
some basic services such as DNS or RPC to some key servers, but log that activity when it 
occurs against other servers that do not run that particular service.
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Example of Custom Signature Creation

A database server in the core of your network contains complete customer profiles and the 
complete history of their business dealings with your company. There is a web interface to the 
database (making it easy for your sales force to manage accounts). You need signatures to protect 
this valued data from possible attack. There are three separate security concepts to address:

• Know when someone is using the administrator account.

• Know when there are failed login attempts.

• Know when anyone tries to access the management web page from the Internet.

You need to create three signatures to accomplish these goals. The following information describes 
the information required to create the three signatures.

To create your signatures:

1. Gather signature information.

This example shows Ethereal screens, which is Wireshark (free and available at 
www.wireshark.org) 

Figure C-1  Main Screen Example
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For our first task of triggering an alert to someone logging in as Administrator, let's compare 
normal usage to abnormal usage. The easiest way to do this is to log in under your own ID, 
then login as Administrator and look at the differences. Figure C-2 and Figure C-3 provide 
examples of the Wireshark output differences in the login.

Figure C-2  Normal Login

Figure C-3  Administrator Login

Comparing these two traces, you can see that once you are logged in, all your transactions 
have a user ID attached to them. Your user ID is 85. The Administrator user ID is 1. Without 
even realizing it, we have already completed two of our three tasks - identify when someone is 
accessing the web page, and when they are using Administrator. 

Our next task is to figure out exactly what happens when someone fails a login attempt. For 
this step, we will start up Wireshark again and log in incorrectly to see what happens. 
Figure C-4 and Figure C-5 provide examples of failed login attempts.

Figure C-4  Failed Login Attempt
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Figure C-5  Packet Dump of Failed Login

2. Create the three signatures.

The following tables describe the sections and field name in which you would enter the 
specified values. 

 

Table C-1 Signature 1 - Know When Someone is Using the Admin Account

Section/Field Name Description within the Signature Value

Base

Name This name describes our signature. WEB:ADMIN-DB-ACCESS

Service Rather than looking generically at all web traffic (port 80), we are 
looking at web traffic going from the client to the server. This tells 
Extreme IPS we are looking for the string going TO the port listed 
later. This setting is used for performance reasons, in addition to 
limiting false positives. 

DESTINATION

Traffic This references our “trusted” networks. We don't care if we see this 
activity coming from within our network or outside it.

ANY

Protocol The protocol is HTTP, which uses TCP. TCP
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Signature Port Since web traffic uses port 80 the obvious choice here is 80, but what 
if you use a proxy server? In this case, web traffic can be seen on 
port 80 or the proxy server’s port of 8080. 

Port Variable

Port Macro W

OS N/A

Dynamic Collection Since this signature is going to trigger as soon as someone begins 
their session as an Administrator, we want to log many packets. This 
will allow us to go back and see what kind of activities they 
performed while logged in, and whether the server allowed them to 
do everything they tried to do.

500

Follow on Signature N/A off

Match Criteria

Direction The signature will match traffic that is flowing to the server. target-server

State The TCP session must be established. established

Match Type Extended Pattern

Distance N/A

Within N/A

Offset N/A

Depth N/A

Pattern The string we are interested in, Administrator Login, is: “GET /
default.asp?User=1 HTTP/1.1” There are a couple of pitfalls to avoid 
here. One is that the request does not need to be a GET method. It 
could be a POST, and in some circumstances the attacker can use 
other methods. Because of this, we will not be using the GET method 
in our signature. The other pitfall to avoid is the HTTP version 
number.

/2fdefault.asp/3fuser/3d1

Type When looking for a banner coming from a server, we know the 
banner will look a certain way every time so we could use “Binary” 
telling Extreme IPS to “look for the string 'exactly' as I type it.” Since 
we are looking for traffic coming from a user, we cannot implicitly 
trust it as easily as if it came from a server. A user can easily take 
steps to hide their activities. To tell Extreme IPS to try harder to 
extract the string from the traffic (since it's untrusted) we are going to 
use a string match.

string

HTTP Region N/A

Normalize We want the signature to decode the pattern. YES

Table C-2 Signature 2 - Know When Someone Accesses Management Page From Internet 

Screen/Field Name Description within the Signature Value

Base

Name This name describes our signature. WEB:UNTRUSTED-DB-
ACCESS

Table C-1 Signature 1 - Know When Someone is Using the Admin Account

Section/Field Name Description within the Signature Value
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Service Rather than looking generically at all web traffic (port 80), we are 
looking at web traffic going from the client to the server. This tells 
Extreme IPS we are looking for the string going TO the port listed 
later. This setting is used for performance reasons, in addition to 
limiting false positives. 

destination

Traffic Specify traffic to our network that originated from outside our 
network.

toward

Protocol The protocol is HTTP, which uses TCP. TCP

Signature Port Since web traffic uses port 80 the obvious choice here is 80, but what 
if you use a proxy server? In this case, web traffic can be seen on 
port 80 or the proxy server’s port of 8080. 

Port Macro W

OS N/A

Dynamic Collection Since this signature is going to trigger as soon as someone begins 
their session, we want to log many packets. This will allow us to go 
back and see what kind of activities they performed while logged in, 
and whether the server allowed them to do everything they tried to 
do.

500

Follow on Signature N/A off

Match Criteria

Direction The signature will match traffic that is flowing to the server. target-server

State The TCP session must be established. established

Match Type Extended Pattern

Distance N/A

Within N/A

Offset N/A

Depth N/A

Pattern We are interested in access to a page named default.asp, but we 
don’t care who is accessing it or why. For this reason, we are going 
to reduce the search string.

/2fdefault.asp/2f

Type When looking for a banner coming from a server, we know the 
banner will look a certain way every time so we could use “Binary” 
telling Extreme IPS to “look for the string 'exactly' as I type it.” Since 
we are looking for traffic coming from a user, we cannot implicitly 
trust it as easily as if it came from a server. A user can easily take 
steps to hide their activities. To tell Extreme IPS to try harder to 
extract the string from the traffic (since it's untrusted) we are going to 
use a string match.

String

HTTP Region N/A

Normalize We want the signature to decode the pattern. YES

Table C-2 Signature 2 - Know When Someone Accesses Management Page From Internet  (continued)

Screen/Field Name Description within the Signature Value
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Table C-3 Signature 3 - Know When There are Failed Login Attempts 

Screen/Field Name Description within the Signature Value

Base

Name This name describes our signature. WEB:FAILED-CUSTOMER-
DB

Service This time we are not looking for something sent from a user to the 
server. Instead, we are looking for something sent from the web 
service to an end-user, so this time it will be coming FROM port 80. 
Port 80 is the Source port.

source

Traffic We want to know about any failure, no matter where it is destined. any

Protocol The protocol is HTTP, which uses TCP. TCP

Signature Port Since web traffic uses port 80 the obvious choice here is 80, but what 
if you use a proxy server? In this case, web traffic can be seen on 
port 80 or the proxy server’s port of 8080. 

Port Macro W

OS N/A

Dynamic Collection Since the server will be closing the connection after sending the 
failure page, there is no need to dynamically log follow-on packets. 
Extreme IPS only does this on a per-session basis, but the session 
will be ending immediately. Additionally, since the login failed, the 
end-user will not be able to perform any action of forensic value (in 
this case). 

0

Follow on Signature N/A off

Match Criteria

Direction The signature will match traffic that is flowing to the client. target-client

State The TCP session must be established. established

Match Type Extended Pattern

Distance N/A

Within N/A

Offset The signature will search from the beginning of the packet. 0

Depth Since we have a dump of the packet that contains the error message 
we can find its exact location in the packet. The message will be 
contained within the first 550 bytes of the packet, so we'll limit our 
search there. The error message is static—we don't need to worry 
about the depth changing.

550

Pattern The heading on the failure page should be sufficient for the purpose 
of identifying failed logins. The string appears as “NOT 
AUTHORIZED” in the packet dump. Since we are doing a “Binary” 
search, Extreme IPS will only look for an all caps instance of the 
string.

/20NOT/20AUTHORIZED/20

Type We are not looking for user-supplied input. We are looking for a 
string of data coming from a web server. That content is static in 
nature, and will look the same time and time again, no matter who 
fails the login. We have to be careful to enter the search string 
exactly as it will appear in the packet from the server.

Binary

HTTP Region N/A
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Normalize N/A

Table C-3 Signature 3 - Know When There are Failed Login Attempts  (continued)

Screen/Field Name Description within the Signature Value
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D
Daemon Descriptions

Table D-4 Daemon Descriptions

Daemon Name Role / Description

AlarmTool The AlarmTool agent reads events from Network Sensor and Host Sensor and generates alarms based 
on configurations settings. Alarms can be in the form of email, flat file logs, the UNIX syslog facility, 
NetSight ASM and OPSEC SAM responses, SNMP traps (both versions 1 and 3), and the execution of 
external binaries/scripts. 

The AlarmTool agent should be installed and activated on any Sensor/EFP where alarming should take 
place.

CacheManager During normal operations, events are stored in memory (e.g., ring buffer) where they are made 
available to any daemon that needs to consume the event. The CacheManager is installed on each 
Sensor and EFP are responsible for managing events that must be cached to disk if memory is full. The 
Cache Manager then moves the events from disk cache to memory as memory becomes available. 

The CacheManager should always be active on EFPs and Enterprise Sensors.

DragonDB The DragonDB agent reads events from Dragon Network Sensor and Host Sensor and records the 
events to a local Dragon database. This Dragon database is used by the Reporting tools for event 
reporting. 

The DragonDB Agent should be installed and activated on any Sensor/EFP where the Reporting tools 
are active.

EventChannel Extreme Networks IPS events are stored in memory on Sensors and EFPs in a ring buffer. The 
Connection Manager allows the ring buffer on a Sensor/EFP to be accessed over the network by a 
Replication Agent.

As events are forwarded from an Enterprise Sensor to an EFP, the Replication Agent on the Sensor 
contacts the Connection Manager on the EFP. Events then flow from memory on the Enterprise Sensor, 
through the Replication Agent, to the Connection Manager, to memory on the EFP. 

The Connection Manager should be installed and activated on any Sensor/EFP that will be receiving 
connections from other Sensors/EFPs.

ExportLog The optional ExportLog agent reads events from Network Sensor and Host Sensor and records the 
events in a flat ASCII file that serves as an export log. The export log can be used to export Extreme 
Networks IPS events to third party systems. It is also used by the Trending Console and RealTime 
Console.

You can install and activate the ExportLog agent on any Sensor/EFP where the Reporting tools are 
installed.
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MD5Sum The MD5Sum agent reads MD5 reference events from Host Sensor. Host Sensor can be configured to 
send MD5 Reference events to a remote system to enhance security. The MD5Sum agent reads these 
events and records them to a local database. As variances are detected in the MD5 information, the 
MD5Sum agent records events indicating that the MD5 value of the specified file has been altered.

MD5Sum agent should be installed and activated on an EFP if Host Sensor is configured to send MD5 
Reference events. The MD5Sum agent must be installed on an EFP through which the MD5 reference 
events will flow.

MySQL Reporting The MySQL Reporting agent provides the event data used by the Extreme Networks IPS Reporting 
features. The MySQL Reporting agent does this by reading events directly from the ring and storing 
them in the Enterasys IPS MySQL event database in batches. 

net-cfg-client The net-cfg-client daemon provides connectivity between a Network Sensor and the Policy Manager. 
The daemon is installed on the Enterprise Sensor and serves as the client component to the net-cfg-
client to net-cfg-server communications. The main purpose of the daemon is to receive and activate 
new configuration downloads from the Policy Manager.

The net-cfg-client also provides heartbeat statistics to the DPM and monitors the health of the Extreme 
Networks IPS Network Sensor. Extreme Networks IPS Network Sensor is restarted by the net-cfg-client 
if it is detected as stopped. As the result, Extreme Networks IPS Network Sensor is never listed by the 
dragonctl utility. Instead, net-cfg-client is started/stopped through the utility.

The net-cfg-client should always be active on an Enterprise Sensor that is running Extreme Networks 
IPS Network Sensor. 

net-cfg-server The net-cfg-server daemon resides on the Extreme Networks IPS Policy Manager and provides 
connectivity between Sensors and the DPM. The main purpose of the daemon is to download new 
configurations to the Sensor on demand. A secondary role of the daemon is to upload heartbeat 
statistics and event timestamps from the Sensor. 

The net-cfg-server should always be active on an Extreme Networks IPS Policy Manager. 

RealTimeConsole The RealTimeConsole agent is used to process requests made by the RealTime Console. The 
RealTimeConsole agent continually reads Extreme Networks IPS events supplied by the ExportLog 
Agent and records these events in memory. As queries are made through the RealTime Console GUI, 
the agent services the query and provides the result set.

The RealTimeConsole agent should be installed and activated on any Sensor/EFP that is running the 
RealTime Console.

Table D-4 Daemon Descriptions (continued)

Daemon Name Role / Description
D-2 Daemon Descriptions



E
HIDS Processes and Services

All UNIX HIDs
Table E-5 lists the processes that are available on UNIX platforms. All config files are created in 
XML format and are located in the $INSTALL/conf directory.

Table E-5 UNIX HIDS Processes 

Process Description

cachemanager 
(CacheManager)

• Process: ./cachemanager -i CacheManager

• Path: $INSTALL/bin

• User: root 

• CacheManager.xml values are defined in the IPS GUI

• You can start, stop, and restart the process from the IPS GUI or by 
using the cache-manager script in $INSTALL/scripts directory. 

dragonctl • Process: dragonctl start

• Path: $INSTALL/bin

• User: root

• host.xml values are defined in the IPS GUI

• You can start, stop, and restart the process from the $INSTALL/bin 
directory using the dragonctl  binary. Use “./dragonctl ?” for usage. 
You can also use the dragon-control script in the $INSTALL/scripts 
directory.

dsquire (HostSensor) • Process: ./bin/dsquire -i HostSensor

• Path: $INSTALL/ dsquire/bin

• User: root

• HostSensor.xml values are defined in the IPS GUI

• You can start, stop, and restart the process from the IPS GUI or by 
using the host-sensor script in the $INSTALL/scripts directory.

net-cfg-client (client side of 
Configuration Channel)

• Process: ./net-cfg-client -f ../conf/net-cfg-client.xml

• Path: $INSTALL/bin

• User: root

• net-cfg-client.xml values are defined during installation

• Start, stop, and restart the process by using either the dragon-start.sh 
and dragon-stop.sh scripts or, from the $INSTALL/scripts directory, 
the config-channel-client script.
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Linux-only HIDs
Before deploying the Host Sensor, only net-cfg-client will be running at startup. 

During the Host Sensor deployment process, all agent/sensor xml files are created. All agents/
sensors are run under the dragonctl process.

The net-cfg-client, dragonctl, EventChannel, and CacheManager processes should always be 
running on all UNIX OS HIDs. All other agents/sensors are optional for Linux OS. You can add 
and configure them as needed.

Linux-only HIDs
Table E-6 lists the processes that are available only on Linux platforms. These are optional 
components for a HIDS-only installation. You can define values for each process in the IPS GUI. 
You can start, stop, and restart each process from the IPS GUI. 

net-event-channel 
(EventChannel)

• Process: ./net-event-channel -i EventChannel

• Path: $INSTALL/bin

• User: dragon

• EventChannel.xml values are defined in the IPS GUI

• You can start, stop, and restart the process from the IPS GUI or by 
using the event-channel script in the $INSTALL/scripts directory.

Table E-5 UNIX HIDS Processes  (continued)

Process Description

Table E-6 Linux HIDS Processes

Process Description

alarmtool (Alarmtool) • Process: ./alarmtool -i Alarmtool

• Path: $INSTALL/bin

• User: root

dragondb (DragonDB) • Process: ./dragondb -i DragonDB

• Path: $INSTALL/bin

• User: dragon

exportlog (ExportLog) • Process: ./exportlog -i ExportLog

• User: dragon

md5sum (MD5Sum) • Process: ./md5sum -i MD5Sum

• Path: $INSTALL/bin

• User: dragon

rts (RealtimeConsole) • Process: ./rts -i RealtimeConsole

• Path: $INSTALL/bin

• User: dragon
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All Windows HIDS
All Windows HIDS
Table E-7 lists the processes that are available only on Windows. All config files, in XML format, 
are located in the C:\Program Files\Enterasys\DragonSquire\conf directory. 

Before deploying the Host Sensor, only net-cfg-client will be running at startup. 

During the Host Sensor deployment process, the following things occur:

• All sensor xml files are created. The values are defined within the IPS GUI.

• Dragon Host sensor service starts.

• The event channel is established. 

There is no separate event channel XML file in Windows HIDS. An event channel module is 
added to HostSensor.xml.

Dragon Config Channel and Dragon Host sensor services should always be running. The Host 
sensor and Config channel services are Windows services and set to automatic startup.

Table E-7 Windows HIDS Processes

Process Description

Dsquire • Process: dsquire.exe

• Service: Dragon Host sensor

• Path: C:\Program Files\Enterasys\DragonSquire\bin

• User: Administrator

• HostSensor.xml values are defined from the IPS GUI

• You can stop, start, and restart the process from the IPS GUI or the 
Dragon Host sensor service.

• The DLLs are present in the module-ets directory. Depending on the 
modules deployed, the DLLs get loaded.

net-cfg-client (client side of 
Configuration Channel)

• Process: net-cfg-client.exe

• Service: Dragon Config Channel 1.0.0 service is started

• Path: C:\Program Files\Enterasys\DragonSquire\bin

• User: Administrator

• You can stop, start, and restart the process by using the Dragon 
Config Channel service.
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All Windows HIDS
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